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About this information product

...............................................................................................................................................................................................................................................................

Purpose This chapter is a preface that provides an overview of this information
product.

The purpose of this Administration Guide is to instruct users how to
administer WaveStar® Network Management System (NMS) Release
4.2.

Reason for reissue This Administration Guide, Issue 1, is a revised document that
supports WaveStar NMS, Release 4.2.

Safety labels N/A

Intended audience This guide is written primarily for operations personnel who
administer WaveStar NMS.

How to use this
information product

This section provides information to help users of this information
product.
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Chapter descriptions

The following table describes the information in each chapter of this
document.

Section Title Description

Preface About this information product Describes this
document’s purpose
and intended
audience, how to
use the document,
and how to
comment on it.

Chapter 1 Chapter 1, “Administration
overview”

Provides an
overview of the
administration
process.

Chapter 2 Chapter 2, “Platform
Administration”

Contains HP-UX
and Windows
configuration
set-up, printer
set-up, power on
and power down
tasks.

Chapter 3 Chapter 3, “System
administration”

Describes how to
start and stop
WaveStar NMS, set
preferences, restart
the database and
how to perform
other system
administration
tasks.

Chapter 4 Chapter 4, “User and Domain
Administration”

Describes how to
assign user
privileges and
restrict access to
WaveStar NMS.
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Section Title Description

Chapter 5 Chapter 5, “Domain
partitioning for provisioning
operations”

Contains procedures
on how to list
network elements,
how to add and
delete domains, and
how to add
channels to
domains.

Chapter 6 Chapter 6, “Provisioning
administration”

Contains tasks on
managing areas,
aggregates, and
scheduled entities.

Chapter 7 Chapter 7, “Reliability and
service recovery ”

Provides
instructions on how
to perform hot and
cold backups.

Chapter 8 Chapter 8, “Off-line tool
concepts”

Contains tasks for
WaveStar NMS’s
off-line tools.

Chapter 9 Chapter 9, “EMS management
”

Describes how to
add new element
management
systems, perform a
database
synchronization,
and view LAN
status information.

Chapter 10 Chapter 10, “Trouble clearing” Contains
troubleshooting
procedures.

Chapter 11 Chapter 11, “Patch and
Software Upgrade Tasks”

Will provide
specific instructions
on how to upgrade
the WaveStar NMS.

Appendix Appendix A, “WaveStar NMS
Filesystems”

Contains a list of
file systems.
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Section Title Description

Appendix Appendix B, “WaveStar NMS
Parameters”

Contains general
information about
WaveStar NMS
installation
parameters.

Index Index Enables the user to
quickly find
information on
specific topics.

Conventions used This document uses the following typographical conventions to
distinguish between computer input and output.

• When describing the WaveStar NMS software, fields in windows
and field entries are identified with this font.

• When describing the UNIX® environment, text and numbers that
the user inputs to the computer are identified with boldface
type.

• In the UNIX environment, text and numbers that the computer
outputs to the user are identified with monospace type.

Related documentation This information product is part of a set of documents that supports
WaveStar NMS.

List of documents

The document set that supports WaveStar NMS includes:

1. WaveStar NMS Getting Started Guide, (365-309-241) - provides
information needed as you learn how to use the WaveStar NMS
software. It describes how to start and stop WaveStar NMS, how
to use the software, and how to interpret the graphical user
interface. This document includes tasks and conceptual
information.

2. WaveStar NMS Applications and Planning Guide, (365-309-242)
- describes the WaveStar NMS features and applications, provides
a product description and the hardware platforms for the product,
and describes system planning and engineering, ordering, and
product support. This document contains conceptual information
only.
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3. WaveStar NMS Administration Guide, (365-309-245) - instructs
users on how to administer WaveStar NMS and the network. This
document includes tasks and conceptual information.

4. WaveStar NMS Maintenance Guide, (365-309-244) - instructs
users on how to maintain WaveStar NMS and the network. This
document includes tasks and conceptual information.

5. WaveStar NMS Provisioning Guide, (365-309-243) - instructs
users how to use WaveStar NMS to provision and manage a
network. This document includes tasks and conceptual
information.

On-line documentation

An online version, in HTML format, of this document set is provided
with WaveStar NMS.

Screen help

The WaveStar NMS software includes screen help for each window,
which describes the purpose of the window, each of the fields, and
each of the buttons.

Window help

The WaveStar NMS software includes window help for each form,
which describes the purpose of the form, each of the fields, and each
of the buttons.

How to comment Customer satisfaction is extremely important to Lucent Technologies.
All users are encouraged to provide feedback on the WaveStar NMS
information products.

A customer comment form appears immediately after the title page of
this document. Please fill out the form and submit is as instructed on
the form.

How to order To order WaveStar NMS information products, contact your Lucent
Technologies customer team representative or contact the Lucent
Technologies Customer Information Center (CIC):

• From the United States, call 1-888-LUCENT8 (1-888-582-3688),
prompt 1.

• From Canada, call 1-317-322-6619.
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• From Europe, the Middle East, and Africa, call 1-317-322-6416.

• From Asia, the Pacific Region, China, the Caribbean, and Latin
America, call 1-317-322-6411.

Administration Guide About this information product
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1 Administration overview

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides an overview of the WaveStar Network
Management System (NMS) administration process.

Platform Administration
and WaveStar NMS

Administration

This document contains the administrative operations on WaveStar
NMS.

It covers the following administration categories:

• Platform Administration, which contains critical platform setup
tasks that are performed outside of the WaveStar NMS
application. This category includes tasks for powering on or
powering off workstations, adding users to workstations, and
assigning user privileges.

• WaveStar NMS Administration, which includes tasks and
concepts specific to this application.

Important Note This document contains:

• Task information, which includes administration tasks (that is,
step-by-step instructions).

• Conceptual information, which is specific data related to the
tasks.

Both types of information is presented within the chapters of this
administration guide.
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What is administration?
....................................................................................................................................................................................................................................

Introduction WaveStar NMS administration covers the following areas:

• Security administration

• Geographic Domain administration

• Service Domain administration

Administration Process The administration process can be broken down into three areas.

Three areas The administration process provides the following type of support to
the WaveStar NMS and the network:

• Security management support

• Provisioning support

• System support

Security management Security management support includes tasks associated with how to
add and delete user IDs and profiles.

Provisioning support Provisioning support includes tasks used to add or delete geographic
domains or to list network elements.

System Support System support includes system-related tasks, such as how to backup
or recover the system.

Administration overview
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Who performs administration tasks?
....................................................................................................................................................................................................................................

Introduction Administrative tasks are performed by users with system administrator
permissions.

System administrator user
types

There are several administrator user types available which define the
operating systems and platforms to which a system administrator may
access.

These user type levels include:

• Operating System (OS) Superuser, or the highest, privileged
user, for example, root on UNIX or Administrator on Windows.

• OS Administrator, which is created by the OS Superuser. This
user type is typically configured with access to specific OS
administrator-level tools and system-packaged tools.
This user type may typically use standard OS tools, such as
UNIX vi, configured with access to OS admin and
system-specific tools. OS Users are typically dacscan on all
server platforms (UNIX) and sa on client (GUI) platforms
(UNIX and Windows).

• OS User, which may be created or deleted by the OS Superuser
or OS Administrator user.

• System Administrator, a user type which performs day-to-day
tasks using system administrative tools. Typically the System
Administrator user also has OS User privileges.

Functions Users with system administrator privileges are able to perform tasks
that enable them to:

• Provide security management, provisioning, and system support
to the WaveStar NMS host and to the Network Map.

• Control the appearance of the Network Map

Administration overview
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Administer various hardware configurations
....................................................................................................................................................................................................................................

Introduction WaveStar NMS supports various hardware configurations.

List of hardware
configurations

The following hardware configurations are supported:

• single server

• single server (with disk mirroring)

• local redundancy

• geographic redundancy

Refer to Chapter 5 (Hardware Platforms) of the WaveStar NMS
Applications and Planning Guide.

Administration overview

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 1 - 5



Run levels
....................................................................................................................................................................................................................................

Introduction Certain tasks in this guide require the system administrator to change
the run level of the WaveStar NMSapplication on an HP-UX machine.
The following describes two run levels, run level 3 and run level 4.

Run level 3 When the system administrator enters the init 3 command on, this
causes the system to run level 3 which shuts down the WaveStar NMS
application. The init 3 command would be entered, for example,
before creating a trace file.

Run level 4 When the system administrator enters the init 4 command on an
HP-UX machine, this causes the system to run level 4, which starts up
the WaveStar NMS application. The init 4 command would be
entered, for example, after a trace file has been created.

Administration overview
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2 Platform Administration

Overview
....................................................................................................................................................................................................................................

Purpose

This chapter contains information on how to:

• power on HP and Windows servers and MC/ServiceGuard
configurations

• power on HP and Windows workstations

• perform configuration setup tasks

• manage users on client/server workstations residing on HP-UX
and Windows platforms

• create and delete SAGE workstation users

• add a printer

• power down HP and Windows workstations

• power down HP and Windows servers

Contents
Section I: Power on servers and
MC/ServiceGuard configurations

2-4

Power on an HP server (single-server configuration) 2-5

Power on HP servers (MC/ServiceGuard cluster -
local redundancy configuration)

2-6

....................................................................................................................................................................................................................................
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Power on an HP server (geographic redundancy
configuration)

2-7

Power on a Windows terminal server 2-8

Section II: Power on HP and Windows
workstations

2-9

Power on an HP-UX workstation 2-10

Power on a Windows workstation 2-11

Section III: Configuration tasks 2-12

Add a workstation to the WaveStar NMS host 2-13

TIM TCP/IP configuration setup 2-14

Asynchronous port setup for TIM interface 2-17

Asynchronous port setup on datakit 2-19

Configuring a LAN Interface 2-20

Section IV: Administering users 2-21

Add an OS user on an HP-UX workstation using
SAM

2-22

Create an OS user ID through the sam
terminal-based program

2-25

Assign user privileges to a user on a Windows PC 2-29

Assign system administrator privileges on a
Windows PC

2-31

Add a user on the server 2-33

Section V: Administer SAGE desktop integration
users

2-34

Add a user to a SAGE workstation 2-35

Delete a user from a SAGE workstation 2-37

Section VI: Printer Administration 2-38

Install a networked printer on a WaveStar NMS
server

2-39

Add a network printer 2-41

Add a local serial printer 2-43

Set up the Common Desktop Environment (CDE)
printer icon

2-44
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Section VII: Power down workstations 2-46

Power down an HP-UX workstation 2-47

Power down a Windows workstation 2-48

Section VIII: Power down servers and
MC/ServiceGuard configurations

2-49

Power down a single server 2-50

Power down MC/ServiceGuard cluster (local
redundancy configuration)

2-51

Power down a server (geographic redundancy
configuration)

2-53

Power down an Windows server 2-55
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Section I: Power on servers and MC/ServiceGuard
configurations

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power on:

• Single-servers (with or without disk mirroring)

• Geographic Redundancy servers (simplified or full)

• Local Redundancy servers

• Windows servers

Contents
Power on an HP server (single-server configuration) 2-5

Power on HP servers (MC/ServiceGuard cluster -
local redundancy configuration)

2-6

Power on an HP server (geographic redundancy
configuration)

2-7

Power on a Windows terminal server 2-8

Platform Administration
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Power on an HP server (single-server configuration)
....................................................................................................................................................................................................................................

Purpose Use the following task to power on an HP server that has a
single-server hardware configuration, with or without mirrored disks.

Important! When the system is powered on, it does not automatically
start the WaveStar NMS application.

Task Use this task to power on the HP server (single-server
configuration).
............................................................................................................................................................

1 Switch on all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Switch on the HP server (press the power switch or turn key, as
appropriate).

Result:

The HP server runs a sequence of diagnostics then boots into
multi-user mode. The server is ready when the Console Login

prompt displays on the controlling terminal.

Section I: Power on servers and
MC/ServiceGuard configurations

Platform Administration
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Power on HP servers (MC/ServiceGuard cluster - local
redundancy configuration)
....................................................................................................................................................................................................................................

Purpose Use the following task to power on an MC/ServiceGuard cluster
hardware configuration, which consists of HP servers in a local
redundancy configuration, with or without mirrored disks.

Important! When the system is powered on, it does not automatically
start the WaveStar NMS application.

Task Use this task to power on the primary server and standby HP
server(s) using a local redundancy configuration.
............................................................................................................................................................

1 Switch on all peripherals associated with the cluster, for example,
control terminal(s), external disk drives, external tape drives, and
modems.

............................................................................................................................................................

2 Switch on the primary HP server (press the power switch or turn key,
as appropriate).

Result:

The HP server runs a sequence of diagnostics then boots into
multi-user mode. The server is ready when the Console Login

prompt displays on the controlling terminal.

............................................................................................................................................................

3 Switch on the standby HP server(s) (press the power switch or turn
key, as appropriate).

Result:

The standby server(s) runs a sequence of diagnostics, then boots
into multi-user mode. The server(s) is ready when the Console

Login prompt displays on the controlling terminal.

Section I: Power on servers and
MC/ServiceGuard configurations

Platform Administration
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Power on an HP server (geographic redundancy configuration)
....................................................................................................................................................................................................................................

Purpose Use the following task to power on an HP server that has a simplified
or full geographic redundancy configuration, with or without mirrored
disks.

Important! When the system is powered on, it does not automatically
start the WaveStar NMS application. Note that the designation of
primary and standby servers in this task refers to the current status of
the servers not the status of the servers at installation.

Task Use this task to power on the HP server using a simplified or full
geographic redundancy configuration.
............................................................................................................................................................

1 Start the primary server. See “Power on an HP server (single-server
configuration)” (2-5).

............................................................................................................................................................

2 Start the standby server. See “Power on an HP server (single-server
configuration)” (2-5).

Section I: Power on servers and
MC/ServiceGuard configurations
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Power on a Windows terminal server
....................................................................................................................................................................................................................................

Purpose Use the following task to power on a Windows terminal server.

Task Use this task to power on a Windows terminal server.
............................................................................................................................................................

1 Switch on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Switch on the server (press the power switch or turn key, as
appropriate).

Result:

The server runs a sequence of diagnostics. The server is ready
when the Windows login dialog box displays.

Section I: Power on servers and
MC/ServiceGuard configurations

Platform Administration
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Section II: Power on HP and Windows workstations

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power on HP and
Windows workstations.

Contents
Power on an HP-UX workstation 2-10

Power on a Windows workstation 2-11

Platform Administration
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Power on an HP-UX workstation
....................................................................................................................................................................................................................................

Purpose Use the following task to power on an HP-UX workstation.

Task Use this task to power on the HP-UX workstation.
............................................................................................................................................................

1 Switch on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Switch on the workstation (press the power switch or turn key, as
appropriate).

Result:

The workstation runs a sequence of diagnostics and then boots
to the X-Windows system. The workstation is ready when the
Common Desktop Environment (CDE) login dialog box
displays.

Section II: Power on HP and Windows
workstations

Platform Administration
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Power on a Windows workstation
....................................................................................................................................................................................................................................

Purpose Use the following task to power on a Windows workstation.

Task Use this task to power on a Windows workstation.
............................................................................................................................................................

1 Switch on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Switch on the workstation (press the power switch or turn key, as
appropriate).

Result:

The workstation runs a sequence of diagnostics. The workstation
is ready when the Windows login dialog box displays.

Section II: Power on HP and Windows
workstations

Platform Administration
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Section III: Configuration tasks

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks that explain how to configure WaveStar
NMS hardware and how to set up supporting processes.

Contents
Add a workstation to the WaveStar NMS host 2-13

TIM TCP/IP configuration setup 2-14

Asynchronous port setup for TIM interface 2-17

Asynchronous port setup on datakit 2-19

Configuring a LAN Interface 2-20

Platform Administration
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Add a workstation to the WaveStar NMS host
....................................................................................................................................................................................................................................

Purpose Use this task to add a workstation to the WaveStar NMS host.

Task Perform the steps below to add a workstation to the WaveStar
NMS host.
............................................................................................................................................................

1 Log in to the WaveStar NMS host as root.

............................................................................................................................................................

2 At the prompt, enter ksh /install/add.ethers

............................................................................................................................................................

3 At the prompt, enter y and press Enter.

............................................................................................................................................................

4 At the prompt, enter the workstation name and press Enter.

............................................................................................................................................................

5 Enter y to confirm that the name was entered correctly then press
Enter.

............................................................................................................................................................

6 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Section III: Configuration tasks Platform Administration
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TIM TCP/IP configuration setup
....................................................................................................................................................................................................................................

Purpose Use this task to set up a TIM TCP/IP configuration.

Task Perform the steps below to set up a TIM TCP/IP configuration.
............................................................................................................................................................

1 Log into the host as root.

............................................................................................................................................................

2 At the prompt, enter init 3

Result:

WaveStar NMS application is stopped.

............................................................................................................................................................

3 At the prompt, enter cd /etc/dscan

touch .tim

chmod 666 .tim

............................................................................................................................................................

4 At the prompt, enter /etc/dscan/chg_env_var

Result:

The following message will be displayed:
THE DEFAULT SETTINGS FOR <COMPANY_NAME> WILL NOW BE

DISPLAYED
YOU WILL BE PROMPTED TO CONFIRM THE SETTINGS.
ENTER TO CONTINUE:

............................................................................................................................................................

5 Press Enter.

Result:

A list of settings display with a prompt requesting whether or
not you want to change the settings.

............................................................................................................................................................

6 Type y and press Enter to continue.

Result:

The WS-NMS Parameter Editor menu displays.
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............................................................................................................................................................

7 View the menu until you see the number corresponding to TIM_PORT

or TIM_TCP.

Important! You may have to press Enter to view this selection.

............................................................................................................................................................

8 At the prompt, enter the number corresponding to TIM_PORT or
TIM_TCP.

Result:

The selection displays.

............................................................................................................................................................

9 At the prompt, enter 2 and press Enter.

Result:

You are prompted to enter the IP address for the ITM-XM.

............................................................................................................................................................

10 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

11 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the TIM hostname.

............................................................................................................................................................

12 Enter the hostname, then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

13 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.
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Result:

The following messages should display followed by a prompt to
add or change the TIM Interface login and password. Updated
host’s file successfully

Updated CCP file successfully

............................................................................................................................................................

14 Add or change the password as required.

Result:

The following message displays.

Updated TIM login file successfully

............................................................................................................................................................

15 Press Enter to return to the edit parameter menu and then type q and
press Enter and type n and press Enter.

Result:

You have exited the menu.

............................................................................................................................................................

16 Log into the host as dacscan.

............................................................................................................................................................

17 Copy the parameters to the following file in the database:
/usr/dacscan/bin/DBinitParam

Result:

A list of parameters display without entries for TIM_PORT and
TIM_TCP.

............................................................................................................................................................

18 Log into the host as root.

............................................................................................................................................................

19 At the prompt, enter init 4

Result:

WaveStar NMS application is started.
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Asynchronous port setup for TIM interface
....................................................................................................................................................................................................................................

Purpose Use this task to set up an asynchronous port for the TIM interface.

Task Perform the steps below to set up an asynchronous port.
............................................................................................................................................................

1 Log into the host as root.

............................................................................................................................................................

2 At the prompt, enter sam then press Enter

Result:

The sam program begins.

............................................................................................................................................................

3 View the display, highlight Peripheral Devices -> then press Enter.

Result:

A new menu displays.

............................................................................................................................................................

4 Highlight Terminals and Modems then press Enter.

Result:

The current configuration displays.

............................................................................................................................................................

5 Press F4.

Result:

The main menu bar is activated.

............................................................................................................................................................

6 Select Actions then press Enter.

Result:

A drop down menu displays.

............................................................................................................................................................

7 Select Add Modems then press Enter.

Result:

A note menu displays.
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............................................................................................................................................................

8 Select OK.

Result:

A hardware scan will take place and eventually return with the
installed Mux/Serial cards and their respective hardware paths.

............................................................................................................................................................

9 Highlight Mux/Serial card with a h/w path of 12 then press tab three
times.

............................................................................................................................................................

10 Enter the port number, press tab once, then enter 9600 for the baud
rate.

............................................................................................................................................................

11 Press tab once, then unselect “Do you want the device for

calling out?” Use defaults for all other prompts, then press F5.

Result:

A device file is created, for example for port 3:

/dev/ttyd0p3

............................................................................................................................................................

12 Write down the displayed device information then exit sam.

............................................................................................................................................................

13 At the prompt, enter vi /etc/inittab and press Enter.

Result:

The file is displayed.

............................................................................................................................................................

14 Locate a0:2:respawn:/etc/getty -h ttyd0p3 9600 then change
the line to a0:24:respawn:/etc/getty -h ttyd0p3 9600

............................................................................................................................................................

15 Write and exit the file.

Result:

The file is saved.

............................................................................................................................................................

16 At the prompt, enter init q then press Enter.
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Asynchronous port setup on datakit
....................................................................................................................................................................................................................................

Purpose Use this task to set up an asynchronous port for datakit

Task Perform the steps below to set up an asynchronous port for
datakit.
............................................................................................................................................................

1 To configure an asynchronous device with a service type of host,
respond to the following prompts:

• For CCO, enter ty and press Enter.

• For TTY Type, enter 12 and press Enter.

• For COMMENT, enter TIMIF for itm and press Enter.

• For SERVICE TYPE, enter host and press Enter.

• For GROUP, enter dacscan and press Enter.

• For BAUD RATE, EXTERNAL BAUD RATE, PARITY, FLOW
CONTROL OF TY-12, and AT&T..., enter +.

• For ENDPOINT NUMBER OF RANGE, enter + and press
DELETE.

• For CCO, enter restore ty and press Enter.

• For MODULE ADDRESS, enter 42 and press Enter.

• For PORT NUMBER, enter 3 and press Enter.
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Configuring a LAN Interface
....................................................................................................................................................................................................................................

Purpose Use this task to configure a LAN interface for WaveStar NMS.

Task Perform the steps below to configure a LAN interface.
............................................................................................................................................................

1 Log in to WaveStar NMS as root.

............................................................................................................................................................

2 At the prompt, enter /etc/dscan/ConfigWaveStarLan

Result:

The following prompt displays: Which interface is the

WaveStar Lan connected to (default is lan1) ?

............................................................................................................................................................

3 Enter WAVESTAR LAN INTERFACE from the checklist and press Enter.

Result:

A confirmation displays.

............................................................................................................................................................

4 At the prompt, enter y and press Enter.

Result:

The following message displays: Verifying lan interface

configuration. Please wait.... followed by a second
message requesting the Internet address for the server on the
WaveStar LAN.

............................................................................................................................................................

5 Enter the WaveStar NMS Host WaveStar NMS IP address from the
checklist, then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

6 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.
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Section IV: Administering users

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks to create user IDs using a GUI-based or
terminal-based version of the System Administration sam program. It
also includes tasks for assigning user or administrator privileges on a
Windows PC.

Contents
Add an OS user on an HP-UX workstation using
SAM

2-22

Create an OS user ID through the sam
terminal-based program

2-25

Assign user privileges to a user on a Windows PC 2-29

Assign system administrator privileges on a
Windows PC

2-31

Add a user on the server 2-33
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Add an OS user on an HP-UX workstation using SAM
....................................................................................................................................................................................................................................

Purpose Use this task to create an OS user ID through the GUI-based version
of the sam program using an HP-UX workstation.

Task Perform the steps below to create an OS user ID through sam
using an HP-UX workstation.
............................................................................................................................................................

1 Log into the workstation as root.

............................................................................................................................................................

2 On the Common Desktop Environment (CDE) panel (at the bottom of
the screen), select the terminal icon to open a dtterm window.

Result:

A dtterm window displays.

............................................................................................................................................................

3 At the prompt, enter sam and then press Enter.

Result:

The System Administration Manager window’s SAM Areas
display.

............................................................................................................................................................

4 Double click the Accounts for Users and Groups icon.

Result:

The Accounts for User and Groups icons display.

............................................................................................................................................................

5 Double click the Users icon.

Result:

A Displaying All Users form displays.

............................................................................................................................................................

6 Select Actions > Add.

Result:

The Add a User Account form displays.
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............................................................................................................................................................

7 In the Login Name field, enter a value of up to 8 characters
representing the ID (such as the person’s abbreviated name) .

Important! The valid characters allowed in the ID are lowercase
letters (a-z), numbers (0-9), and one or more underscores (_). The first
character must be a lowercase letter. The underscores may be in any
position after the first.

Result:

The Home directory field displays the directory path, which
includes the Login Name field’s value, such as
/home/<login_name>.

............................................................................................................................................................

8 At the Create Home directory field, select the box.

Important! The Create Home Directory box must be selected in
order to successfully add the user. If this box is not checked, a
corruption may occur in the /etc/passwd file that causes the computer
to boot up in single user mode.

............................................................................................................................................................

9 In the Primary Group Name field, enter users.

............................................................................................................................................................

10 In the Start-up Program field, enter /usr/bin/ksh.

Important! The remaining information is optional.

............................................................................................................................................................

11 Optionally complete the remaining fields then click OK to continue.

Result:

The Set User Password dialog box is displayed.

............................................................................................................................................................

12 Enter a password for the user ID, then click OK.

Result:

A verification message displays.

............................................................................................................................................................

13 Re-enter a password for the user ID, then click OK.
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Result:

A message displays that the user ID has been added.

............................................................................................................................................................

14 To exit the Add a User Account form, select File > Exit.

Result:

The Accounts for Users and Groups form displays.

............................................................................................................................................................

15 To exit the Accounts for Users and Groups form, select File > Exit
SAM.

............................................................................................................................................................

16 At the prompt, type cat /etc/passwd | pg then view the display to
determine if permissions have been properly set for the created user
ID in the passwd file.

............................................................................................................................................................

17 For each user entered in the Login Name field in Step 7 of this task,
use the “Add a user” (4-4) task to add the user to the WaveStar NMS
application.
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Create an OS user ID through the sam terminal-based program
....................................................................................................................................................................................................................................

Purpose Use this task to create an OS user ID through the terminal (non-GUI)
version of the sam program, which may be accessed through a telnet
session.

Task Perform the steps below to create a user ID by accessing sam
through a telnet session.
............................................................................................................................................................

1 Log into a workstation.

............................................................................................................................................................

2 Click the Start button in the taskbar, then select Run

Result:

The Run dialog box displays.

............................................................................................................................................................

3 In the Run dialog box’s Open field, enter telnet <ip_address> and
log into a machine that contains the sam program as root.

............................................................................................................................................................

4 At the prompt, type sam and press Enter.

Result:

A message displays indicating that the terminal version of sam
is started.

............................................................................................................................................................

5 Press Enter.

Result:

The Sam Administration Manager menu is displayed.

............................................................................................................................................................

6 At the highlighted Accounts for Users and Groups selection, press
Enter.

Result:

A menu of User and Group options is displayed.

............................................................................................................................................................

7 Using the down arrow key, highlight the Users item and press Enter.
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Result:

The Accounts for Users and Groups form is displayed.

............................................................................................................................................................

8 Using the Tab and arrow keys, scroll to the Actions menu selection,
then press Enter.

Result:

The Actions menu is displayed.

............................................................................................................................................................

9 At the highlighted Add... entry, press Enter.

Result:

The Add a User Account form is displayed.

............................................................................................................................................................

10 In the Login Name field, enter a value of up to 8 characters
representing the ID (such as the person’s abbreviated name) and press
Enter.

Important! The valid characters allowed in the ID are lowercase
letters (a-z), numbers (0-9), and one or more underscores (_). The first
character must be a lowercase letter. The underscores may be in any
position after the first.

Result:

The cursor bypasses the User ID (UID) field, which is already
populated with a system-generated entry. The Home directory
field displays the directory path, which includes the Login Name
field’s value, such as /home/<login_name>.

............................................................................................................................................................

11 Tab to the Create Home Directory check box, then press Enter if the
box is not already checked.

Important! The Create Home Directory box must be checked in
order to successfully add the user. If this box is not checked, a
corruption may occur in the /etc/passwd file that causes the computer
to boot up in single user mode.

............................................................................................................................................................

12 Tab to the Primary Group Name field, type users and press Enter.
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............................................................................................................................................................

13 In the Start-Up Program field, enter /usr/bin/ksh and press Enter.

Important! The remaining information is optional.

............................................................................................................................................................

14 Tab to OK and press Enter.

Result:

The Set User Password dialog box displays.

............................................................................................................................................................

15 Enter a password for the user ID, tab to OK then press Enter.

Result:

A verification message displays.

............................................................................................................................................................

16 Re-enter a password for the user ID, tab to OK then press Enter.

Result:

A message displays that the login has been added.

............................................................................................................................................................

17 To exit the Add a User Account form, tab to the File menu, highlight
Exit then press Enter.

Result:

The Accounts for Users and Groups form is displayed.

............................................................................................................................................................

18 To exit the Accounts for Users and Groups form, tab to the File
menu, highlight Exit SAM then press Enter.

............................................................................................................................................................

19 At the prompt, type cat /etc/passwd | pg then view the display to
determine if permissions have been properly set for the created user
ID in the passwd file.

............................................................................................................................................................

20 At the prompt, type exit.

Result:

A logout root and telnet status message is displayed.
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............................................................................................................................................................

21 For each user entered in the Login Name field in Step 10 of this task,
perform the “Add a user” (4-4) task to add the user to the WaveStar
NMS application.
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Assign user privileges to a user on a Windows PC
....................................................................................................................................................................................................................................

Purpose Use this task to assign user privileges to a user on a PC running
Windows software.

Before you begin Be sure that the user ID has been created.

Permissions You must have system administrator privileges on the PC in order to
perform this task.

Task Perform the steps below to assign user privileges to a user on a
Windows PC.
............................................................................................................................................................

1 On the Windows main window, click on the Start button in the task
bar.

Result:

A menu is displayed.

............................................................................................................................................................

2 Select Programs > Administrative Tools (Common) > User
Manager.

Result:

The User Manager window is displayed.

............................................................................................................................................................

3 From the User Manager window, select User > New User.

Result:

The New User window is displayed.

............................................................................................................................................................

4 Complete the required Username field and the optional Full Name
and Description fields.

............................................................................................................................................................

5 In the Password field, enter the password associated with the new
user ID.

............................................................................................................................................................

6 In the Confirm Password field, enter the same password.
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............................................................................................................................................................

7 Uncheck User Must Change Password at Next Logon box.

............................................................................................................................................................

8 Check the Password Never Expires box.

............................................................................................................................................................

9 Select the Groups button.

Result:

The Group Membership screen is displayed.

............................................................................................................................................................

10 On the Group Membership screen, view the Member of list for a
Users entry. If Users is not listed, highlight Users in the Not
Member of list and select the Add button.

Important! If an entry other than Users displays in the Member of
list, highlight the entry, then select the Remove button to move the
entry to the Not Member of list.

Result:

Users displays in the Member of list.

............................................................................................................................................................

11 On the Group Membership screen, select OK.

Result:

The Group Membership screen closes.

............................................................................................................................................................

12 On the New User screen, select OK.

Result:

The New User screen closes and the new user is listed on the
User Manager screen.
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Assign system administrator privileges on a Windows PC
....................................................................................................................................................................................................................................

Purpose Use this task to assign system administrator privileges to a user on a
Windows PC.

Before you begin Be sure that the user ID has been created.

Permissions You must be authorized to perform this task.

Tasks Perform the steps below to create a system administrator login
and assign system administrator privileges on a Windows PC.
............................................................................................................................................................

1 On the Windows main window, click on the Start button in the task
bar.

Result:

A menu is displayed.

............................................................................................................................................................

2 Select Programs > Administrative Tools (Common) > User
Manager.

Result:

The User Manager window is displayed.

............................................................................................................................................................

3 From the User Manager window, select User > New User.

Result:

The New User window is displayed.

............................................................................................................................................................

4 Complete the required Username field and the optional Full Name
and Description fields.

............................................................................................................................................................

5 In the Password field, enter the password associated with the new
user ID.

............................................................................................................................................................

6 In the Confirm Password field, enter the same password.
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............................................................................................................................................................

7 Uncheck User Must Change Password at Next Logon box.

............................................................................................................................................................

8 Check the Password Never Expires box.

............................................................................................................................................................

9 Select the Groups button.

Result:

The Group Membership screen is displayed.

............................................................................................................................................................

10 On the Group Membership screen, view the Member of list for an
Administrators entry. If Administrators is not listed, highlight
Administrators in the Not Member of list and select the Add button.

Important! If an entry other than Administrators displays in the
Member of list, highlight the entry then select the Remove button to
move the entry to the Not Member of list.

Result:

Administrators displays in the Member of list.

............................................................................................................................................................

11 On the Group Membership screen, select OK.

Result:

The Group Membership screen closes.

............................................................................................................................................................

12 On the New User screen, select OK.

Result:

The New User screen closes and the new user is listed on the
User Manager screen.
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Add a user on the server
....................................................................................................................................................................................................................................

Note There is no need to add any new users on the server. Any necessary
User IDs should have already been loaded with the software.
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Section V: Administer SAGE desktop integration users

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the Secure Access Gateway
for Enterprises (SAGE) Desktop Integration feature.

Definition: SAGE Desktop
Integration

SAGE Desktop Integration is an optional feature for NMS
applications that allows users to access multiple WaveStar NMS
systems through a web browser.

A system administrator may add or delete SAGE users to/from an
HP-UX client workstation.

Since SAGE requires each user to have an individual profile, the
system administrator needs to manage these, along with user logins
and passwords. The administrator also needs to support users with
how to log into SAGE, how to change passwords, how to modify user
attributes, and how to interpret and respond to system messages.

Related information For more detailed system administration instructions, see the Secure
Access Gateway for Enterprises (SAGE) Manual.
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Add a user to a SAGE workstation
....................................................................................................................................................................................................................................

Purpose Use this task to add a user to a SAGE workstation.

Task Perform the steps below to add a user to a SAGE client
workstation.
............................................................................................................................................................

1 Log into the SAGE client workstation as system administrator.

............................................................................................................................................................

2 Click on the IWS icon.

Result:

The IWS HOME PAGE form is displayed.

............................................................................................................................................................

3 Click on the WaveStar NMS Network Module icon.

Result:

The WaveStar NMS Network Module form is displayed.

............................................................................................................................................................

4 Select Administration > Security > Security Privileges.

Result:

The Controller: Security Privilege Query Box #1 form is
displayed.

............................................................................................................................................................

5 At the Work Group ID field, type sawg then click OK.

............................................................................................................................................................

6 Select Action, and Add User to Work Group.

Result:

The Add User to Work Group form is displayed.

............................................................................................................................................................

7 Type the user ID in the User ID field and click OK.
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Important! If a specific geographic domain is required for the new
User ID, refer to Chapter 5, “Domain partitioning for provisioning
operations” in this document.

Result:

The user ID is added to the SAGE workstation.
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Delete a user from a SAGE workstation
....................................................................................................................................................................................................................................

Purpose Use this task to delete a user from a SAGE workstation.

Task Perform the steps below to delete a user from a SAGE
workstation.
............................................................................................................................................................

1 Log into the SAGE client workstation as system administrator.

............................................................................................................................................................

2 Click on the IWS icon.

Result:

The IWS HOME PAGE form is displayed.

............................................................................................................................................................

3 Click on the WaveStar NMS Network Module icon.

Result:

The WaveStar NMS Network Module form is displayed.

............................................................................................................................................................

4 Select Administration>Security>Security Privileges.

Result:

The Controller: Security Privilege Query Box form is
displayed.

............................................................................................................................................................

5 At the Work Group ID field, type sawg and click OK.

............................................................................................................................................................

6 Select the user ID to be deleted then select Action and Delete User.

Result:

The selected user ID is deleted from the workstation.
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Section VI: Printer Administration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add a network or local serial printer and
how to set up the Common Desktop Environment (CDE) printer icon.

Contents
Install a networked printer on a WaveStar NMS
server

2-39

Add a network printer 2-41

Add a local serial printer 2-43

Set up the Common Desktop Environment (CDE)
printer icon

2-44
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Install a networked printer on a WaveStar NMS server
....................................................................................................................................................................................................................................

Purpose Use this task to install a networked printer on a WaveStar NMS
server.

Before you begin Before you begin this task, collect the following information about the
network printer from the system administrator and/or by printing the
test/configuration page from the printer.

• Printer name

• IP Address

• LAN Hardware Address

• Name or IP address of the server providing spooler facilities

Task Perform the steps below to add a networked printer on a
WaveStar NMS server.
............................................................................................................................................................

1 Take the printer off-line.

............................................................................................................................................................

2 Press the Menu button until TEST MENU appears in the display.

............................................................................................................................................................

3 Press the Item button until SELF TEST appears in the display.

............................................................................................................................................................

4 Press Enter.

Result:

A printer status sheet prints. This status sheet indicates the LAN
hardware address (LAN HW ADDRESS), network peripheral
name (HOST NAME), and the IP address, if these values have
been assigned to the printer.

............................................................................................................................................................

5 Press On Line.

............................................................................................................................................................

6 Using the system console, log in as root on the primary server via the
system console.
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............................................................................................................................................................

7 Enter ksh /install/prtinstall at the # prompt.

Result:

Additional prompts display.

............................................................................................................................................................

8 Respond to the IP address, printer name, and Type in the LAN

Hardware Address prompts.

Result:

The network printer is added.

Section VI: Printer Administration
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Add a network printer
....................................................................................................................................................................................................................................

Purpose Use this task to add a network printer to your workstation.

Before you begin Before you begin this task, collect the following information:

• Printer name (the printer name must be six characters or less)

• IP Address

The network printer must be connected to Ethernet. The local serial
printer must be connected to the asynchronous mux board.

Task Perform the steps below to add a network printer.
............................................................................................................................................................

1 Take the printer off-line.

............................................................................................................................................................

2 Press the Menu button until TEST MENU appears in the display.

............................................................................................................................................................

3 Press the Item button until SELF TEST appears in the display.

............................................................................................................................................................

4 Press Enter.

Result:

A printer status sheet prints. This status sheet indicates the LAN
hardware address (LAN HW ADDRESS), network peripheral
name (HOST NAME), and the IP address, if these values have
been assigned to the printer.

............................................................................................................................................................

5 Press On Line.

............................................................................................................................................................

6 Using the system console, log in as root on the primary server via the
system console.

............................................................................................................................................................

7 Enter ksh /install/prtinstall at the # prompt.

Result:

Additional prompts display.
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............................................................................................................................................................

8 Respond to the IP address, printer name, and Type in the LAN

Hardware Address prompts.

Result:

The network printer is added.

Section VI: Printer Administration
Add a network printer

Platform Administration

....................................................................................................................................................................................................................................

2 - 4 2 Lucent Technologies 365-309-245
Issue 1, October 2001

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Add a local serial printer
....................................................................................................................................................................................................................................

Purpose Use this task to add a local serial printer.

Before you begin Before you begin this task, collect the following information:

• Printer name (the printer name must be six characters or less)

Task Perform the steps below to add a local serial printer to your
workstation.
............................................................................................................................................................

1 Using the system console, log in as root onto the primary server.

............................................................................................................................................................

2 Enter ksh /install/prtinstall at the # prompt.

............................................................................................................................................................

3 Answer the questions as appropriate.

Result:

The local serial printer is added.
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Set up the Common Desktop Environment (CDE) printer icon
....................................................................................................................................................................................................................................

Purpose Use this task to configure the workstation to print WaveStar NMS
forms to a local printer.

The workstation can be configured to enable the CDE printer icon to
be used to print WaveStar NMS forms to a local printer.

Task Perform the steps below to set up the CDE printer icon.
............................................................................................................................................................

1 Log in as root.

............................................................................................................................................................

2 Enter cd /config at the UNIX prompt.

............................................................................................................................................................

3 Enter vi sys.vuewmrc

............................................................................................................................................................

4 Change the PUSH_ACTION variable in the “CONTROL Printer” section
to PUSH_ACTION f.action PrintPush

............................................................................................................................................................

5 Save the file.

............................................................................................................................................................

6 Exit the file.

............................................................................................................................................................

7 Enter cd /usr/vue/config/types

............................................................................................................................................................

8 Enter vi PrintPush.vf

............................................................................................................................................................

9 Change the EXEC-STRING variable in the “Action PrintPush” section to
EXEC-STRING bin/ksh -c ’xwd -frame | xpr -device ps
-cutoff 70 -rv | lp -o nb -o postscript’

............................................................................................................................................................

10 Save the file.

............................................................................................................................................................

11 Exit the file.
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............................................................................................................................................................

12 Select Exit on the CDE to reboot the workstation.
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Section VII: Power down workstations

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power down HP and
Windows workstations.

Contents
Power down an HP-UX workstation 2-47

Power down a Windows workstation 2-48
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Power down an HP-UX workstation
....................................................................................................................................................................................................................................

Purpose Use the following task to power down an HP-UX workstation.

Before you begin Before you begin this task, be sure that the WaveStar NMS
application has been shut down. (See “Stop WaveStar NMS on an
HP-UX workstation” (3-24).)

Task Use this task to power down an HP-UX workstation.
............................................................................................................................................................

1 Log in to the workstation as root.

............................................................................................................................................................

2 At the prompt, type cd /

Result:

The directory is changed.

............................................................................................................................................................

3 At the prompt, type shutdown -h -y now

Result:

The shutdown process initiates and eventually displays the
following message:
System has halted
OK to turn off power or reset system
UNLESS ’wait for UPS to turn off power’ message was

printed above

............................................................................................................................................................

4 Switch off the workstation (press the power switch or turn key, as
appropriate).

Result:

The workstation is powered off.

............................................................................................................................................................

5 Switch off all associated peripherals, for example, the control
terminal, external disk drives, external tape drives, and modems.
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Power down a Windows workstation
....................................................................................................................................................................................................................................

Purpose Use the following task to power down a Windows workstation.

Before you begin Before you begin this task, be sure that the WaveStar NMS
application has been shut down. See “Stop WaveStar NMS on a
Windows workstation” (3-25).

Task Use this task to power down a Windows workstation.
............................................................................................................................................................

1 Log in to the workstation as Administrator.

............................................................................................................................................................

2 Select Start > Shut Down....

Result:

The Shut Down Windows dialog box displays.

............................................................................................................................................................

3 Select the Shut Down... radio button then select Yes.

Result:

The Windows workstation powers down.

............................................................................................................................................................

4 Switch off the workstation (press the power switch or turn key, as
appropriate).

Result:

The workstation is powered off.

............................................................................................................................................................

5 Switch off all associated peripherals, for example, the control
terminal, external disk drives, external tape drives, and modems.
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Section VIII: Power down servers and MC/ServiceGuard
configurations

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power down:

• Single-servers and Geographic Redundancy servers (simplified or
full)

• an MC/ServiceGuard cluster

• Local Redundancy servers

• Windows servers

Contents
Power down a single server 2-50

Power down MC/ServiceGuard cluster (local
redundancy configuration)

2-51

Power down a server (geographic redundancy
configuration)

2-53

Power down an Windows server 2-55
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Power down a single server
....................................................................................................................................................................................................................................

Purpose Use the following task to power down a single server, with or without
mirrored disks.

Before you begin Before you begin this task, be sure that the WaveStar NMS
application has been shut down. See “Stop WaveStar NMS on a single
server” (3-17).

Task Complete the following task to power down a single server.
............................................................................................................................................................

1 On the control terminal, log in as root.

............................................................................................................................................................

2 At the prompt, type cd /

Result:

The directory is changed.

............................................................................................................................................................

3 At the prompt, type shutdown -h -y now

Result:

The shutdown process initiates and eventually displays the
following message:
System has halted
OK to turn off power or reset system
UNLESS ’wait for UPS to turn off power’ message was

printed above

............................................................................................................................................................

4 Switch off the HP server (press the power switch or turn key, as
appropriate).

Result:

The HP server is powered off.

............................................................................................................................................................

5 Switch off all associated peripherals, for example, the control
terminal, external disk drives, external tape drives, and modems.

Section VIII: Power down servers and
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Power down MC/ServiceGuard cluster (local redundancy
configuration)
....................................................................................................................................................................................................................................

Purpose Use the following task to power down an MC/ServiceGuard cluster
hardware configuration, which contains HP servers in a local
redundancy configuration, with or without mirrored disks.

Before you begin Before you begin this task, be sure that the WaveStar NMS
application has been shut down.

Task Perform the steps below to bring the server down when the local
redundancy hardware configuration is used.
............................................................................................................................................................

1 Log into any server in the cluster as root.

............................................................................................................................................................

2 At the prompt, enter sam and then press Enter.

Result:

The System Administration Manager window’s SAM Areas
display.

............................................................................................................................................................

3 From the System Administration Manager window, select Clusters >
High Availability Clusters > Cluster Admin.

............................................................................................................................................................

4 Select ITM Cluster, then select Actions > Shutdown Cluster .

Result:

The shutdown process initiates and eventually displays the
following message:
System has halted
OK to turn off power or reset system
UNLESS ’wait for UPS to turn off power’ message was

printed above

............................................................................................................................................................

5 Switch off the HP server (press the power switch or turn key, as
appropriate).
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Result:

The HP server is powered off.

............................................................................................................................................................

6 Repeat Step 3 through Step 5 until all cluster servers are off.

............................................................................................................................................................

7 Switch off all peripherals associated with the cluster, for example, the
control terminal, external disk drives, external tape drives, and
modems.
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Power down a server (geographic redundancy configuration)
....................................................................................................................................................................................................................................

Purpose Use the following task to power down an HP server that has a
simplified or full geographic redundancy configuration, with or
without mirrored disks.

Before you begin Before you begin this task, be sure that the WaveStar NMS
application has been shut down. (See “Stop WaveStar NMS on a
server with a geographic redundancy configuration” (3-19).)

Task Complete the following task to power down a server with a
geographic redundancy configuration.
............................................................................................................................................................

1 Log in on the control terminal of the primary server as root.

............................................................................................................................................................

2 At the prompt, type cd /

Result:

The directory is changed.

............................................................................................................................................................

3 At the prompt, type shutdown -h -y now

Result:

The shutdown process initiates and eventually displays the
following message:
System has halted
OK to turn off power or reset system
UNLESS ’wait for UPS to turn off power’ message was

printed above

............................................................................................................................................................

4 Switch off the HP server (press the power switch or turn key, as
appropriate).

Result:

The HP server is powered off.

............................................................................................................................................................

5 Switch off all associated peripherals, for example, the control
terminal, external disk drives, external tape drives, and modems.
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............................................................................................................................................................

6 Log in on the control terminal of the secondary server as root.

............................................................................................................................................................

7 At the prompt, type cd /

Result:

The directory is changed.

............................................................................................................................................................

8 At the prompt, type shutdown -h -y now

Result:

The shutdown process initiates and eventually displays the
following message:
System has halted
OK to turn off power or reset system
UNLESS ’wait for UPS to turn off power’ message was

printed above

............................................................................................................................................................

9 Switch off the HP server (press the power switch or turn key, as
appropriate).

Result:

The HP server is powered off.

............................................................................................................................................................

10 Switch off all associated peripherals, for example, the control
terminal, external disk drives, external tape drives, and modems.
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Power down an Windows server
....................................................................................................................................................................................................................................

Purpose Use the following task to power down a Windows server.

Before you begin Before you begin this task, be sure that the WaveStar NMS
application has been shut down.

Task Use this task to power down a Windows server.
............................................................................................................................................................

1 Log in to the server as Administrator.

............................................................................................................................................................

2 Press the Ctrl, Alt, and Del buttons.

Result:

The Windows Security dialog box displays.

............................................................................................................................................................

3 Press the Shut Down button.

Result:

The Shut Down Windows dialog box displays.

............................................................................................................................................................

4 Select the Shut Down... radio button.

Result:

The Shutdown Computer dialog box displays.

............................................................................................................................................................

5 Select the OK radio button.

Result:

The Windows server powers down.

............................................................................................................................................................

6 Switch off the terminal server (press the power switch or turn key, as
appropriate).

Result:

The terminal server is powered off.
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............................................................................................................................................................

7 Switch off all associated peripherals, for example, the control
terminal, external disk drives, external tape drives, and modems.
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3 System administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes tasks performed to administer WaveStar NMS.

Contents
Section I: Start WaveStar NMS server
applications

3-4

Start WaveStar NMS on a single server 3-5

Start WaveStar NMS on a server with a geographic
redundancy configuration

3-7
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Section II: Start WaveStar NMS User Interface
(UI) applications

3-9

Start WaveStar NMS on a MC/ServiceGuard Cluster 3-10

Start WaveStar NMS on a Windows terminal server 3-12

Start WaveStar NMS on an HP-UX workstation 3-13

Start WaveStar NMS on a Windows workstation
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3-14
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Stop WaveStar NMS on a server with a geographic
redundancy configuration

3-19

Stop WaveStar NMS package 3-20

Stop WaveStar NMS application on a
MC/ServiceGuard cluster

3-21

Stop the WaveStar NMS application on a Windows
terminal server

3-22

Stop WaveStar NMS on a specific node using sam 3-23

Stop WaveStar NMS on an HP-UX workstation 3-24
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Modify a description of a noncontrollable network
element

3-50

Delete a network element from the database 3-52

Section X: Set Filtering Criteria 3-54

Set filtering criteria for WaveStar NMS alarms 3-55

Section XI: Set Preferences 3-56
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Section I: Start WaveStar NMS server applications

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to start WaveStar NMS server applications.

Background The initial step to start WaveStar NMS is to power on the server. (See
the “power on” tasks in Chapter 2, “Platform Administration”.) There
are a few possible configurations users can have with the server, but
the configurations fall into three main categories — local redundancy,
geographic redundancy, and single-server. Within single-server, the
configuration may or may not contain mirrored disks.

Start the host application The host application starts when the WaveStar NMS application is set
to run level 4. See “Run level 4” (1-6) for additional details.

Contents
Start WaveStar NMS on a single server 3-5

Start WaveStar NMS on a server with a geographic
redundancy configuration

3-7

Start WaveStar NMS on a Windows terminal server 3-8
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Start WaveStar NMS on a single server
....................................................................................................................................................................................................................................

Purpose Use this procedure to start the WaveStar NMS application on a single
server.

Before you begin Before you begin this task, be sure that the single server has been
powered up. See “Power on an HP server (single-server
configuration)” (2-5).

Start WaveStar NMS on a
single server

Complete the following steps to start the WaveStar NMS
application on a single server.
............................................................................................................................................................

1 Log into the server as root.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

A message displays a line of current run level information, such
as run-level 3 Oct 30 11:26 3 0 S.

..........................................................................................................................................................

3 Continue with one of the following options.

IF THEN

run-level is 3, proceed to the next step to continue.

run-level is 4, the application is already running; no
further action is necessary.

run-level is not 3 or 4, contact the system support staff. (See
the Technical support information
located at the beginning of this
document for details).

............................................................................................................................................................

4 At the prompt, enter init 4.

Result:

The run level is changed to run-level 4.
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............................................................................................................................................................

5 At the prompt, enter tail —f/etc/rc.log

Important! To terminate this command, press the Ctrl and c buttons.

Result:

The message,

WS-NMS Application has been started...

HP-UX run-level transition completed

<Weekday> MMM DD HH:MM:SS <timezone> YYYY

displays.

Section I: Start WaveStar NMS server
applications
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Start WaveStar NMS on a server with a geographic redundancy
configuration
....................................................................................................................................................................................................................................

Purpose Use this procedure to start the WaveStar NMS application on a
simplified or full geographic redundancy server.

Before you begin Be sure that the simplified or full geographic redundant server has
been powered up. See “Power on an HP server (geographic
redundancy configuration)” (2-7).

Task Perform the following step to start WaveStar NMS on a server
with a simplified or full geographic redundancy configuration.
............................................................................................................................................................

1 Log in to the primary server as root.

............................................................................................................................................................

2 Enter ksh /usr/dacscan/bin/StartUp

Result:

WaveStar NMS is initiated on the simplified or full geographic
redundancy server. If problems are identified, the startup
terminates.
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Start WaveStar NMS on a Windows terminal server
....................................................................................................................................................................................................................................

Overview Once the Windows terminal server is powered on, (see “Power on a
Windows terminal server” (2-8)), it is not necessary to start the
WaveStar NMS application on a Windows terminal server, therefore
no steps are required.
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Section II: Start WaveStar NMS User Interface (UI) applications

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to start WaveStar NMS user interface
applications.

Background Once the servers are powered up, (as described in the previous section
of this chapter), users may start WaveStar NMS:

• using the MC/ServiceGuard cluster configuration

• on an HP-UX workstation

• on a Windows workstation

Contents
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Start WaveStar NMS on a Windows terminal server 3-12

Start WaveStar NMS on an HP-UX workstation 3-13

Start WaveStar NMS on a Windows workstation
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3-14
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Start WaveStar NMS on a MC/ServiceGuard Cluster
....................................................................................................................................................................................................................................

Purpose Use this procedure to start WaveStar NMS on a MC/ServiceGuard
cluster configuration (local redundancy).

Before you begin Be sure that the servers within the cluster have been powered up. See
“Power on HP servers (MC/ServiceGuard cluster - local redundancy
configuration)” (2-6).

Task Perform the following step to start WaveStar NMS on a
MC/ServiceGuard cluster.
............................................................................................................................................................

1 Log into any server within the cluster as root.

..........................................................................................................................................................

2 To determine if the package is running on a member of the cluster,
view the cluster/package status (see “View the cluster status
information” (3-35) for details) then continue with one of the
following options.

IF THEN

the package is not running
on a member of the cluster,

proceed to the next step to continue.

the package is running on
a member of the cluster,

no further action is necessary.

............................................................................................................................................................

3 Start the WaveStar NMS package.

Result:

WaveStar NMS package is started.

............................................................................................................................................................

4 Repeatedly perform a status check to view the cluster/package status
(see “View the cluster status information” (3-35) for details) until a
Running status displays.

Result:

Application status will move from Halted to Starting to
Running. Since the status changes take several minutes to

Section II: Start WaveStar NMS User
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complete, the status check is performed repeatedly until the
desired results display.
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Start WaveStar NMS on a Windows terminal server
....................................................................................................................................................................................................................................

Overview Once the Windows terminal server is powered on, (see “Power on a
Windows terminal server” (2-8)), it is not necessary to start the
WaveStar NMSapplication on a Windows terminal server, therefore no
steps are required.
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Start WaveStar NMS on an HP-UX workstation
....................................................................................................................................................................................................................................

Purpose Use this procedure to start WaveStar NMS on an HP-UX workstation.

Before you begin Before you begin, be sure that the HP-UX workstation is powered on.
See “Power on an HP-UX workstation” (2-10).

Task Complete the following steps to start WaveStar NMS on an
HP-UX workstation.
............................................................................................................................................................

1 Log in to the HP-UX workstation.

Result:

The WaveStar NMS icon displays on the Common Desktop
Environment (CDE) panel. (The icon may display as a Lucent
logo.)

............................................................................................................................................................

2 Double-click the icon.

Result:

The WaveStar NMS Network Map displays.
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Start WaveStar NMS on a Windows workstation (PC)
....................................................................................................................................................................................................................................

Purpose Use this procedure to start the WaveStar NMS application on a
Windows workstation (PC).

Before you begin Before running WaveStar NMS on a Windows workstation, the
workstation must be powered on (see “Power on a Windows
workstation” (2-11)) and the WaveStar NMS application must be
loaded on the workstation. This task assumes that the application has
been already loaded on the workstation.

Task Complete the following steps to start WaveStar NMS on a
Windows workstation.
............................................................................................................................................................

1 Log into the Windows workstation.

Result:

The Windows desktop displays.

............................................................................................................................................................

2 Locate the icon on the desktop, then double-click the icon.

Result:

The WaveStar NMS Network Map displays.
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Section III: Stop WaveStar NMS

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to stop WaveStar NMS.

Stop the host application The host application stops whenWaveStar NMS is brought to run level
3 (multi-user mode).

Under certain circumstances, it may be necessary to bring the
WaveStar NMS application to run level 3, for example, if the system
needs a new software load.

See “Run level 3” (1-6) for additional details.
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Stop WaveStar NMS
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the WaveStar NMS application on PCs and
workstations.

Other tasks are required to support stopping the WaveStar NMS
application on servers with single, local redundancy, and geographic
redundancy configurations. For example,

• to stop the WaveStar NMS application on single servers, see
“Stop WaveStar NMS on a single server” (3-17).

• to stop the WaveStar NMS application on servers running a local
redundancy configuration, see “Stop WaveStar NMS application
on a MC/ServiceGuard cluster” (3-21).

• to stop the WaveStar NMS application on servers running a
geographic redundancy configuration, see “Stop WaveStar NMS
on a server with a geographic redundancy configuration” (3-19).

Task Complete the following task to stop the WaveStar NMS
application.
............................................................................................................................................................

1 On the Network Map, do one of the following:

• Select File > Exit.

• Select the close button in the top right corner of the Network
Map.

Result:

A confirmation dialog box appears.

............................................................................................................................................................

2 At the dialog box, selectOK.

Result:

The Controller session ends. You are logged off the WaveStar
NMS server. The Login form displays.
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Stop WaveStar NMS on a single server
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the WaveStar NMS application on a single
server.

Start WaveStar NMS on a
single server

Complete the following steps to stop the WaveStar NMS
application on a single server.
............................................................................................................................................................

1 Log into the server as root.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

A message displays a line of current run level information, such
as run-level 4 Oct 30 11:26 3 0 S.

..........................................................................................................................................................

3 Continue with one of the following options.

IF THEN

run-level is 4, proceed to the next step to continue.

run-level is 3, the application is not running; no
further action is necessary.

run-level is not 3 or 4, contact the system support staff. (See
the Technical support information
located at the beginning of this
document for details).

............................................................................................................................................................

4 At the prompt, enter init 3.

Result:

The run level is changed to run-level 3.

............................................................................................................................................................

5 At the prompt, enter tail —f/etc/rc.log

Important! To terminate this command, press the Ctrl and c buttons.
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Result:

The message,

HP-UX run-level transition completed

<Weekday> MMM DD HH:MM:SS <timezone> YYYY

displays.
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Stop WaveStar NMS on a server with a geographic redundancy
configuration
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop WaveStar NMS on a simplified or full
geographic redundancy server.

Task Perform the following step to stop WaveStar NMS on a server
with a simplified or full server geographic redundancy
configuration.
............................................................................................................................................................

1 Log on to the primary server using a geographic redundancy
configuration as root.

............................................................................................................................................................

2 At the prompt, enter ksh /usr/dacscan/bin/ShutDown

Result:

The WaveStar NMS application is stopped.
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Stop WaveStar NMS package
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the WaveStar NMS package using the sam
application.

This task is specific to MC/ServiceGuard cluster configurations

Task Perform the following step to stop the WaveStar NMS package.
............................................................................................................................................................

1 Log into the cluster as root.

............................................................................................................................................................

2 At the prompt, enter sam and then press Enter.

Result:

The System Administration Manager window’s SAM Areas
display.

............................................................................................................................................................

3 From the System Administration Manager window, select Clusters >
High Availability Clusters > Cluster Admin

............................................................................................................................................................

4 Select ITM Cluster, then select Actions > Shutdown Cluster .

Result:

The shutdown process initiates and eventually displays the
following message:
System has halted
OK to turn off power or reset system
UNLESS ’wait for UPS to turn off power’ message was

printed above
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Stop WaveStar NMS application on a MC/ServiceGuard cluster
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the WaveStar NMS application on a
MC/ServiceGuard cluster.

Task Perform the following step to stop the WaveStar NMS application
on a cluster.
............................................................................................................................................................

1 Log into any server in the cluster as root.

..........................................................................................................................................................

2 To determine if the package is running on a member of the cluster,
view the cluster/package status (see “View the cluster status
information” (3-35) for details) then continue with one of the
following options.

IF THEN

the package is running on
a member of the cluster,

proceed to the next step to continue.

the package is not running
on a member of the cluster,

no further action is necessary.

............................................................................................................................................................

3 Stop the WaveStar NMS package. See “Stop WaveStar NMS package”
(3-20).

Result:

WaveStar NMS is stopped.

............................................................................................................................................................

4 Repeatedly perform a status check to view the cluster/package status
(see “View the cluster status information” (3-35) for details) until a
Halted status displays.

Result:

Application status will move from Running to Stopping to
Halted. Since the status changes take several minutes to
complete, the status check is performed repeatedly until the
desired results display.

Section III: Stop WaveStar NMS System administration

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 3 - 2 1

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Stop the WaveStar NMS application on a Windows terminal
server
....................................................................................................................................................................................................................................

Overview Since the WaveStar NMS application is not run on a Windows
terminal server, no steps are required.
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Stop WaveStar NMS on a specific node using sam
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the WaveStar NMS application on a
specific node using the sam application.

Task Perform the steps below to stop the WaveStar NMS application
on a specific node.
............................................................................................................................................................

1 Log into either the primary or the standby machine as root.

............................................................................................................................................................

2 Enter sam at the prompt.

Result:

The sam application displays.

............................................................................................................................................................

3 Select Clusters > High Availability Clusters > Package Admin.

............................................................................................................................................................

4 Highlight the ITMHost entry.

............................................................................................................................................................

5 On the pull down menu, select Actions > Halt package.

............................................................................................................................................................

6 At the displayed dialog box, confirm that the package should be
halted.

Result:

The package is stopped.
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Stop WaveStar NMS on an HP-UX workstation
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the WaveStar NMS application on an
HP-UX workstation.

StopWaveStar NMS on an
HP-UX workstation

Complete the following steps to stop the WaveStar NMS
application on an HP-UX workstation.
............................................................................................................................................................

1 On the Network Map, do one of the following:

• Select File > Exit.

• Select the close button in the top right corner of the Network
Map.

Result:

A confirmation dialog box appears.

............................................................................................................................................................

2 At the dialog box, select OK.

Result:

The WaveStar NMS session is terminated.

Section III: Stop WaveStar NMS System administration

....................................................................................................................................................................................................................................

3 - 2 4 Lucent Technologies 365-309-245
Issue 1, October 2001

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Stop WaveStar NMS on a Windows workstation
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the WaveStar NMS application on a
Windows workstation.

StopWaveStar NMS on a
Windows workstation

Complete the following steps to stop the WaveStar NMS
application on a Windows workstation.
............................................................................................................................................................

1 On the Network Map, do one of the following:

• Select File > Exit.

• Select the close button in the top right corner of the Network
Map.

Result:

A confirmation dialog box appears.

............................................................................................................................................................

2 At the dialog box, select OK.

Result:

The WaveStar NMS session is terminated.
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Stop WaveStar NMS with UPS
....................................................................................................................................................................................................................................

Introduction An Uninterruptible Power Supply (UPS) protects against power
failures. It is used to protect the main servers and their essential
peripherals from minutes of power failure. In the case of a longer
power loss, the UPS enables the system to shut down gracefully.

Configurable file The UPS provides a configurable file that contains two timers used in
the shutdown process. When the WaveStar NMS application receives
notification to indicate a loss of AC power, the application runs a
shutdown script that results in a graceful shutdown of the application
within the time limit of these timers:

• shutdown_delay_mins: This parameter indicates the number of
minutes following notification that its UPS has switched to
internal battery power before the UPS monitor initiates a
shutdown. The default value for this parameter is one minute.

• shutdown_timeout_mins: This parameter indicates the number of
minutes to monitor the shutdown operation before a reboot is
initiated with the halt option. The default value for this parameter
is five minutes.

These timers are tunable at time of installation and can be changed
subsequent to installation; however, normally they should not need to
be changed. UPS is not supported in local redundancy configurations
and is only compatible with Non-Safeguard configurations.

Systems configured with UPS are brought into init level 4
automatically on power up.
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Section IV: Administer the system cron file

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the system cron file.

Background The cron file contains commands that are automatically executed at
set times.

Certain commands can be executed at desired times by using the
system cron. The root cron and dacscan cron operate independently.
The root cron has various administrative functions that are executed
on a routine basis, such as daily backups and file system space
monitoring. The dacscan cron has various application-related
functions, such as database syncs and auto-implementation.

File format The read-only root cron file format is such that everything on the
active line is separated by blanks or tabs. Each field of the active line
correlates to a subset of time. The following is an example of an
active line, with each field separated by a tab (indicated by -->):

min-->hour-->day-->month-->day-of-week-->command min: 0-59
hour: 0-23 day:1-31 month:1-12 day of week: 0-6 (Sunday=0)
command: program to be executed

In place of numerics, an asterisk (*) may be used to imply the whole
range (wild card). A sample active line may look like:

01 04,23 * * * ksh /usr/dacscan/bin/auto_backup &

This line implies that the auto_backup will execute in the background
one minute past the 4th hour and, again, one minute past the 23rd
hour, every day, every month and every day of the week.

The cron files can be edited. Once the file is created/edited, it must be
loaded into the cron.

Contents
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View the system cron file
....................................................................................................................................................................................................................................

Purpose Use this procedure to view the system cron file.

Important! The system cron file is a read-only file. It can only be
edited by the superuser (root user).

Task Perform the steps below to view the system cron file.
............................................................................................................................................................

1 Using the system console, log into the primary server as root.

............................................................................................................................................................

2 Enter crontab -l at the # prompt.

............................................................................................................................................................

3 Press Enter.

Result:

The root cron file is displayed.
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Edit the system cron file
....................................................................................................................................................................................................................................

Purpose Use this procedure to change the desired execution times of
commands in the system cron file.

Important! The system cron file can only be edited by the superuser
(root user).

Task Perform the steps below to edit the system cron file.
............................................................................................................................................................

1 Using the system console, log into the primary server as root.

............................................................................................................................................................

2 Enter cd /usr/spool/cron/crontabs <CR> at the # prompt.

............................................................................................................................................................

3 Enter ls -l <Enter> at the # prompt.

Result:

The files root and dacscan are listed.

............................................................................................................................................................

4 Open the root or dacscan file using the vi editor.

............................................................................................................................................................

5 Edit the desired parameter.

..........................................................................................................................................................

6
IF... THEN...

The root file is being
edited.

Log in as root and enter crontab
root <Enter> at the # prompt.

Result:

The root file is read into the system
cron.

The dacscan file is being
edited.

Log in as dacscan and enter crontab
dacscan <Enter> at the # prompt.

Result:

The dacscan file is read into the
system cron.
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Section V: Local redundancy configuration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to switch to a backup server using a local
redundancy configuration using MC/ServiceGuard. It also includes
package switching tasks and information on how to administer
clusters.

A switchover may need to occur in the case of a hardware failure,
software upgrade, or for general maintenance. If the primary server
fails, the standby server takes over.

A configuration that has server redundancy enhances the availability
of the system. Since WaveStar NMS supports single-server (with or
without disk mirroring), local redundancy , and geographic
redundancy configurations, it has several tasks to support the
configuration being used. There are no switchover tasks for the
single-server configurations since they cannot be switched.

Monitoring the switchover It is recommended to ensure that the monitoring process is present.
The standby server has a pulse process that monitors the heartbeat of
the primary server. These processes can be started and stopped
manually. The pulse process resides on the Standby server. This
process is used to determine whether the primary server is alive. The
heartbeat process resides on the primary server. This process is used
as a detection mechanism for the standby server.

Contents
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View the cluster status information 3-35

System administration

....................................................................................................................................................................................................................................

3 - 3 0 Lucent Technologies 365-309-245
Issue 1, October 2001



Switch to a standby server
....................................................................................................................................................................................................................................

Purpose Use this procedure to switch to a standby server when using the local
redundancy configuration.

Before you begin If package switching is disabled, the user must first start up the
application and then enable switching.

Task Perform the steps below to switch to a standby server (for local
redundancy configuration).
............................................................................................................................................................

1 Log into either the primary or the standby machine as root.

............................................................................................................................................................

2 Enter sam at the prompt.

............................................................................................................................................................

3 Select the Clusters option.

............................................................................................................................................................

4 Select the High Availability Clusters option.

............................................................................................................................................................

5 Select the Package Administration option.

............................................................................................................................................................

6 Highlight the ITMHost entry.

............................................................................................................................................................

7 Select the Actions menu.

............................................................................................................................................................

8 Select the Move a Package option.

............................................................................................................................................................

9 Select the Standby Host entry.

............................................................................................................................................................

10 Select OK.

............................................................................................................................................................

11 Confirm that the system successfully switched over.
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Enable automatic package switching
....................................................................................................................................................................................................................................

Purpose Use this procedure to enable package switching (local redundancy
configuration).

Task Perform the steps below to enable package switching.
............................................................................................................................................................

1 Using the system console, log into either the primary or the standby
server as root.

............................................................................................................................................................

2 Enter sam at the prompt.

............................................................................................................................................................

3 Select the Clusters option.

............................................................................................................................................................

4 Select the High Availability Clusters option.

............................................................................................................................................................

5 Select the Package Administration option.

............................................................................................................................................................

6 Highlight the ITMHost entry.

............................................................................................................................................................

7 From the Actions menu, select Modify Failover Options.

............................................................................................................................................................

8 Change Automatic Switching value to Enable.

............................................................................................................................................................

9 Select OK.

Result:

Package switching is enabled.
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Disable automatic package switching
....................................................................................................................................................................................................................................

Purpose Use this procedure to disable automatic package switching (local
redundancy configuration).

Task Perform the steps below to disable package switching.
............................................................................................................................................................

1 Using the system console, log into either the primary or the standby
server as root.

............................................................................................................................................................

2 Enter sam at the prompt.

............................................................................................................................................................

3 Select the Clusters option.

............................................................................................................................................................

4 Select the High Availability Clusters option.

............................................................................................................................................................

5 Select the Package Administration option.

............................................................................................................................................................

6 Highlight the ITMHost entry.

............................................................................................................................................................

7 From the Actions menu, select Modify Failover Options.

............................................................................................................................................................

8 Change Automatic Switching value to Disable.

............................................................................................................................................................

9 Select OK.

Result:

Package Switching is disabled.
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Re-add the server to a cluster
....................................................................................................................................................................................................................................

Purpose Use this procedure to re-add the server to a cluster (local redundancy
configuration).

Task Perform the steps below to re-add the server to the cluster.
............................................................................................................................................................

1 Using the system console, log into either the primary or the standby
server as root.

............................................................................................................................................................

2 Enter sam at the prompt.

............................................................................................................................................................

3 Select Clusters option.

............................................................................................................................................................

4 Select High Availability Clusters option.

............................................................................................................................................................

5 Select Package Administration option.

............................................................................................................................................................

6 Highlight the ITMHost entry.

............................................................................................................................................................

7 From the Actions menu, select Specify node to join the cluster.

............................................................................................................................................................

8 Highlight Host name.

............................................................................................................................................................

9 Select OK.

Result:

Host node joins the cluster.
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View the cluster status information
....................................................................................................................................................................................................................................

Purpose Use this procedure to view the cluster status information (local
redundancy configuration).

Task Perform the steps below to view the cluster status information.
............................................................................................................................................................

1 Using the system console, log into either the primary or the standby
server as root.

............................................................................................................................................................

2 Enter cmviewcl -v

Result:

The cluster status information is displayed.

Section V: Local redundancy configuration System administration

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 3 - 3 5

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section VI: Restart and stop the Oracle database

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to restart and stop the Oracle database.

Definition: Oracle database The Oracle database is used to retain persistent copies of application
and customer data. Use of Oracle’s Transaction Processing Option
enables concurrency control and a high degree of data integrity.

Important Starting and stopping the database should be performed only at the
direction of Lucent Customer Support.

Contents
Restart the Oracle database 3-37

Stop the Oracle database 3-38
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Restart the Oracle database
....................................................................................................................................................................................................................................

Purpose Use this procedure to restart the Oracle database.

Important! This procedure is only performed at the direction of
Lucent Customer Support.

Task Perform the steps below to restart the Oracle database.
............................................................................................................................................................

1 Using the system console, log in as oracle.

............................................................................................................................................................

2 Enter /usr/dacscan/toolbin/startdb.sh at the prompt.

Result:

A message is displayed on the form to indicate that the database
has been started.
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Stop the Oracle database
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop the Oracle database.

Task Perform the steps below to stop the Oracle database.
............................................................................................................................................................

1 Using the system console, log in as oracle.

............................................................................................................................................................

2 Stop the application on the primary server.

Reference:

For instructions, see the section “Stop WaveStar NMS” (3-16),
earlier in this chapter.

............................................................................................................................................................

3 Enter /usr/dacscan/toolbin/shutdb.sh at the prompt.

Result:

A message is displayed on the form and indicates that the
database has been stopped.
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Section VII: Administer performance monitoring data export

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the performance monitoring
data export feature.
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Performance monitoring data export
....................................................................................................................................................................................................................................

Definition: Performance
monitoring data export

The Performance monitoring data file export is an optional feature.

Peformance monitoring data file export enables the automatic capture
of all 24-hour performance monitoring data for all network elements
controlled by WaveStar NMS and ITM-SC. When it executes, it
requests that all 24-hour performance monitoring data collected for the
previous day is transferred to an ASCII file—one per Element
Management System (EMS)—on a workstation or PC specified at the
time of installation.

To change the runtime of the file transfer process, see Chapter 2 of
the WaveStar NMS Maintenance Guide.

Set up performance
monitoring data file

transfer

The performance monitoring data file export feature executes
according to the values specified by certain environment variables,
which control how this feature operates:

• $PM_LOG_WKST: The workstation to which performance
monitoring data is exported.
$PM_LOG_DIR: The directory on the above workstation to store
the exported data.
The user must create in this directory one subdirectory for each
day of the week: Monday, Tuesday, Wednesday, Thursday, Friday,
Saturday, Sunday, and Yesterday.

• $PM_DATA_FILE: The file on the above workstation that
contains the exported performance monitoring data.

• $PM_DATA_FILE_DIR: The directory on the server that
contains the request files. One request file must be created for
each EMS, based on the $PM_DATA_FILE environment variable
and the EMS name.

• $PM_EMS_TIMEOUT: The duration (in seconds) that is
allocated to the EMS to collect and export the requested data.
When this duration expires, a time-out error is logged.

• Given these environment variables, the most recently transferred
performance monitoring data file is found at:
Example:
$PM_LOG_WKST:$PM_LOG_DIR/<yesterday>/$PM_DATA_FILE

Section VII: Administer performance
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Scheduled run time The performance monitoring data file export process is scheduled to
run daily. By default, it is scheduled to run at 02:10 a.m. local time.

Execute the performance
monitoring data export tool

The performance monitoring data export tool is accessible by any user
from the host server. It is located in /usr/dacscan/toolbin and allows
a host user to view the relevant log information, as well as to view
the current environment associated with this feature. This tool also
provides the means for a host user to reissue the request to transfer
24-hour performance monitoring data associated with the previous
day.

Section VII: Administer performance
monitoring data export
Performance monitoring data export
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Section VIII: Monitor space

Overview
....................................................................................................................................................................................................................................

Purpose WaveStar NMS has an internal, space monitoring script that
periodically checks its own filesystems to verify that they are not
running out of space. The following describes WaveStar NMS’s script
which produces warning and recovery messages as required.
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Monitor space
....................................................................................................................................................................................................................................

Definition: Spacewatch
program

Spacewatch is a space monitoring and recovery program that provides
file-system monitoring once per hour for the following controller files:

• Provisioning documents directory (/dacscan/prov)

• Alarms directory (/dacscan/alarms)

• Application logs directory (/dacscan/log)

• Database archives directory (/dacscan/dbarch)

• Application users directory (/dacscan/users)

• Application trace information directory (/dacscan/trace)

Warning messages If a controller file is over 60% full, Spacewatch provides a warning
message to the system event log. The warning message is in the form
of: “Log file” running low on space - clean up immediately!

Recovery messages Specific recovery actions are provided for /dacscan/trace,
dacscan/log, dacscan/dbarch, and dacscan/users files, if its
percentage fill is over 80%. The recovery message for the
dacscan/dbarch controller file is: ″Logfile″ removed database

archive file - back up database immediately!

The recovery message for the dacscan/trace and dacscan/log files is:
Removed log files - Archives may be incomplete!

The recovery message for the dacscan/users file is: ″Logfile″ is

running low on space, clean up immediately!
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Section IX: Network Map

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks for installing a new background map using
the map scanning feature.

Choosing a background
map

A new background map must be selected carefully so that it does not
obscure the icons and text displayed with it. For example, a map that
is largely white will hide the white text of the icon names.

When selecting a background map, keep the following in mind:

• Select a map that is mainly of a different color than the icons
and text displayed on the map.

• Select a map that includes colors that contrast sufficiently with
the icons and text displayed on the map so that they are easily
distinguished by the user.

Contents
Install a new background map for all users 3-45

Install a new background map for HP-UX client
machines

3-47

Install a new background map for Windows
PC/Windows terminal server machines

3-48

Update a network element position 3-49

Modify a description of a noncontrollable network
element

3-50

Delete a network element from the database 3-52
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Install a new background map for all users
....................................................................................................................................................................................................................................

Purpose Use this task to install a new background map for all users. The
system administrator of the host will use an off-line hardware, (such
as a scanner) to scan the customer’s map and save it onto the host
machine as a .gif file. This map may be an image (.gif ) file scanned
by the user and stored in the host machine’s
$DEST/jnm/itm/data/customer directory.

Task Perform the steps below to install a new background map for all
users.
............................................................................................................................................................

1 Log into the WaveStar Network Management System as root on the
primary server via the system console.

............................................................................................................................................................

2 To change to the directory containing the original background map,
enter cd /usr/dacscan/ui/jui/jnm/itm/data/customer at the
prompt.

............................................................................................................................................................

3 Enter mv defaultGIS.bshp ../. at the prompt.

Important! If the defaultGIS.bshp file is missing at run time, the
GUI will search for the defaultGIS.bshp file in the same directory as
the background .gif image in the map window.

Result:

The original background map is moved and saved into another
directory.

............................................................................................................................................................

4 Enter cp earth.gif /usr/dacscan/ui/jui/jnm/itm/data/
customer/defaultGIS.gif

Result:

The new map is copied into the directory.

..........................................................................................................................................................

5 Continue with one of the following:
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IF THEN

the map is for HP-UX GUI
client machines,

download the defaultGIS.gif file to
/user/add-on/ui/jui/jnm/itm/
data/customer

the map is for Windows
machines,

download the defaultGIS.gif file to
\jui\jnm\itm\data\customer

............................................................................................................................................................

6 At the prompt, type guipreinstall

Result:

The server tool is run to rebuild the configuration downloads the
new map to each of the workstation.

............................................................................................................................................................

7 Start the WaveStar NMS GUI.

Result:

The new map displays in the background.
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Install a new background map for HP-UX client machines
....................................................................................................................................................................................................................................

Purpose Use this task to install a new background map for HP-UX client
machines.

Task Perform the steps below to install a new background map for
HP-UX client machines.
............................................................................................................................................................

1 Log into each HP-UX client machine that needs a new map
background as root.

............................................................................................................................................................

2 To change to the directory containing the original background map,
enter cd /usr/add-on/ui/jui/jnm/itm/data/customer at the
prompt.

............................................................................................................................................................

3 Enter mv defaultGIS.bshp ../. at the prompt.

Result:

The original background map is moved and saved into a into
another directory.

............................................................................................................................................................

4 Enter cp earth.gif /usr/add-on/ui/jui/jnm/itm/data/
customer/defaultGIS.gif

Result:

The new map is copied into the directory.

............................................................................................................................................................

5 Start the WaveStar NMS GUI.

Result:

The new map displays in the background.
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Install a new background map for Windows PC/Windows
terminal server machines
....................................................................................................................................................................................................................................

Purpose Use this task to install a new background map for Windows
PC/Windows Terminal Server users.

Task Perform the steps below to install a new background map for
Windows PC/Windows Terminal Server users.
............................................................................................................................................................

1 Log into each client machine that needs a new map background as
administrator for the Windows PC/Windows Terminal Server
machines.

............................................................................................................................................................

2 To change to the directory containing the original background map,
enter cd \jui\jnm\itm\data\customer at the prompt.

............................................................................................................................................................

3 Enter mv defaultGIS.bshp ..\. at the prompt.

Result:

The original background map is moved and saved into a into
another directory.

............................................................................................................................................................

4 Enter cp earth.gif
\jui\jnm\itm\data\customer\defaultGIS.gif

Result:

The new map is copied into the directory.

............................................................................................................................................................

5 Start the WaveStar NMS GUI.

Result:

The new map displays in the background.
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Update a network element position
....................................................................................................................................................................................................................................

Purpose Use the following procedure to update a network element’s position
on the Network Map.

Before you begin Be sure that you have Configuration management, Element
Management, or system administrator privileges to permit you to
save the updated network element positions on the Network Map. See
“System administrator user types” (1-4) for a description of what is
allowable for system administrator users.

Task Complete the following task to permanently move a node to a
new position on the Network Map.
............................................................................................................................................................

1 On the Network Map, select the node you want to reposition.

............................................................................................................................................................

2 Drag and drop the node to the new location.

Result:

The node and its connecting links are repositioned.

............................................................................................................................................................

3 Select the following menu option: File > Update Node and Label
Map Positions.

Result:

The network element’s location is updated.
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Modify a description of a noncontrollable network element
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify the description or administration
information of an existing noncontrollable network element.

Task Complete the following task to modify the description or
administrative information of a noncontrollable network element.
............................................................................................................................................................

1 From the Network Map, select Administration > Location Reference
Table.

Result:

The Location Reference Table Query Box is displayed.

............................................................................................................................................................

2 In the Office Location/NE ID field, select the appropriate existing
noncontrollable network elements.

Important! You can use the wildcard character * to aid in your
search.

............................................................................................................................................................

3 (Optional) In the Additional Information field, enter any additional
information.

............................................................................................................................................................

4 Select the Area from the drop-down menu.

............................................................................................................................................................

5 Select the Node Type from the drop-down menu..

............................................................................................................................................................

6 Click OK.

Result:

The Location Reference Table is displayed.

............................................................................................................................................................

7 If you would like to modify the information, either click the first box
in a row to select the row or click a box in a specific column to
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modify the information.You may modify rows in the following
columns:

• Admin Area

• Description

• Acronym

• Additional Information

............................................................................................................................................................

8 Select Actions > Update.

............................................................................................................................................................

9 Select File > Close.

Result:

The description or administration information of the network
element is modified.

Section IX: Network Map
Modify a description of a noncontrollable
network element

System administration

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 3 - 5 1

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Delete a network element from the database
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a network element from the database.

Important! Off-line scripts are required to delete EMSs, equipment,
regenerators, and nodes within a subnet or ring.

Before you begin Before you delete a controlled network element, consider the
following items:

• A network element should only be deleted if there are no
in-effect or pending circuits connected to it. If there are
links/paths/circuits associated with the network element, the
corresponding network element will not be deleted (but will turn
gray). Note that users cannot back out of the pending delete state.

• No commands, such as delete cross-connect or port
re-provisioning, will be sent to a network element once it is in a
pending delete state. Any associated network elements are left in
an indeterminate state.

Task Perform the following steps to delete a network element from the
database.
............................................................................................................................................................

1 On the Network Map, right-click the network element to be deleted.

Result:

The Node menu is displayed.

............................................................................................................................................................

2 Select Node Operations > Delete Node.

Result:

A confirmation box is displayed.

..........................................................................................................................................................

3
IF THEN

You want to delete the
network element.

Select Yes.

Result:

The network element is deleted
from the system database.
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IF THEN

You want to cancel the
network element’s deletion.

Select No.

Result:

The deletion is cancelled.

Section IX: Network Map
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Section X: Set Filtering Criteria

Overview
....................................................................................................................................................................................................................................

Purpose This section defines how to set filtering criteria for WaveStar NMS
alarms to be sent to the TNM Integration Module (TIM) northbound
alarm interface.

Contents
Set filtering criteria for WaveStar NMS alarms 3-55
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Set filtering criteria for WaveStar NMS alarms
....................................................................................................................................................................................................................................

Purpose Use this task to set filtering criteria for WaveStar NMS alarms to be
sent to the TIM northbound alarm interface.

Task Perform the steps below to set filtering criteria for WaveStar
NMS alarms.
............................................................................................................................................................

1 Start the Wavestar NMS application.

Reference:

For instructions, see the section “Start WaveStar NMS on an
HP-UX workstation” (3-13), earlier in this chapter.

............................................................................................................................................................

2 On the Network Map, select Administration > NB Transmission
Filter...

Result:

The Alarm Transmission Filter form is displayed.

............................................................................................................................................................

3 To send WaveStar NMS’s service-affecting and non-service affecting
alarms to the TIM northbound alarm interface, select Both then click
OK.To send WaveStar NMS’s service-affecting alarms only to the
TIM northbound alarm interface, select SA then click OK.

Result:

The filtering criteria is set to send either WaveStar NMS’s
service-affecting and non-service affecting alarms or
service-affecting alarms to the TIM northbound alarm interface.

............................................................................................................................................................

4 Start the WaveStar NMS GUI.

Result:

The new map displays in the background.
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Section XI: Set Preferences

Overview
....................................................................................................................................................................................................................................

Purpose This section defines how to set preferences in WaveStar NMS.

Contents
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Set map preferences 3-58

Set alarm preferences 3-59

Set Fault Management (FM) operational preferences 3-60
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Set event indications preferences
....................................................................................................................................................................................................................................

Purpose Use this procedure to set event indications preferences for the
Network Event Summary.

Task Perform the steps below to set event indications preferences.
............................................................................................................................................................

1 On the network map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Event Indications tab.

Result:

The Event Indications form displays.

..........................................................................................................................................................

3 IF THEN

You want to set an audible
beep when a new alarm is
reported.

Select Set Beep On, then select the
number of beeps to sound when a new
alarm is reported.

You want to set the Event
form to display in the
foreground.

Select Set Event form to Foreground.

............................................................................................................................................................

4 Select OK.

Result:

The form closes. Changes to the event indications will take
effect during the next and subsequent sessions.
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Set map preferences
....................................................................................................................................................................................................................................

Purpose Use this procedure to set map preferences.

Task Perform the steps below to set map preferences.
............................................................................................................................................................

1 On the network map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Map tab.

Result:

The Map form displays.

..........................................................................................................................................................

3 IF THEN

You want to select a
different map

highlight an entry in the first tab’s
drop down list.

You want to specify area or
select no area,

highlight an entry in the second tab’s
drop down list.

............................................................................................................................................................

4 Select OK.

Result:

The form closes. Changes to the map will take effect during the
next and subsequent sessions.
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Set alarm preferences
....................................................................................................................................................................................................................................

Purpose Use this procedure to set alarm preferences on forms.

Task Perform the steps below to set alarm preferences on forms.
............................................................................................................................................................

1 On the network map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Alarm Information On Forms tab.

Result:

The Alarm Information on Forms form displays.

............................................................................................................................................................

3 Click each box corresponding to the form to be changed.

Result:

Each selected box is marked.

............................................................................................................................................................

4 Select OK.

Result:

The form closes. Changes to the selected forms will take effect
during the next and subsequent sessions.
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Set Fault Management (FM) operational preferences
....................................................................................................................................................................................................................................

Purpose Use this procedure to set FM operational preferences.

Task Perform the steps below to set FM operational preferences.
............................................................................................................................................................

1 On the network map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the FM Operational Mode tab.

Result:

The Fault Management Operational Mode form displays.

..........................................................................................................................................................

3 IF THEN

You want to set fault
management to use the
alarm approach,

Select Alarm Approach.

You want to set fault
management to use the
service approach,

Select Service Approach.

............................................................................................................................................................

4 Select OK.

Result:

An Attention dialog box displays indicating that the change will
take effect for the next and subsequent sessions.

............................................................................................................................................................

5 On the Attention dialog box select OK and on the Fault Management
Operational Mode form, select OK

Result:

The dialog box and Fault Management Operational Mode form
close.
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Section XII: Miscellaneous system administration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes some miscellaneous system administration
tasks.

Contents
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Search for location-type information for a specific
network element

3-64
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Check the status of X.25 links
....................................................................................................................................................................................................................................

Purpose Use this task to check the status of the X.25 links.

A utility is available to the system administrator to check the status of
the X.25 links.

Sample output Links that have not been installed or activated will appear to be down.
A sample output of this utility is shown below:

P8_card 2 P1_card 0 P8_link_m0 8 P8_link_m1 8 P1_link 0

/dev/zx25m0p0 0

/dev/zx25m0p1 0

/dev/zx25m0p2 0

/dev/zx25m0p3 1 5

/dev/zx25m0p4 0

/dev/zx25m0p5 0

/dev/zx25m0p6 0

/dev/zx25m0p7 0

/dev/zx25m1p0 0

/dev/zx25m1p1 0

/dev/zx25m1p2 0

/dev/zx25m1p3 0

/dev/zx25m1p4 0

/dev/zx25m1p5 0

/dev/zx25m1p6 1 4

/dev/zx25m1p7 0

In the above report:

• All ports designated as zx25m0pX are the eight X.25 ports
connected to slot 5 of the server, where X=0 to 7.

• All ports designated as zx25m1pX are the eight X.25 ports
connected to slot 6 of the server, where X=0 to 7.

Section XII: Miscellaneous system
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• In the second column, a 0 after the port designation indicates that
the link is DOWN and a 1 indicates that the link is UP.

• The third column corresponds to all the 1s in the second column.
The number indicates the total number of sessions that are active
on that link.

Task Perform the steps below to check the status of the X.25 links.
............................................................................................................................................................

1 Log in as dacscan on the primary server via the system console.

............................................................................................................................................................

2 Enter cd /tmp at the prompt.

............................................................................................................................................................

3 Enter ncstat <Enter> at the prompt.

............................................................................................................................................................

4 Enter cat ncstat.tab <Enter>.

Important! Links that have not been installed or activated will
appear to be down.

Result:

The status of all available x.25 links on the system is displayed.

............................................................................................................................................................

5 Enter the command init 4 to bring the application up to run level 4.
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Search for location-type information for a specific network
element
....................................................................................................................................................................................................................................

Purpose Use this procedure to search for location-type information for a
specific network element.

Important! The search is limited to network elements that are
controlled or cataloged by WaveStar NMS.

Task Perform the steps below to search for location-type information
for a specific network element.
............................................................................................................................................................

1 On the Network Map, select Administration.

............................................................................................................................................................

2 Select Location Reference Table.

Result:

The Location Reference Table Query Box is displayed.

............................................................................................................................................................

3 Enter the location type information in the Office Location/NE ID
field.

............................................................................................................................................................

4 Enter criteria in Additional Information, if desired.

............................................................................................................................................................

5 Select the Area ID from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Location Reference Table appears and displays location-type
information.
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Search for controlled network elements
....................................................................................................................................................................................................................................

Purpose Use this procedure to search for a list of network elements (NEs) with
which WaveStar NMS works and for information about the digital
cross-connect systems that are part of the network.

Task Perform the steps below to search for controlled network
elements and digital cross-connect systems that are part of the
network.
............................................................................................................................................................

1 On the Network Map, select Administration.

............................................................................................................................................................

2 Select Location Reference Table.

Result:

The Location Reference Table Query Box is displayed.

............................................................................................................................................................

3 Enter the network element information in the Office Location/NE ID
field.

............................................................................................................................................................

4 Enter criteria in Additional Information, if desired.

............................................................................................................................................................

5 Select the Area ID from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Location Reference Table form with the queried information
is displayed.
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4 User and Domain Administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes tasks performed to assign privileges and restrict
access to WaveStar NMS, network elements, and the Configuration
Management (CM), Fault Management (FM), Provisioning
Management (PM), Pre-Plan, and administrative capabilities in
WaveStar NMS.

Contents
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4-20
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List service domain user(s) 4-25
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Section I: Administer users in WaveStar NMS

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer users and user profiles in
WaveStar NMS.

Background Administrators are responsible for adding, modifying, and deleting
WaveStar user IDs. They also define the tasks to which users may or
may not access by assigning a user profile to a user ID.

Contents
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Delete a user 4-8

Add a user profile 4-9

Modify a user profile 4-10

Delete a user profile 4-12
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Add a user
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a Regular User, Service Domain User, or
Geographic Domain user to WaveStar NMS.

Permissions You must be authorized to perform this task.

Important! Before you perform this task, the user ID must first be
created in the sam program. See “Add an OS user on an HP-UX
workstation using SAM” (2-22) and “Create an OS user ID through
the sam terminal-based program” (2-25) for details.

Task Complete the following steps to add a Regular User, Service
Domain User, or Geographic Domain user to WaveStar NMS.
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Add.

Result:

The Add User form displays.

............................................................................................................................................................

3 In the User ID field, enter a user ID.

............................................................................................................................................................

4 In the Description field (if desired, this field is optional), enter a
description to be associated with the user ID.

............................................................................................................................................................

5 In the Profile field, select a user profile from the drop-down list.

If no user profile is selected, the user is automatically assigned Initial
Profile.
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Result:

The selected profile is displayed and the tasks associated with
the profile selection are displayed in the Assigned Tasks area
of the window.

............................................................................................................................................................

6 In the User Type field, select one of the following:

• If the user is not to be added to the Service Domain user list or
to the Geographic Domain user list, select Regular User.

• If the user is to be added to the Service Domain user list, select
Service Domain User.

• If the user is to be added to the Geographic Domain user list,
select Geo Domain User.

............................................................................................................................................................

7 Click Apply.

Result:

A message displays at the bottom of the Add User form
indicating that the user is added.

............................................................................................................................................................

8 Click OK.

Result:

The Add User form closes.
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Modify a user
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify user ID information.

Permissions You must be authorized to perform this task.

Task Complete the following steps to modify a user:
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form displays.

............................................................................................................................................................

3 Highlight the user ID to be modified.

............................................................................................................................................................

4 From the Actions menu, select Modify User.

Result:

The Modify User form displays.

............................................................................................................................................................

5 Change the Description, Profile, or User Type parameters as desired.

............................................................................................................................................................

6 Click Apply.

Result:

A message displays at the bottom of the Modify User form
which states that the parameters for the selected user are
modified.

............................................................................................................................................................

7 Click OK.

Section I: Administer users in WaveStar
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Result:

The Modify User form closes.

............................................................................................................................................................

8 From the List of Users form, select File > Close.

Result:

The List of Users form closes.
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Delete a user
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a Regular User, Service Domain User, or
Geographic Domain user.

Permissions You must be authorized to perform this task.

Complete the following steps to delete a user:
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form displays.

............................................................................................................................................................

3 Highlight the user ID to be deleted.

............................................................................................................................................................

4 From the Actions menu, select Delete User.

Result:

A confirmation box displays and asks if you really want to
delete this user.

............................................................................................................................................................

5 Click Yes.

Result:

The user ID is deleted.

............................................................................................................................................................

6 Select File > Close.

Result:

The List of Users form closes.
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Add a user profile
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a user profile.

Permissions You must be authorized to perform this task.

Task Complete the following steps to add a user profile:
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Profiles > Add.

Result:

The Add Profile form is displayed.

............................................................................................................................................................

3 In the Profile Name field, enter a name for the user profile (up to 30
characters).

............................................................................................................................................................

4 Add tasks to the user profile by moving them from the Available
Tasks list to the Selected Tasks list.

............................................................................................................................................................

5 Click Apply.

Result:

The user profile is added and is now available for assignment to
users.

............................................................................................................................................................

6 Click OK.

Result:

The Add Profile form closes.
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Modify a user profile
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify a user profile.

Permissions You must be authorized to perform this task.

Task Complete the following steps to modify a user profile:
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Profiles > Modify.

Result:

The Modify Profile form displays.

............................................................................................................................................................

3 In the Profile Name field, select the user profile to be modified from
the drop-down list.

Result:

The selected and available tasks for the user profile are
displayed.

............................................................................................................................................................

4 Do one of the following:

• Add tasks to the user profile by moving them from the Available
Tasks list to the Selected Tasks list.

• Remove tasks from the user profile by moving them from the
Selected Tasks list to the Available Tasks list.

............................................................................................................................................................

5 Click Apply.

Result:

The user profile is modified.
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............................................................................................................................................................

6 Click OK.

Result:

The Modify Profile form closes.
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Delete a user profile
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a user profile.

Permissions You must be authorized to perform this task.

Task Complete the following steps to delete a user profile:
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments> Profiles > Delete.

Result:

The Delete Profile form displays.

............................................................................................................................................................

3 In the Profile Name field, select the name of the user profile to be
deleted from the drop-down list.

............................................................................................................................................................

4 Click Apply.

Result:

A confirmation box displays and asks if you really want to
delete this profile.

............................................................................................................................................................

5 Click Yes.

Result:

The user profile is deleted.

............................................................................................................................................................

6 Click Close.

Result:

The Delete Profile form closes.
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Section II: Geographic domain user administration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add a user to or to delete a user from a
geographic domain, or to list geographic domain information.

Background Geographic Domain Partitioning is an optional feature. If this feature
is not installed, the following entry is grayed out on the Network
Map:

Administration > Domain Partitioning > Geographic Domain

Contents
Add user(s) or network element(s) to a geographic
domain

4-14

List users assigned to geographic domains 4-16

List users assigned to a network element 4-18

List network elements assigned to user 4-19

Delete user(s) or network element(s) from a
geographic domain

4-20
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Add user(s) or network element(s) to a geographic domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to add user(s) or network element(s) to a
geographic domain.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Important! When adding a user to a geographic domain, that user ID
must first be defined as a Geo Domain User in WaveStar NMS. See
the “Add a user” (4-4) task in this chapter for details.

Task Complete the following procedure to add a user or a network
element to a geographic domain.
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify...

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

3 Select the Domains radio button.

Result:

A list of domains display in the Domains area of the form.

............................................................................................................................................................

4 Under the Domains list, select a domain, then select Actions >
Modify Domain.

Result:

The Geographical Domain Modify form is displayed.

Section II: Geographic domain user
administration
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............................................................................................................................................................

5 Do one of the following:

• To add user(s) to a geographic domain, click the User tab,
highlight user(s), then click the Add button.

• To add a network element to a geographic domain, click the NEs
tab, highlight network element(s), then click the Add button.

Result:

The selected user(s) or network element(s) are moved to the left
of the window.

............................................................................................................................................................

6 On the Geographical Domain Modify form, click OK.

Result:

The Geographic Domain Modify form closes.

Section II: Geographic domain user
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List users assigned to geographic domains
....................................................................................................................................................................................................................................

Purpose Use this procedure to list users assigned to geographic domains and
their assigned network elements.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Task Complete the following procedure to list assigned users, their
geographic domains and assigned network elements.
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify...

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

3 Select the Assigned Users radio button.

Result:

A list of users display in the Assigned Users area of the form.

............................................................................................................................................................

4 Select the radio button that matches the type of user to be viewed.

• Both (which displays Domain and Inter-domain Users)

• Domain (which displays Domain users only)

• Inter-Domain (which displays users assigned to more than one
geographic domain)

............................................................................................................................................................

5 Select a listed user.

Section II: Geographic domain user
administration

User and Domain Administration

....................................................................................................................................................................................................................................

4 - 1 6 Lucent Technologies 365-309-245
Issue 1, October 2001



Result:

The domains and network elements associated with the user are
displayed.
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List users assigned to a network element
....................................................................................................................................................................................................................................

Purpose Use this procedure to list users assigned to a network element.

Task Complete the following procedure to display a list of all the users
who have access to a particular network element.
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify...

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

2 In the top field, select the Assigned NEs radio button.

Result:

The Assigned NEs list is displayed.

............................................................................................................................................................

3 In the Assigned NEs list, select a network element.

Result:

The Assigned Users list displays, and all users who have access
to the selected network element are displayed.

Section II: Geographic domain user
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List network elements assigned to user
....................................................................................................................................................................................................................................

Purpose Use this procedure to list network elements assigned to a user.

Task Complete the following procedure to list the network elements a
specific user can access.
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify...

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

2 In the top field, select the Assigned Users radio button.

Result:

The Assigned Users list is displayed.

............................................................................................................................................................

3 Select the radio button that matches the type of user:

• Both

• Domain

• Inter-Domain

............................................................................................................................................................

4 Select the desired user.

Result:

The Assigned NEs list displays all the network elements to
which the selected user has access via the selected domain.
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Delete user(s) or network element(s) from a geographic domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete user(s) or network element(s) from a
geographic domain.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Task Complete the following procedure to delete user(s) or network
element(s) from a geographic domain.
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify...

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

3 Select the Domains radio button.

Result:

A list of domains display in the Domains area of the form.

............................................................................................................................................................

4 Under the Domains list, select a domain, then select Actions >
Modify Domain.

Result:

The Geographical Domain Modify form is displayed.
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............................................................................................................................................................

5 Do one of the following:

• To remove user(s) from a geographic domain, click the User tab,
highlight user(s), then click the Remove button.

• To remove a network element from a geographic domain, click
the NEs tab, highlight network element(s), then click the
Remove button.

Result:

The selected user(s) or network element(s) are moved to the
right of the window.

............................................................................................................................................................

6 On the Geographical Domain Modify form, click OK.

Result:

The Geographic Domain Modify form closes.
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Section III: Service domain user administration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add, modify, and delete users from
service domains.

Background Service Domain Partitioning is an optional feature. If this feature is
not installed, the following entry is grayed out on the Network Map:

Administration > Domain Partitioning > Service Domain

Contents
Add a user to a service domain 4-23

List service domain user(s) 4-25

Delete user(s) from a service domain 4-26
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Add a user to a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a user to a service domain.

Permissions Service domain administration procedures can only be performed by
those with the appropriate security privileges. You must be authorized
to perform this task.

Important! When adding a user to a service domain, that user ID
must first be defined as a Service Domain User in WaveStar NMS.
See the “Add a user” (4-4) task in this chapter for details.

Task Complete the following procedure to add users to a service
domain.
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Users.

Result:

The Service Domain Display/Modify Users form is displayed.

............................................................................................................................................................

3 In the Service Domain field, select a service domain name.

Result:

The users assigned to that service domain display in the
Members box and users not assigned to the service domain
display in the Non-Members box.

............................................................................................................................................................

4 To add user(s) to the Members box, highlight user(s) in the
Non-Members box and click the left arrow button.
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Result:

The selected user(s) are moved to Members box.

............................................................................................................................................................

5 On the Service Domain Display/Modify form, click OK.

Result:

The Service Domain Display/Modify form closes.

Section III: Service domain user
administration
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List service domain user(s)
....................................................................................................................................................................................................................................

Purpose Use this procedure to list members assigned to a service domain.

Task Complete the following procedure to list service domain users.
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Users

Result:

The Service Domain Display/Modify Users form displays.

............................................................................................................................................................

3 From the Service Domain field, select a service domain.

Result:

The users assigned to the selected domain are listed in the left
box, and the users not assigned to the domain display in the
right box, if applicable.

Section III: Service domain user
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Delete user(s) from a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete user(s) from a service domain.

Permissions Service domain administration procedures can only be performed by
those with the appropriate security privileges. You must be authorized
to perform this task.

Task Complete the following task to delete user(s) from a service
domain.
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Users.

Result:

The Service Domain Display/Modify Users form is displayed.

............................................................................................................................................................

3 In the Service Domain field, select a service domain name.

Result:

The users assigned to that service domain display in the
Members box and users not assigned to the service domain
display in the Non-Members box.

............................................................................................................................................................

4 To delete user(s) from the Members box, highlight user(s) in the
Members box and click the right arrow button.

Result:

The selected user(s) are moved to Non-Members box.

............................................................................................................................................................

5 On the Service Domain Display/Modify form, click OK.
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Result:

The Service Domain Display/Modify form closes.

Section III: Service domain user
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Section IV: WaveStar SNMS cut-through user ID

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to set up a user ID for WaveStar SNMS
cut-through purposes.

Background In releases of WaveStar SNMS prior to Release 4.2, a default itm user
ID was hardcoded into the interface to support WaveStar NMS
cut-through connections to WaveStar SNMS. For WaveStar SNMS
Release 4.2 and greater, a cut-through user ID (other than the default
itm user ID) may be created and used for WaveStar NMS to WaveStar
SNMS cut-through connections.

Once the WaveStar SNMS cut-through user ID is created, it can be
used in a cut-through session to apply geographic domain restrictions
to ITM-SC or WaveStar SNMS, such as restricting network elements
that a user is allowed to view.

Use the following task to create a WaveStar SNMS cut-through user
ID.

Contents
Set up a user ID for cut-through to WaveStar
SNMS

4-29
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Set up a user ID for cut-through to WaveStar SNMS
....................................................................................................................................................................................................................................

Purpose Use this task to set up a user ID (other than the default itm user ID)
for cut-through to WaveStar SNMS Release 4.2 and later releases.

Task Use the following steps to add a cut-through user ID to WaveStar
SNMS.
............................................................................................................................................................

1 Add a cut-through user ID to WaveStar SNMS. (See the “Add a User”
task in the Security Management chapter of the WaveStar Subnetwork
Management System (SNMS) Administration Guide for details.)

............................................................................................................................................................

2 Enable the user option in the Secure Access Gateway for Enterprises
(SAGE) feature. See the Secure Access Gateway for Enterprises
(SAGE) Manual.
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5 Domain partitioning for
provisioning operations

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes tasks performed to administer the provisioning
environment. In particular, this chapter discusses the administration of
geographic domain partitioning and service domain partitioning.

Contents
Section I: Geographic domain partitioning 5-3

Add a geographic domain 5-7

List geographic domain 5-9

Delete a geographic domain 5-10

Modify a geographic domain 5-11

List network elements assigned to geographic
domains

5-13

Section II: Service domain partitioning 5-14

List trails assigned to a service domain 5-17

List channels assigned to a service domain 5-18

List ports assigned to a service domain 5-19

Add a service domain 5-20

Modify the trails assigned to a service domain 5-21

Modify the channels assigned to a service domain 5-23
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Modify the ports assigned to a service domain 5-25

Delete a service domain 5-27
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Section I: Geographic domain partitioning

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer geographic domains.

Geographic domain partitioning is an optional feature. If this feature
is not installed, Geographic Domain is grayed out on the Domain
Administration menu.

At installation, geographic domain can be set with one of the
following options:

• View ALL option

• Restricted user option

Geographic domain
partitioning

Geographic domain partitioning allows you to group network elements
into domains that are directly under the control of:

• WaveStar NMS, (such as digital cross-connect system frames)

• ITM-SC (such as SLMs)

• ITM-XM (such as digital cross-connect system frames)

• WaveStar SNMS

Geographic domain partitioning facilitates:

• Grouping network elements into domains

• Assigning specific user access to the domains.

Managing geographic
domains

A network element may be assigned to only one geographic domain.

User access is limited to only those network elements that are
assigned to domains to which the user has access on WaveStar NMS.
A user can be assigned to one or more domains; however, a network
element may be assigned to only one domain.

Users who are assigned to more than one geographic domain are
called inter-domain users.

These associations are set by system administrators.

To implement a circuit that crosses geographic domains for a user
who is not an inter-domain user, the user implements that portion of
the circuit that is in the user’s graphical domain. The user then refers
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the work item to another work group or to a user who has access to
the remaining network elements of the other domain(s).

A single user can have more than one login (user ID). Each login can
have access to different domains only if the login is permitted access
to those domains. This access permits a user to have greater coverage
during out-of-hours or weekend assignments using one login and the
more restricted access during normal working hours by using a second
login.

The Geographic Domain Administration form facilitates geographic
domain partitioning by permitting a user with the proper security
privileges, such as an WaveStar NMS privileged user, to control the
assignment of network elements and users to domains.

The network elements and users must first exist in the WaveStar NMS
database before they can be assigned to any domain. Network
elements must be added in the standard fashion before using the
geographic domain partitioning feature.

Users with correct privileges can view a list of:

• All users

• All network elements

• All geographic domains

• Users that have access to a particular geographic domain

• Network elements that are assigned to a particular geographic
domain

• Users that are not assigned to any geographic domain

• Network elements that are not assigned to any geographic
domain

• Network elements are assigned to geographic domains

• Users are assigned to geographic domains

• Users that have access to a particular network element

In the discussion that follows, the term network elements includes
EMSs such as ITM-SCs, WaveStar SNMSs, and ITM-XMs.

Assigning users to a
geographic domain

Only users with the user type Geo Domain User can access the
Geographic Domain forms.

Section I: Geographic domain partitioning
Overview
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Specific users can then be assigned access to specific domains. This is
done by the Admin User who selects the User Type when the user is
added to the WaveStar NMS system.

The network elements and users must first exist in the controller
database before they can be assigned to any domain.

For a user to appear on the Geographic Domain Administration form,
the user must exist in the database with a login.

Geographic domain partitioning recognizes three types of users with
associated permissions:

• Geographic Domain Admin User, generally an WaveStar NMS
system administrator with superuser privileges, who has
permission to:

- Access all features and forms

- Create geographic domains

- Assign users to geographic domains

- View all network elements and links in the network

• Geographic Domain User, who has permission to:

- Control assigned network elements in the geographic domain
(if this is a restricted geographic domain user).

- Provision network element ports

- View only the network elements and links within the user’s
assigned geographic domain (if this is a restricted
geographic domain user).

• Geographic Inter-Domain User, who has permission to:

- Control assigned network elements in multiple geographic
domains

- View only the network elements and links within the user’s
assigned geographic domains (if this is a restricted
geographic domain user). A user with View All option sees
all, but can only perform operations on nodes assigned in
their geographic domain.

Note that none of the users listed above may add a service
domain.

Important! The ability to view network elements and links is
dependent upon the setup of the DBP variable readall at installation.
If this variable is selected, the geographic domain/inter-domain users
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can view network elements, however, these users will only be allowed
to perform operations on network elements assigned to the geographic
domain.

Security permissions A person with proper security permissions can create, delete, modify,
or associate network elements, domains, and users.

Multiple logins A user can have multiple logins (user IDs). Each login can have
access to different domains only if it is assigned to the geographic
domain. This permits users to have greater coverage during out of
hours or weekend assignments using one login, and more restricted
access during normal work hours by using a second login. These
associations are accomplished by use of the Domains form.

Contents
Add a geographic domain 5-7

List geographic domain 5-9

Delete a geographic domain 5-10

Modify a geographic domain 5-11

List network elements assigned to geographic
domains

5-13
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Add a geographic domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a geographic domain.

Before you begin Geographic domain administration procedures can only be performed
by those with the appropriate security privileges.

Network elements or users must be assigned to a geographic domain
or the domain will not be created. If you assign either network
elements or users, the domain will be created and you can assign or
delete more users or network elements at a later time.

Important! Some geographic domains are created by default and
cannot be deleted (for example, the ITM-SC controller domain and
the ALL domain). Geographic domains created by default can be
modified. You can add users to them.

Task Complete the following procedure to add a geographic domain.
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Add.

Result:

The Geographic Domain Add form is displayed.

............................................................................................................................................................

2 In the Domain field, enter a name for the new geographic domain.

..........................................................................................................................................................

3
IF THEN

You want to add users to
the geographic domain.

Select the Users tab.

You want to add network
elements to the geographic
domain.

Select the NEs tab.

............................................................................................................................................................

4 Highlight the user or network element that is to be added or removed
from the domain.

Section I: Geographic domain partitioning Domain partitioning for provisioning operations

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 5 - 7



............................................................................................................................................................

5 Select the appropriate arrow button to add or delete the highlighted
selection.

............................................................................................................................................................

6 Select OK.

Result:

The domain is created and its selected users and network
elements are assigned to the new domain. An Attention form
confirms that the geographic domain has been added.

............................................................................................................................................................

7 Select OK.

Result:

The Attention form closes.
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List geographic domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to list a geographic domain and its assigned users
and network elements.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Task Complete the following procedure to list a geographic domain
and its assigned users and network elements.
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify...

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

3 Select the Domains radio button.

Result:

A list of domains display in the Domains area of the form.

............................................................................................................................................................

4 Select a listed domain.

Result:

The assigned users and network elements associated with the
domain are displayed.
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Delete a geographic domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a domain from geographic domain
partitioning.

Task Perform the steps below to delete a domain from geographic
domain partitioning.
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Delete.

Result:

The Geographical Domain Delete form is displayed.

............................................................................................................................................................

2 In the Domain field, select a geographic domain from the drop-down
list.

............................................................................................................................................................

3 Select Apply.

Result:

A form displays for you to confirm that the geographic domain
should be deleted.

............................................................................................................................................................

4 Select Yes.

Result:

The confirmation form closes.

............................................................................................................................................................

5 Select Close.

Result:

The Geographical Domain Delete form closes.
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Modify a geographic domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify a geographic domain. This procedure is
used to:

• Add users to a geographic domain

• Delete users from a geographic domain

• Add network elements to a geographic domain

• Delete users from a geographic domain.

Task Perform the steps below to modify a geographic domain.
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify.

Result:

The Geographical Domain Administration form is displayed.

............................................................................................................................................................

2 In the top field, select the Domains radio button.

Result:

The Domains list is populated.

............................................................................................................................................................

3 In the Domains list, select a domain.

............................................................................................................................................................

4 Select Actions > Modify Domain.

Result:

The Geographical Domain Modify form is displayed.

..........................................................................................................................................................

5
IF THEN

You want to modify the
users that are assigned to
the domain.

Select the Users tab.
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IF THEN

You want to modify the
network elements assigned
to the domain.

Select the NEs tab.

............................................................................................................................................................

6 Highlight the user or network element that is to be added or removed
from the domain.

............................................................................................................................................................

7 Select the appropriate arrow button to add or delete the highlighted
selection.

............................................................................................................................................................

8 Select Apply.

Result:

The selected network elements or users are assigned to or
deleted from the domain.

............................................................................................................................................................

9 Select OK.

Result:

The Geographical Domain Modify form closes.

............................................................................................................................................................

10 Select File > Close.

Result:

The Geographical Domain Administration form closes.
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List network elements assigned to geographic domains
....................................................................................................................................................................................................................................

Purpose Use this procedure to list network elements assigned to geographic
domains and their assigned users.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Task Complete the following procedure to list network elements, their
geographic domains and assigned users.
............................................................................................................................................................

1 Start WaveStar NMS. See “Section I: Start WaveStar NMS server
applications” (3-4) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify...

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

3 Select the Assigned NEs radio button.

Result:

A list of users display in the Assigned NEs area of the form.

............................................................................................................................................................

4 Select a listed network element.

Result:

The geographic domains and assigned users are displayed.
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Section II: Service domain partitioning

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer service domains.

Service domain partitioning is an optional feature. If this feature is not
installed, Service Domain is grayed out on the Domain Administration
menu.

Service domain
partitioning

Service domain partitioning groups trails, channels, and ports into
service domains and assigns specific users access to the service
domains. Through the Virtual Private Network (VPN) feature, system
administrators may now restrict a user’s ability to assign channels.
This restriction is made during the creation of the service domain.

Service domains are created in one of the following modes:

• Dedicated mode

• Shared mode

Either mode is selected in the Add a Service Domain process.

Dedicated mode When Dedicated mode is selected, the user may group channels,
trails, and ports into service domains. As a result, the user may assign
channels and assign ports for trail provisioning purposes or assign
trails, for example, to monitor fault and performance.

Shared mode When Shared mode is selected, the VPN feature is implemented
therefore no channel assignment is permitted, therefore the user may
only group trails and ports into service domains. As a result, the user
may assign ports for trail provisioning purposes or assign trails for
monitoring purposes.

Manage service domains In the Shared mode, a channel may be assigned to only one Service
Domain.

• Channels belong to either the Public Domain or a specific
Service Domain. A Public Domain is a channel that does not
belong to a Service Domain.

Domain partitioning for provisioning operations
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A trail may be assigned to only one Service Domain.

• A circuit assigned to a Service Domain consists of a circuit made
up of channels that are a part of the Service Domain.

Service Domain Administration is accomplished by use of the Service
Domain Administration form, which is accessed from the
Administration menu of the map. Only a person with proper security
permissions can create, delete, or modify a domain.

Assign users to a service
domain

Service domain partitioning recognizes two types of users:

• Service Domain Admin User, generally an WaveStar NMS
system administrator with superuser privileges

• Service Domain User

A Service Domain User cannot be a geographic domain user.

Only a person with proper security permissions can create, delete, and
modify domains. Users with the user type, Service Domain User can
access the Service Domain forms.

A user may only be assigned to one Service Domain and generally
may not belong to more than one service domain. If a user must be
assigned to additional Service Domains, the user must be assigned
additional user IDs. However, the user can only operate in the Service
Domain that he or she is currently logged into by the user ID.

The channels and users must first exist in the controller database
before they can be assigned to any domain. The domain forms do not
create users or network elements.

For a user to appear on the Service Domain Administration form, the
user must exist in the database with a login.

All users can complete the form to view the following lists:

• All users

• All network elements

Contents
List trails assigned to a service domain 5-17
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Modify the trails assigned to a service domain 5-21

Modify the channels assigned to a service domain 5-23

Modify the ports assigned to a service domain 5-25
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List trails assigned to a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to list trails that are assigned to a service domain.

Task Complete the following steps to list trails that are assigned to a
service domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Trails/Channels/Ports.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Trails tab.

............................................................................................................................................................

4 Complete the A Node and Z Node fields.

Important! To view A Node and Z Node values, select the A Node or
Z Node button to display a selection box. Next, select the Find
button, select the value from the displayed list and select OK.

............................................................................................................................................................

5 Select a trail type from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Service Domain Display/Modify Trails form displays and
lists the trails assigned to the service domain.
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List channels assigned to a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to list the channels assigned to a service domain.

Task Complete the following steps to list the channels assigned to a
service domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Trails/Channels/Ports.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Channels tab.

............................................................................................................................................................

4 Complete the A Node and Z Node fields.

Important! To view A Node and Z Node values, select the A Node or
Z Node button to display a Selection box. Next, select the Find
button, select the value from the displayed list and select OK.

............................................................................................................................................................

5 Select a trail type from the drop-down list.

............................................................................................................................................................

6 Select a channel type from the drop-down list.

............................................................................................................................................................

7 Select OK.

Result:

If the Service domain mode value is Dedicated, the Service
Domain Display/Modify Channels form displays and lists the
channels assigned to the service domain.
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List ports assigned to a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to list ports that are assigned to a service domain.

Task Complete the following steps to list ports that are assigned to a
service domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Trails/Channels/Ports.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Ports tab.

............................................................................................................................................................

4 Complete the Node field.

Important! Existing node values may be viewed by selecting the
Node button.

............................................................................................................................................................

5 Select the Rate value from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Service Domain Display/Modify Ports form displays and
lists the ports assigned to the service domain.
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Add a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a service domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Task Important! Channels, circuits, or users must be assigned to create the
domain.

Complete the following procedure to add a service domain.
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Add...

Result:

The Service Domain Add box is displayed.

............................................................................................................................................................

2 In the Service Domain field, enter a name for the service domain.

............................................................................................................................................................

3 In the Service Domain Mode field, select Shared (default) or
Dedicated.

............................................................................................................................................................

4 Select the OK button.

Result:

An Attention form confirms that the service domain has been
added.

............................................................................................................................................................

5 Select OK.

Result:

The Attention form closes.
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Modify the trails assigned to a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify the trails assigned to a service domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Task Complete the following task to modify the trails assigned to a
service domain.
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Trails/Channels/Ports.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Trails tab.

............................................................................................................................................................

4 Complete the A Node and Z Node fields.

Important! A Node and Z Node values may be viewed by selecting
the A Node or Z Node button to display a Selection box. Next, select
the Find button, select the value from the displayed list and select
OK.

............................................................................................................................................................

5 Select a trail type from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Service Domain Display/Modify form displays and lists the
trails assigned to the service domain.
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............................................................................................................................................................

7 Continue with one of the following:

• Add trails to the service domain by moving them from the Non
Member Trails list to the Member Trails list.

• Delete trails from the service domain by moving them from the
Member Trails list to the Non Member Trails list.

............................................................................................................................................................

8 Select Apply.

Result:

The trails assigned to the service domain are modified. The Non
Member Trails and Member Trails lists redisplay and show the
modifications.

............................................................................................................................................................

9 Select OK.

Result:

The Service Domain Display/Modify Trails form closes.

Section II: Service domain partitioning
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Modify the channels assigned to a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify the channels assigned to a service
domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Task Complete the following task to modify the channels assigned to a
service domain.
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Trails/Channels/Ports.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Channels tab.

............................................................................................................................................................

4 Complete the A Node and Z Node fields.

Important! A Node and Z Node values may be viewed by selecting
the A Node or Z Node button to display a Selection box. Next, select
the Find button, select the value from the displayed list and select
OK.

............................................................................................................................................................

5 Continue with one of the following:

• Add channels to the service domain by moving them from the
Non Member Channels list to the Member Channels list.

• Delete channels from the service domain by moving them from
the Member Channels list to the Non Member Channels list.

Important! Channels will not display if Shared was selected for the
Service Domain Mode (when this service domain was added).

Section II: Service domain partitioning Domain partitioning for provisioning operations

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 5 - 2 3



............................................................................................................................................................

6 Select Apply.

Result:

The channels assigned to the service domain are modified. The
Non Member Channels and Member lists redisplay and show
the modifications.

............................................................................................................................................................

7 Select OK.

Result:

The Service Domain Display/Modify Channels form closes.
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Modify the ports assigned to a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify the ports assigned to a service domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Task Complete the following task to modify the ports assigned to a
service domain.
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Trails/Channels/Ports.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Ports tab.

............................................................................................................................................................

4 Complete the Node field.

Important! Existing node values may be viewed by selecting the
Node button.

............................................................................................................................................................

5 Select the Rate value from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Service Domain Display/Modify Ports form displays and
lists the ports assigned to the service domain.
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............................................................................................................................................................

7 Continue with one of the following:

• Add ports to the service domain by moving them from the Non
Member Ports list to the Member Ports list.

• Delete ports from the service domain by moving them from the
Member Ports list to the Non Member Ports list.

............................................................................................................................................................

8 Select Apply.

Result:

The ports assigned to the service domain are modified. The Non
Member Ports and Member Ports lists redisplay and show the
modifications.

............................................................................................................................................................

9 Select OK.

Result:

The Service Domain Display/Modify Ports form closes.
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Delete a service domain
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a service domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Before deleting a service domain, be sure that:

• all ports, trails, and users have been unassigned from the service
domain

• if the service mode is dedicated, all channels assigned to the
domain have been unassigned from the service domain

Task Complete the following task to delete a service domain.
............................................................................................................................................................

1 Select Administration > Domain Partitioning > Service Domain >
Delete...

Result:

The Service Domain Delete form is displayed.

............................................................................................................................................................

2 In the Service Domain field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select Apply.

Result:

A form displays for you to confirm that the service domain
should be deleted.

............................................................................................................................................................

4 Select Yes.

Result:

The confirmation form closes.

............................................................................................................................................................

5 Select Close.
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Result:

The Service Domain Delete form closes.
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6 Provisioning administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains topology and provisioning tasks performed to
administer WaveStar NMS.
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Filter the display of scheduled entities on the
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6-22

View successful/failed scheduled entities through
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Section I: Aggregates

Overview
....................................................................................................................................................................................................................................

Purpose An aggregate is a collection of one or more network elements
collapsed into a single node displayed on the Network Map. An
aggregate may contain other aggregates.

This section discusses the provisioning tasks associated with
aggregates as they relate to managing the topology of the WaveStar
NMS Network Map.
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Add an aggregate
....................................................................................................................................................................................................................................

Purpose Use this procedure to add an aggregate to the WaveStar NMS
Network Map.

Task Complete the following task to add an aggregate to the WaveStar
NMS Network Map.
............................................................................................................................................................

1 On the Network Map, select Administration > Aggregate > Add.

Result:

The Aggregate Add form is displayed.

............................................................................................................................................................

2 In the Aggregate ID field, enter the Aggregate ID.

............................................................................................................................................................

3 In the Acronym field, enter the Aggregate Acronym.

............................................................................................................................................................

4 From the Non-Member List, select the network element or elements
you wish to add to the aggregate.

Important! To select more than one node, press the Control key.
There is no limit on the number of network elements that can be
selected at one time.

............................................................................................................................................................

5 Left-click the right arrow to move the network elements appearing in
the Non-Member list to the Members list.

Result:

The selected network elements appear within the Members list.

............................................................................................................................................................

6 Left click Apply.

Result:

A confirmation window is displayed.

............................................................................................................................................................

7 Left click OK.

Section I: Aggregates Provisioning administration

....................................................................................................................................................................................................................................

6 - 4 Lucent Technologies 365-309-245
Issue 1, October 2001



Result:

You are returned to the Aggregate Add Form.

............................................................................................................................................................

8 Left-click OK.

Result:

The Aggregate is added to the Network Map. A corresponding
network element is displayed at the top left-hand side of the
Network Map.
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Delete an aggregate
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete an aggregate from the WaveStar NMS
Network Map.

Task Complete the following task to delete an aggregate from the
WaveStar NMS Network Map.
............................................................................................................................................................

1 From the Network Map, select Administration> Aggregate >
Delete...

Result:

The Aggregate List is displayed.

............................................................................................................................................................

2 Left-click the Aggregate to be deleted.

............................................................................................................................................................

3 Left click Apply.

Result:

A confirmation window is displayed.

............................................................................................................................................................

4 Left click OK.

Result:

You are returned to the Aggregate Add Form.

............................................................................................................................................................

5 Left-click OK.

Result:

The aggregate is deleted and is no longer displayed on the
Network Map.
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Add an aggregate member
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a member to an existing aggregate. A
member can be defined as a network element, which constitute
aggregates.

Important! There is not a limit on the number of members that may
reside in an aggregate.

Task Complete the following task to add a member to an existing
aggregate.
............................................................................................................................................................

1 On the Network Map, select Administration> Aggregate >
Display/Modify.

Result:

The Aggregate Modify form appears.

............................................................................................................................................................

2 In the Aggregate ID pull-down menu, left-click the aggregate to be
modified.

Result:

The aggregate members are displayed in the Members column.

............................................................................................................................................................

3 In the Non-members column, left-click the network element to be
added to the aggregate.

Result:

The network element is highlighted.

............................................................................................................................................................

4 Left-click the left-pointing arrow.

Result:

The network element is moved to the Members column.

............................................................................................................................................................

5 Left click Apply.

Result:

A confirmation window is displayed.
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............................................................................................................................................................

6 Left click OK.

Result:

You are returned to the Aggregate Add Form.

............................................................................................................................................................

7 Left click Close.

Result:

The screen closes and the network element becomes a new
member of the aggregate.
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Remove an aggregate member
....................................................................................................................................................................................................................................

Purpose Use this procedure to remove a member from an existing aggregate. A
member can be defined as a network element, which constitute an
aggregate.

Before you begin Before removing a member from an aggregate, note the following
items:

• The aggregate must have at least one member.

• You cannot delete the last aggregate member without deleting the
aggregate itself.

Task Complete the following task to remove a member from an
existing aggregate.
............................................................................................................................................................

1 From the Network Map, select Administration> Aggregate >
Display/Modify.

Result:

The Aggregate Modify window appears.

............................................................................................................................................................

2 In the Aggregate ID menu, left-click the aggregate to be modified.

Result:

The aggregate members are displayed in the Members column.

............................................................................................................................................................

3 In the Members column, left-click the network element to be deleted
from the aggregate.

Result:

The network element becomes highlighted.

............................................................................................................................................................

4 Left-click the right-pointing arrow.

Result:

The network element is moved to the Non-members column.

............................................................................................................................................................

5 Left-click Apply.
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Result:

A confirmation window is displayed.

............................................................................................................................................................

6 Click OK.

Result:

You are returned to the Aggregate Add Form.

............................................................................................................................................................

7 Left click Close.

Result:

The screen closes. The member is removed from the aggregate.
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Specify an aggregate’s acronym
....................................................................................................................................................................................................................................

Purpose Use this procedure to specify an aggregate’s on-screen acronym (title
formed from the initial letters or parts of the aggregate’s full name).

Related information For related information, refer to the WaveStar NMS Application and
Planning Guide.

Task Complete the following task to modify an aggregate’s on-screen
acronym.
............................................................................................................................................................

1 From the Network Map, select Configuration > Aggregate >
Display/Modify.

Result:

The Aggregate Modify window appears.

............................................................................................................................................................

2 In the Aggregate ID pull-down menu, select the aggregate whose
acronym you wish to specify.

Result:

The members of the aggregate are displayed in the Members
column.

............................................................................................................................................................

3 Select Acronym and press the Backspace key.

Result:

The Aggregate List form is displayed.

............................................................................................................................................................

4 Enter the new acronym.

............................................................................................................................................................

5 Click Apply.

............................................................................................................................................................

6 Click OK.

Result:

The aggregate acronym is modified. The change will
dynamically appear on-screen.

Section I: Aggregates Provisioning administration

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 6 - 1 1

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section II: Areas

Overview
....................................................................................................................................................................................................................................

Purpose This section describes areas and describes the tasks related to areas.

Background Networks managed by WaveStar NMS can be subdivided into smaller,
manageable networks called areas. When the network is subdivided
into areas containing a limited set of nodes/aggregates and associated
links, the potential to overcrowd the display is reduced and the system
performance is improved as a smaller amount of information is
exchanged by the subsystems.

Areas may be a:

• Set of nodes/aggregates dedicated to a subscriber

• Set of nodes/aggregates, which are or are not connected

• Set of nodes/aggregates in a geographic location or building.

Users can choose to view only the areas they are interested in, which
reduces the potential to overcrowd the display and improves system
performance because a smaller amount of information is exchanged by
the subsystems.

Only a system administrator can create areas.

Definition: area An area is a collection of nodes, aggregates, and their associated
links. An area is displayed as an icon on the Area Panel of the
Network Map. An area can be expanded, which causes the Expansion
Panel to appear on the Network Map and display all of the nodes,
aggregates, and links in the area.

There is no restriction in the number of network elements that can be
included in an area, however a limit of 300 network elements in an
area is recommended to avoid a cluttered display and performance
problems.

Contents
Add an area 6-13

Modify an area 6-15

Delete an area 6-17
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Add an area
....................................................................................................................................................................................................................................

Purpose Use this procedure to add an area.

Permissions You must be authorized to perform this task.

Task Perform the steps below to add an area.
............................................................................................................................................................

1 On the Network Map, select Administration > Area > Add...

Result:

The Area Create form is displayed.

............................................................................................................................................................

2 In the Area Name field, enter a name for the area.

............................................................................................................................................................

3 SelectOK.

Result:

The area is added. Note that an area icon displays in the top left
side of the Area Panel on the Network Map. An entry for the
new area appears in the Network Tree Panel on the Network
Map.
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For more information For instructions on how to add members to the area that was created
with this task, see the following task, “Modify an area” (6-15)
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Modify an area
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify an area.

Permissions You must be authorized to perform this task.

Task Perform the steps below to modify an area:
............................................................................................................................................................

1 On the Network Map, select Administration > Area >
Display/Modify...

Result:

The Area Modify form is displayed.

............................................................................................................................................................

2 In the Area ID field, select the area from the drop-down list.

Result:

Non-members of the area display in the Non-Members list, and
members of the area display in the Members list.

............................................................................................................................................................

3 Do one of the following:

• Add nodes to the area by moving them from the Non-Members
list to the Members list.

• Delete nodes from the area by moving them from the Members
list to the Non-Members list.

............................................................................................................................................................

4 SelectApply.

Result:

The area is modified. The Non-Members and Members lists
redisplay and show the modifications.

............................................................................................................................................................

5 SelectClose.
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Result:

The Area Modify form closes.
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Delete an area
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete an area.

Permissions You must be authorized to perform this task.

Task Perform the steps below to delete an area:
............................................................................................................................................................

1 On the Network Map, select Administration > Area > Delete...

Result:

The Area Delete form is displayed.

............................................................................................................................................................

2 In the Area Name field, select the area from the drop-down menu.

............................................................................................................................................................

3 SelectOK.

Result:

The area is deleted. Note that the area icon is deleted from the
Area Panel on the Network Map. The entry for the area
disappears from the Network Tree Panel on the Network Map.
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Section III: Scheduled entities

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the administration of scheduled entities.

Definition: scheduled
entity

A scheduled entity is a scheduled event.

Contents
View a list of scheduled entities 6-19

Delete a scheduled entity 6-20

Modify a scheduled entity 6-21

Filter the display of scheduled entities on the
Scheduled List

6-22

View successful/failed scheduled entities through
the Scheduled History List

6-24
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View a list of scheduled entities
....................................................................................................................................................................................................................................

Purpose Use this procedure to view a list of scheduled entities.

Before you begin The active form must be the Network Map.

Task Perform the steps below to view a list of scheduled entities.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter the Scheduled Entity.

............................................................................................................................................................

3 Enter the Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled List form appears and displays the queried
information.
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Delete a scheduled entity
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a scheduled entity.

Task Perform the steps below to delete a scheduled entity.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter an existing Scheduled Entity.

............................................................................................................................................................

3 Enter a Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled List form is displayed with the queried
information.

............................................................................................................................................................

5 Select Actions > Delete.

Result:

A confirmation box is displayed which prompts the user to
confirm the delete request.

............................................................................................................................................................

6 Select OK.

Result:

The selected scheduled entity is deleted.
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Modify a scheduled entity
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify a scheduled entity.

Task Perform the steps below to modify a scheduled entity.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter an existing Scheduled Entity.

............................................................................................................................................................

3 Enter the Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled List form is displayed with the queried
information.

............................................................................................................................................................

5 Select Actions > Modify.

Result:

A popup form is displayed for the selected entity.

............................................................................................................................................................

6 Change the Start Date, Start Time, or both.

............................................................................................................................................................

7 Select OK.

Result:

The selected scheduled entity is modified.
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Filter the display of scheduled entities on the Scheduled List
....................................................................................................................................................................................................................................

Purpose Use this procedure to filter the display of the scheduled entities on the
Scheduled List.

Task Perform the steps below to filter the display of the scheduled
entities on the Scheduled List.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter a Scheduled Entity.

............................................................................................................................................................

3 Select OK.

Result:

The Scheduled List form is displayed with the queried
information.

............................................................................................................................................................

4 Select the Scheduled Entity.

............................................................................................................................................................

5 Select View > Filter/Sort.

Result:

The Scheduled List Sort/Filter form is displayed.

............................................................................................................................................................

6 Select the Filter tab.

Result:

The Filter fields are displayed.

............................................................................................................................................................

7 In the Filter 1, Filter 2, and Filter 3 fields, select a field from the
drop-down menu, then enter a value to the right of your selection.
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............................................................................................................................................................

WARNING
When the Date or Time fields are selected, enter the From
and To date values in the appropriate fields.

8 Select OK.

Result:

The filtered entities are displayed on the Scheduled List form.
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View successful/failed scheduled entities through the Scheduled
History List
....................................................................................................................................................................................................................................

Purpose Use this procedure to query for a historical list of scheduled entities
that were successfully completed or that failed during reinstatement.

Task Perform the steps below to query for a historical list of
successful/failed scheduled entities.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled History
List.

Result:

The Scheduled History List Query Box is displayed.

............................................................................................................................................................

2 Enter a Scheduled Entity.

............................................................................................................................................................

3 Enter a Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled History List form is displayed with the queried
information.
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Section IV: User Defined Area Map

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add, display/modify, or delete user
defined area maps.

Contents
Add a user defined area map 6-26

Display/modify a user defined area map 6-27

Delete a user defined area map 6-28
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Add a user defined area map
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a user defined area map.

Permissions You must be authorized to perform this task.

Task Perform the steps below to add a user defined area map.
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined Area
Map > Add

Result:

The Add User Defined Area Map form is displayed.

............................................................................................................................................................

2 In the User Defined Area Map Name field, enter a name for the user
defined map.

............................................................................................................................................................

3 To add member(s) to the new area map, select one or more entries
from the Non-Members list, then click the left arrow button.

Important! You can optionally complete the Filters field to lessen the
number of listed entries.

Result:

The selection(s) are moved to the Members list.

............................................................................................................................................................

4 SelectOK.

Result:

The new user defined area map is added and the Add User
Defined Area Map form closes.
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Display/modify a user defined area map
....................................................................................................................................................................................................................................

Purpose Use this procedure to display/modify a user defined area map.

Permissions You must be authorized to perform this task.

Task Perform the steps below to display/modify a user defined area
map:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined Area
Map > Display/Modify

Result:

The Modify User Defined Area Map form is displayed.

............................................................................................................................................................

2 In the User Defined Area Map Name field, select the map to be
displayed/modified.

Result:

The selected information displays.

............................................................................................................................................................

3 Do one of the following:

• Make no changes and proceed to the next step.

• Add member(s) to the area map by selecting one or more entries
from the Non-Members list, then click the left arrow button.

• Remove member(s) from the area map by selecting one or more
entries from the Members list, then click the right arrow button.

............................................................................................................................................................

4 SelectOK.

Result:

The area map is modified if changes were made.
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Delete a user defined area map
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a user-defined area map.

Permissions You must be authorized to perform this task.

Task Perform the steps below to delete a user defined area map:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined Area
Map > Delete...

Result:

The Delete User Defined Area Map form is displayed.

............................................................................................................................................................

2 In the User Defined Area Map Name field, select a map name from
the drop-down menu.

Result:

The selected information displays.

............................................................................................................................................................

3 SelectOK.

Result:

The user defined area map is deleted.
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Section V: User Defined Submap

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add, display/modify, or delete user
defined submaps.

Contents
Add a user defined submap 6-30

Display/modify a user defined submap 6-31

Delete a user defined submap 6-32
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Add a user defined submap
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a user defined submap.

Permissions You must be authorized to perform this task.

Task Perform the steps below to add a user defined submap.
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Add

Result:

The Add User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, enter a name for the user
defined submap.

............................................................................................................................................................

3 To add member(s) to the new submap, select one or more entries from
the Non-Members list, then click the left arrow button.

Important! You can optionally complete the Filters field to lessen the
number of listed entries.

Result:

The selection(s) are moved to the Members list.

............................................................................................................................................................

4 SelectOK.

Result:

The new user defined submap is added and the Add User
Defined Submap form closes.
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Display/modify a user defined submap
....................................................................................................................................................................................................................................

Purpose Use this procedure to display/modify a user defined submap.

Permissions You must be authorized to perform this task.

Task Perform the steps below to display/modify a user defined
submap:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Display/Modify

Result:

The Modify User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, select the submap to be
displayed/modified.

Result:

The selected information displays.

............................................................................................................................................................

3 Do one of the following:

• Make no changes and proceed to the next step.

• Add member(s) to the submap by selecting one or more entries
from the Non-Members list, then click the left arrow button.

• Remove member(s) from the submap by selecting one or more
entries from the Members list, then click the right arrow button.

............................................................................................................................................................

4 SelectOK.

Result:

The submap is modified if changes were made.
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Delete a user defined submap
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a user-defined submap.

Permissions You must be authorized to perform this task.

Task Perform the steps below to delete a user defined submap:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Delete...

Result:

The Delete User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, select a map name from
the drop-down menu.

Result:

The selected information displays.

............................................................................................................................................................

3 SelectOK.

Result:

The user defined submap is deleted.
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Section VI: Provisioning maintenance tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the paper or virtual disconnect tool.

Contents
Virtual disconnect tool description 6-34
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Virtual disconnect tool description
....................................................................................................................................................................................................................................

Overview The virtual disconnect tool is used to clean up the WaveStar NMS
database when circuit provisioning does not proceed as planned.

Cleanup is sometimes needed because circuits can be disconnected at
the EMS or network element level without notification to the
WaveStar NMS, or circuits can be partially provisioned and in need of
cleanup before a re-attempt is executed.

The virtual disconnect tool is a means to clean up the NMS database
when circuits are disconnected at the EMS or network element level,
or when circuits are partially provisioned and in need of cleanup
before a re-attempt is executed.

This script would need to be run, for example, in the unlikely event
that an operator incorrectly assigned a circuit to a wrong black box
location when provisioning the circuit in WaveStar NMS. The result
of this script is to cause change to the WaveStar NMS database
without interacting with the network elements.

For more information, see “Virtual disconnect tool task” (8-74).
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7 Reliability and service recovery

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes tasks performed to insure the reliability of
WaveStar NMS and procedures for system recovery if WaveStar NMS
becomes unavailable. It also includes tasks associated with
redundancy configurations.

Contents
Section I: Perform backups 7-3

Perform a hot backup 7-5

Perform a cold backup 7-6

Section II: Perform recoveries 7-8

Recovering Hot or Cold Backups 7-9

Perform a hot backup recovery 7-10

Perform a cold backup recovery 7-11

Recover the database to a different server 7-13

Section III: Delete history 7-15

Section IV: Miscellaneous reliability and service
recovery tasks

7-17

Obtain mirroring status 7-18

Section V: Redundancy 7-19
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EMS switchovers 7-23

Restart WaveStar NMS communication with EMS
servers

7-26

Restart WaveStar NMS communication with
WaveStar SNMS local redundancy servers

7-27

Restart WaveStar NMS’s ability to communicate
with WaveStar SNMS geographic redundancy
servers

7-28

Restart WaveStar NMS’s ability to communicate
with ITM-SC servers

7-29

Switch the roles of WaveStar NMS servers
(simplified or full geographic redundancy
configuration)

7-30

Section VI: Geographic Redundancy
configuration

7-31

View which server is running the WaveStar NMS
application

7-32

Overview Reliability and service recovery
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Section I: Perform backups

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform various types of backups.

Regular backups The system can be set to perform daily backups. The time for the
daily backups is set in the cron file. For information on how to edit
the cron file, see Chapter 3, “System administration”.

Host database backup Two types of backup are available to HP server systems:

• Hot backup

• Cold backup

Hot backups occur when the system is up and running (hot). Cold
backups occur when the WaveStar Network Management System
(NMS) is shutdown (cold). The hot backup takes longer to complete
than the cold backup, but the hot backup can be initiated while the
WaveStar NMS application is running. The application must be
stopped before a cold backup can be initialized.

Hot backup The system automatically backs up the database on Sunday, Tuesday,
Wednesday, Thursday, and Friday at 2:00 a.m. if a tape is present in
the tape drive. A customer may alter the run frequency of hot backups
by changing the run time in the cron file.

The system also performs a hot backup to machines in simplified
geographic redundancy configurations. See “Simplified and full
geographic redundancy configurations” (7-19) within this chapter for
details.

The system is required to be at run level 4 for hot backup. See “Run
level 4” (1-6) for more information on this run level.

No operator action is required during the hot backup, which takes
from 60 to 180 minutes to complete, depending on the size of the
database. The default database backup retention is 5 days (5
tapes/rotation).

Reliability and service recovery
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Important! It is recommended that you maintain scratch tape in the
standby HP 9000 server.

Cold backup A cold backup is the most accurate type of backup.

Operator action is required during the cold backup procedure. The
system is required to be set at run level 3 for cold backup. See “Run
level 3” (1-6) for more information on this run level.

The system must be down to run cold backups. It is recommended
that cold backups are run every week, however it is up to the
customer to determine run frequency.
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Perform a hot backup
....................................................................................................................................................................................................................................

Purpose A hot backup occurs when the system is up and running.

Task Perform the steps below to perform a hot backup.
............................................................................................................................................................

1 Using the system console, log into the system as root.

............................................................................................................................................................

2 Insert a tape into the tape drive.

Important! Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

3 Enter cd /usr/dacscan/bin

............................................................................................................................................................

4 Enter /bin/ksh ./hot_backup

Result:

The hot backup begins. This will take 60-180 minutes to
complete. The # prompt is issued to the system console once the
backup is complete.

............................................................................................................................................................

5 Remove the tape.

............................................................................................................................................................

6 Label the tape with the current date, and store the tape in a safe place.

Result:

The hot backup is complete.
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Perform a cold backup
....................................................................................................................................................................................................................................

Purpose A cold backup occurs when the NMS is shutdown (cold).

Task Perform the steps below to perform a cold backup.
............................................................................................................................................................

1 Using the system console, log into the system as root.

............................................................................................................................................................

2 Stop the WaveStar NMS application.

Reference:

For instructions, see the section “Stop WaveStar NMS on a
specific node using sam” (3-23), in Chapter 3, “System
administration”.

............................................................................................................................................................

3 Log in to the WaveStar NMS server as root.

............................................................................................................................................................

4 Insert a tape into the tape drive.

............................................................................................................................................................

5 Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

6 Enter cd /usr/dacscan/bin

............................................................................................................................................................

7 Enter /bin/ksh cold_backup

Result:

The cold backup begins. This will take approximately 40
minutes to complete. The # prompt is issued to the system
console once the backup is complete.

............................................................................................................................................................

8 Remove the tape.

............................................................................................................................................................

9 Label the tape with the current date, and store the tape in a safe place.
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Result:

The cold backup is complete.
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Section II: Perform recoveries

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform various types of recoveries.

Contents
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Recovering Hot or Cold Backups
....................................................................................................................................................................................................................................

Introduction Two types of recovery are available:

• Recovering a hot backup

• Recovering a cold backup

Recovering a Hot Backup Hot backups are recovered using the “hot_recover” script. WaveStar
NMS must be shut down to perform this procedure.

Recovering a Cold Backup Cold backups are recovered using the “cold_recover” script. WaveStar
NMS must be shut down to perform this procedure.

Recovering the database
to a different server

The database can be recovered onto a different server after a hot
backup is completed.

Assumptions

• Both systems have network connectivity to all Workstations,
external servers (such as ITM-SCs), and network elements. This
connectivity establishes a disaster recovery site.

• The systems have been installed with an identical release of
WaveStar NMS application software (including identical
environment variable settings).

• The systems have both been licensed for identical features and
network elements.

• The system administrators at both sites are synchronizing the
following files:

- /etc/passwd

- /etc/hosts

- /usr/dacscan/oam/config_data/cm/ccpm/ccpconfig (all
references to hostnames except those that contain the local
hostname)

- /etc/x25/*acc_config (specifically the X.121 Network
Telephone Numbers (NTNs)) Virtual Craft Interface
Terminal (VCIT) device files (use the HP-UX system
administration tool “sam”)

- user’s accounts (use the HP-UX system administration tool
“sam”).
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Perform a hot backup recovery
....................................................................................................................................................................................................................................

Purpose Use this procedure to perform a hot backup recovery.

Task Perform the steps below to perform a hot backup recovery.
............................................................................................................................................................

1 Using the system console, log into the system as root.

............................................................................................................................................................

2 Stop the WaveStar NMS application.

Reference:

For instructions, see the section “Stop WaveStar NMS on a
specific node using sam” (3-23), in Chapter 3, “System
administration”.

............................................................................................................................................................

3 Insert the backup tape into the tape drive.

............................................................................................................................................................

4 Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

5 Enter cd /usr/dacscan/bin

............................................................................................................................................................

6 Enter /bin/ksh ./hot_recover

Result:

The hot backup recovery begins. This will take approximately
90 minutes to complete. The # prompt is issued to the system
console once the hot backup recovery is complete.

............................................................................................................................................................

7 Remove the tape.

............................................................................................................................................................

8 Label the tape with the current date, and store the tape in a safe place.

Result:

The hot backup recovery is complete.

Section II: Perform recoveries Reliability and service recovery

....................................................................................................................................................................................................................................

7 - 1 0 Lucent Technologies 365-309-245
Issue 1, October 2001

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Perform a cold backup recovery
....................................................................................................................................................................................................................................

Purpose Use this procedure to perform a cold backup recovery.

Task Perform the steps below to perform cold backup recovery.
............................................................................................................................................................

1 Using the system console, log into the system as root.

............................................................................................................................................................

2 Stop the WaveStar NMS application.

Reference:

For instructions, see the section “Stop WaveStar NMS on a
specific node using sam” (3-23), in Chapter 3, “System
administration”.

............................................................................................................................................................

3 Insert a tape with a valid cold backup into the tape drive.

............................................................................................................................................................

4 Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

5 Enter cd /usr/dacscan/bin

............................................................................................................................................................

6 Enter /bin/ksh ./cold_recover

Result:

A prompt appears and asks for the date of the backup tape.

............................................................................................................................................................

7 Enter YYYYMMDD (or YYMMDD for older tapes).

Important! The date entered must match the date on the backup tape.

Result:

The cold backup recovery begins. This will take approximately
90 minutes to complete. The # prompt is issued to the system
console once the backup is complete.

............................................................................................................................................................

8 Remove the tape.
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............................................................................................................................................................

9 Label the tape with the current date, and store the tape in a safe place.

Result:

The cold backup recovery is complete.
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Recover the database to a different server
....................................................................................................................................................................................................................................

Purpose Use this procedure to recover the database to a different server. This
task can only be performed after a hot backup has been completed.

Before You Begin

• Create a hot backup tape at the site which has the source
database, using the task “Perform a hot backup” (7-5), earlier in
this chapter.

• Ensure that the destination system is at run level 3.

• Recover the hot backup tape at the destination site, using the task
“Perform a hot backup recovery” (7-10), earlier in this chapter.

• On each workstation:

- Ensure that the hostnames/IP addresses for both WaveStar
NMS systems (source and destination) are in /etc/hosts.

- Ensure that the hostnames for both WaveStar NMS systems
(source and destination) are present in /.rhosts.

- Ensure that the hostnames for both WaveStar NMS systems
(source and destination) are present in /home/dacscan/.rhosts.

Task Perform the steps below to recover the database to a different
server.
............................................................................................................................................................

1 Using the system console, log in as dacscan on the WaveStar NMS
server.

............................................................................................................................................................

2 Enter ksh /usr/dacscan/bin/local.sh.

Result:

This script resets the “active controller” field in the database
with the name of the new hostname.

............................................................................................................................................................

3 Refer to ITM-SC documentation for procedures to enable the
ITM-SCs to accept connection requests from the new WaveStar NMS
host.
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............................................................................................................................................................

4 For any network elements that require knowledge of the connecting
manager, refer to their documentation for procedures to enable
connections.

............................................................................................................................................................

5 For each user on each workstation, reset the name of the WaveStar
NMS system to which the user should connect.

............................................................................................................................................................

6 Enter the command init 4 to bring the system to run level 4.

Result:

The WaveStar NMS application is started.
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Section III: Delete history

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the delete history tool.
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About this tool
....................................................................................................................................................................................................................................

Background Whenever a circuit is rearranged, the data from the previous circuit is
retained in the WaveStar NMS database. A circuit that has been
rearranged several times accumulates a large amount of history
information. The Delete History script retains only the necessary
history data associated with each circuit, and deletes all unnecessary
history data from the database.

The Delete History script consists of two parts:

• A script that automatically runs once, when upgrading the
database. If you need to refer to any circuits listed in the history
that are not the most recent non-RS, non-RI circuits, you should
print out these circuits before upgrading the database. The Delete
History script will delete these circuits from the history during
the upgrade.

• A daily script execution that runs immediately following each
successful daily backup.
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Section IV: Miscellaneous reliability and service recovery tasks

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform miscellaneous reliability and
service recovery tasks.
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Obtain mirroring status
....................................................................................................................................................................................................................................

Purpose Use this procedure to obtain mirroring status. This task is used to
verify that the application and databases residing on separate disks are
synchronized.

About the mirrored disk
configuration

A mirrored disk configuration eliminates the need to have a second
server to serve as a backup. The application and database that reside
on separate disks are mirrored onto a second set of disks. Information
that is written to disk is reflected onto the mirrored counterpart. It is
recommended that the mirroring status is checked from time to time
to ensure that all the mirrored information is synchronized with the
primary information.

Before you begin Ensure that the LVSTATUS is set to SYNC.

Task Perform the steps below to obtain mirroring status:
............................................................................................................................................................

1 Using the system console, log into the primary host as root.

............................................................................................................................................................

2 Enter vgdisplay -v | pg at the # prompt.

Result:

The mirroring status displays.
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Section V: Redundancy

Overview
....................................................................................................................................................................................................................................

Purpose This section describes redundancy configurations available to support
WaveStar NMS and Element Management System (EMS) failures.

This section describes how the redundancy process is supported with
simplified geographic redundancy, full geographic redundancy, and
local redundancy configurations.

Geographic redundancy
configurations

Geographic redundancy configurations provide site protection by
maintaining a primary and a standby server in separate locations and
ensuring that the two servers are far enough apart so that natural
disasters or adverse weather conditions cannot affect the servers at the
same time.

There are two types of geographic redundancy: simplified and full.
Both consist of a primary WaveStar NMS server connected to a
standby WaveStar NMS server.

Simplified and full
geographic redundancy

configurations

Simplified and full geographic redundancy configurations differ in the
frequency in which updates occur to the standby server’s database.
For example, for simplified geographic redundancy, data is transmitted
from the primary server to the standby server during the hot backup
process. Full geographic redundancy updates the standby server’s
database every 30 minutes through WaveStar NMS’s geographic
redundancy software which manipulates Oracle files to perform the
regular updates. If there is a failure, no more than 30 minutes of
operations should be lost.

Note that there may be user activity on the standby server in the
simplified geographic redundancy configuration however no user
activity is permitted on this server in the full redundancy
configuration.
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Full Geographic
Redundancy ’s support to

EMS and WaveStar NMS
servers

When a failure occurs to WaveStar NMS servers, the full geographic
redundancy process protects availability through its switchover
process. Similarly, EMS geographic redundancy switchovers protect
the availability of EMS servers. For both scenarios, procedures are
available to address how to maintain WaveStar NMS-EMS
connectivity.

WaveStar NMS geographic
redundancy commands

Several WaveStar NMS geographic redundancy commands are used to
either set up the standby database, or reinitialize the primary database.
These commands are:

• InitializeStandby.sh - creates a standby database on a standby
machine and completes a Full Geographic Redundancy
environment between the primary and standby machines.

• GR_Oracle.sh - performs common functions related to the
Oracle database, which includes how to retrieve system date, how
to revoke or grant privileges, and how to retrieve information of
Oracle files or archive logs.

• OnlineStandby.sh - runs on the standby database only in the
event of a disaster, at which time it activates the standby
database.

• SwitchOver.sh - performs switchover or switchback between
primary and standby databases.

• AlterStandby.sh - synchronizes primary and standby databases
or takes a data file off-line on standby database after physical
structure of primary database was altered.

• CleanGRARCH.sh - cleans geographic redundancy archive file
system.

WaveStar NMS local
redundancy switchover

The standby server has a pulse process that monitors the heartbeat of
the primary server. These processes can be started and stopped
manually. The pulse process resides on the standby server. This
process is used to determine whether the primary server is alive. The
heartbeat process resides on the primary server. This process is used
as a detection mechanism to initiate automatic switchover for
WaveStar NMS local redundancy configurations.
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Local redundancy
configuration switches to

the standby server
(MC/ServiceGuard)

The local redundancy configuration is supported by a
MC/ServiceGuard paradigm in which the primary and standby servers
are connected to the same database. In this paradigm, the “primary”
and the “standby” systems are treated as a “cluster”, and applications
are bundled into “packages,” which can be launched on either of the
machines in the cluster. When one of the machines in a cluster detects
the loss of heartbeat from the other machine, the cluster is reformed
without the failed machine. Any packages run on the failed machine
are migrated to, and restarted on, the remaining machine. For
applications that can take advantage of distributed computing, this
solution allows the full resources of both machines to be utilized.

The incorporation of MC/ServiceGuard results in a local redundancy
configuration with distinct Switchover/UX-like characteristics, namely
an “primary” and a “standby” system. The entire application—with all
its assets, is bundled as a single package and configured to run in a
single instance. The MC/ServiceGuard configuration offers some
failover performance over the Switchover/UX configuration, because a
reboot is no longer required as part of the switchover.

Automatic and manual
switchovers

Automatic switchovers occur when there is a link loss or when there
is a failure of an association between a primary server and a network
element. Manual switchovers occur when a user manually initializes a
switchover to a standby server. WaveStar NMS geographic
redundancy configurations require manual switchover processing,
while its local redundancy configurations feature automatic
switchover.

WaveStar NMS supports manual switchovers for the ITM-SC EMS
and manual and automatic switchovers in WaveStar SNMS. (See
“EMS switchovers” (7-23) for details). The support is designed to
assure maximum availability of WaveStar NMS while minimizing the
downtime of the subtending EMS population, where several
switchovers can be expected. While local redundancy switchovers are
always automatic, the EMS geographic redundancy switchover process
occurs manually only in the earlier releases of WaveStar SNMS (for
example, R5.0) while WaveStar SNMS R5.1 supports both manual
and automatic switchovers.

For example, in WaveStar SNMS releases earlier than R5.1, a
command is entered to initiate switchover. Newer releases of
WaveStar SNMS (Release 5.1 and beyond), manual switchovers are
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handled through a Cluster Administrator GUI, which may be set up to
support manual or automatic switchovers.

WaveStar SNMS Cluster
Administration GUI

The WaveStar SNMS Cluster Administration GUI contains two icons
to support local and remote servers. When a failure occurs, an ’X’
displays on the failed server’s icon, which is displayed in WaveStar
SNMS. The ’X’ clears once communication is re-established to the
server.

In order to provide an instant status to WaveStar NMS personnel, it is
recommended that the GUI is placed on a convenient workstation at
the WaveStar NMS work center.

Supporting EMS/WaveStar
NMS server failures

When failures occur to the WaveStar SNMS and ITM-SC EMS
servers, they are either automatically resolved through redundancy
software intervention methods in place, or must be resolved manually
through the EMS system administrator’s intervention.

Manual intervention varies by EMS server type, release number, and
redundancy type. It also differs depending upon whether or not the
failure occurs on the EMS side versus if it occurs on the WaveStar
NMS side.

The following tasks define the steps that need to be performed by
WaveStar NMS system administrators after any switchover occurs to
an EMS server.

Contents
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servers

7-26

Restart WaveStar NMS communication with
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7-27
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servers

7-28

Restart WaveStar NMS’s ability to communicate
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7-29

Switch the roles of WaveStar NMS servers
(simplified or full geographic redundancy
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7-30
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EMS switchovers
....................................................................................................................................................................................................................................

WaveStar SNMS
switchover behavior (for
geographic redundancy

configurations)

During the initial installation of the complex containing WaveStar
SNMS servers in a geographic redundancy configuration, the
add.controller command is entered twice in WaveStar NMS. More
specifically, the command is entered one time per WaveStar SNMS
server.

Before a switchover occurs, the WaveStar SNMS primary and standby
servers in a geographic redundancy configuration display on the
WaveStar NMS Network Controller Map as two green icons.

The two servers are distinguished by their adjacent ″Controller Name″
labels.

Assuming that Server A in this configuration is Active and Server B
is in Standby mode, when WaveStar SNMS Server A fails, its icon
turns to magenta while Server B’s icon remains green. Once the
WaveStar SNMS switchover occurs, about 7 minutes elapse between
Server A’s failure and Server B’s new status. When Server A is
repaired by the WaveStar SNMS staff, Server A’s icon becomes green
again, and two green icons display on the WaveStar NMS Network
Controller Map.

At this point, there is no WaveStar NMS manual re-synchronization
action required. Note that when the switchover occurred, WaveStar
NMS had interrupted communications to WaveStar SNMS Server A,
however it held the orders during the 7 minute timeframe and then
resumed communication with WaveStar SNMS Server B.

WaveStar SNMS
switchover behavior (for

local redundancy
configurations)

In WaveStar SNMS local redundancy configurations, the WaveStar
SNMS MC/ServiceGuard cluster is assigned an arbitrary designation
name, such as <C_arbitrary_designation_name> which serves as a
floating IP address.

During the initial installation of WaveStar SNMS servers in a local
redundancy configuration, the add.controller command must be
used to uniquely support the floating IP address representing the
cluster.

The actual WaveStar SNMS primary and standby servers within the
cluster (for example, Server A and Server B) are designated in the
/etc/hosts file of the WaveStar NMS server with their
fully-qualified name, such as <servername>.<full_name>.com.
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Before a switchover occurs, the WaveStar SNMS cluster in a local
redundancy configuration displays on the WaveStar NMS Network
Controller Map as one green icon.

Assuming that Server A in this configuration is Active and Server B
is in Standby mode, when WaveStar SNMS Server A fails, the icon
turns to magenta for a period of 3-5 minutes, after which the
WaveStar SNMS local redundancy switchover occurs. Once
switchover is complete, the icon turns back to green and WaveStar
NMS operation continues as usual with WaveStar SNMS Server B as
Active.

At this point, there is no WaveStar NMS manual re-synchronization
action required. Note that when the switchover occurred, WaveStar
NMS had interrupted communications to WaveStar SNMS Server A,
however it held the orders during the 3-5 minute timeframe and then
resumed communication with WaveStar SNMS Server B.

ITM-SC switchover
behavior

When ITM-SC servers experience a failure, the icons (in the
geographic redundancy configuration) representing the failed machine
changes its color.

On the Network Controller Map, the failed server’s icon changes from
green to magenta. This indicates that WaveStar NMS has lost
communications with the failed machine. WaveStar NMS attempts to
regain communication with the failed machine.

When the failed ITM-SC machine does not recover, switchover
processing occurs in the background on the ITM-SC side to change
the standby machine to the primary machine. The switchover occurs
either automatically (through software intervention) or manually by
the ITM-SC network operator. Once switchover is complete, the icon
turns back to green and WaveStar NMS operation continues as usual
with the alternate ITM-SC server in Active state.
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Detecting EMS
switchovers

While the icon(s) changes colors on the Network Controller Map
when EMS switchovers occur, it may not be clear as to exactly when
the EMS switchovers occur. The restoral is automatic, yet there may
be critical provisioning that must be re-sent because orders were
placed in pending state during the switchover. A notification process is
in place for newer releases of WaveStar SNMS through the Cluster
Administration GUI. This process notifies WaveStar NMS
administrators (by a call, page, or email message), that a switchover
has occurred.

Since the notification process is not in effect for ITM-SC switchovers
or in prior releases of WaveStar SNMS, it is important to contact the
network operator(s) responsible for the EMS in question if it is
unclear as to which server is primary.
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Restart WaveStar NMS communication with EMS servers
....................................................................................................................................................................................................................................

Restart WaveStar NMS
communication with EMS

servers

When icons representing EMS servers appear magenta for an extended
period of time, use one of the following tasks to initiate
communication to the EMS servers.

• To restart communication to WaveStar SNMS servers in a local
redundancy configuration, see “Restart WaveStar NMS
communication with WaveStar SNMS local redundancy servers”
(7-27).

• To restart communication to WaveStar SNMS servers in a
geographic redundancy configuration, see “Restart WaveStar
NMS’s ability to communicate with WaveStar SNMS geographic
redundancy servers” (7-28).

• To restart communication to ITM-SC servers, see “Restart
WaveStar NMS’s ability to communicate with ITM-SC servers”
(7-29).

For additional information, see the Database Maintenance chapter in
the WaveStar SubNetwork Management System (SNMS)
Administration Guide or the Geographic Redundancy chapter of the
ITM-SC Release 7.0 Administration Guide.
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Restart WaveStar NMS communication with WaveStar SNMS
local redundancy servers
....................................................................................................................................................................................................................................

Purpose This task explains how to restart WaveStar NMS communication with
WaveStar SNMS servers residing in a local redundancy configuration.
This task would be performed if the color of the icon representing the
WaveStar SNMS cluster does not change from magenta to green after
a period of 5 minutes.

Task Use the following steps to restart communication to WaveStar
SNMS local redundancy servers.
............................................................................................................................................................

1 On the Network Map, select File > Open Network Controller Map.

Result:

The Network Controller Map displays.

............................................................................................................................................................

2 Select the icon representing the WaveStar SNMS cluster configuration,
click the left mouse button, and select Session > Start
Communication.

Result:

A dialog box containing the following text displays: START
SESSION COMMAND SENT FOR FRAME:<ems_ name>

............................................................................................................................................................

3 On the dialog box, click OK.

Result:

Communication should start.

............................................................................................................................................................

4 If communication does not start, contact the network operator(s)
responsible for the WaveStar SNMS local redundancy servers.
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Restart WaveStar NMS’s ability to communicate with WaveStar
SNMS geographic redundancy servers
....................................................................................................................................................................................................................................

Purpose This task explains how to restart WaveStar NMS’s ability to
communicate withWaveStar SNMS servers residing in a geographic
redundancy configuration. This task would be performed if the color
of the icon representing a WaveStar SNMS server does not change
from magenta to green after a period of time exceeding 7-15 minutes.

Task Use the following steps to restart WaveStar NMS’s ability to
communicate with WaveStar SNMS geographic redundancy
servers.
............................................................................................................................................................

1 On the Network Map, select File > Open Network Controller Map.

Result:

The Network Controller Map displays.

............................................................................................................................................................

2 Select the icon representing the WaveStar SNMS geographic
redundancy configuration, click the left mouse button, and select
Session > Start Communication.

Result:

A dialog box containing the following text displays: START
SESSION COMMAND SENT FOR FRAME:<ems_ name>

............................................................................................................................................................

3 On the dialog box, click OK.

Result:

Communication should restart.

............................................................................................................................................................

4 If communication does not restart, contact the network operator(s)
responsible for the WaveStar SNMS geographic redundancy servers.
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Restart WaveStar NMS’s ability to communicate with ITM-SC
servers
....................................................................................................................................................................................................................................

Purpose This task explains how to restart WaveStar NMS’s ability to
communicate with ITM-SC servers residing in a geographic
redundancy configuration. This task would be performed if the color
of the icon representing the ITM-SC server does not change from
magenta to green after several minutes.

Task Use the following steps to restart WaveStar NMS’s ability to
communicate with ITM-SC servers.
............................................................................................................................................................

1 On the Network Map, select File > Open Network Controller Map.

Result:

The icons representing the ITM-SC servers should display.

............................................................................................................................................................

2 Select the icon representing the ITM-SC server, click the left mouse
button, and select Session > Start Communication.

Result:

A dialog box containing the following text displays: START
SESSION COMMAND SENT FOR FRAME:<ems_ name>

............................................................................................................................................................

3 On the dialog box, click OK.

Result:

Communication should restart.

............................................................................................................................................................

4 If communication does not restart, contact the network operator(s)
responsible for the ITM-SC servers.
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Switch the roles of WaveStar NMS servers (simplified or full
geographic redundancy configuration)
....................................................................................................................................................................................................................................

Purpose Use this procedure to switch the roles of WaveStar NMSservers
(primary becomes standby and standby becomes primary) when using
the simplified or full geographic redundancy configuration. This task
is performed, for example, when service is required to the primary
server.

Task Perform the step below to switch the roles of the servers.
............................................................................................................................................................

1 Log into the standby server as dacscan.

............................................................................................................................................................

2 Enter /usr/dacscan/bin/Switchover.sh.

Result:

The roles of the servers are switched. (Primary becomes standby
and standby becomes primary.)
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Section VI: Geographic Redundancy configuration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform a task to support servers
residing in a geographic redundancy configuration.

Contents
View which server is running the WaveStar NMS
application

7-32
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View which server is running the WaveStar NMS application
....................................................................................................................................................................................................................................

Purpose Use this procedure to view which server is running the WaveStar
NMS application.

This task is a geographic redundancy-only issue.

Task Perform the steps below to view which server is running the
application.
............................................................................................................................................................

1 Do one of the following:

• Enter cat /install/GR.role

• On the Network Controller Map, locate the labeled WaveStar
NMS icon.

Section VI: Geographic Redundancy
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8 Off-line tool concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes off-line script tools provided with WaveStar
NMS. It also contains tasks associated with off-line tools.

Contents
Section I: Auto-Discovery Tool 8-3

Section II: Rename network element tool 8-17

Change the name of an existing network element 8-18

Section III: INSERTNODE and REMOVENODE
tools

8-23

Insert an ITM-SC controlled node into a digital link
using INSERTNODE

8-26

Insert a WaveStar SNMS controlled node into a
digital link using INSERTNODE

8-32

Delete an ITM-SC controlled node from a digital
link using REMOVENODE

8-37

Delete a WaveStar SNMS controlled node from a
digital link using REMOVENODE

8-40

Section IV: Network element reparenting tool 8-42

Reparenting ITM-SC controlled Network Elements 8-43
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Reparenting WaveStar SNMS controlled network
elements

8-45

Reparenting WaveStar NMS EMS resources to
another WaveStar NMS

8-48

Section V: Upgrade WaveStar OLS 400G to
WaveStar OLS 800G

8-50

Upgrade WaveStar OLS 400G to WaveStar OLS
800G

8-51

Section VI: Upgrade WaveStar OLS 400G’s
network element’s from CMISE mode to TL1
mode

8-53

Use the CMISE to TL1 upgrade tool for WaveStar
OLS 400G

8-54

Section VII: Connection renaming tool 8-56

Rename network connections with the connection
renaming tool

8-58

Section VIII: Bulk circuit provisioning tool 8-60

Bulk circuit provisioning tool task 8-61

Section IX: Bulk link provisioning tool 8-63

Bulk link provisioning tool task 8-64

Section X: Network element tools 8-66

Add a new network element to an established ring 8-67

Delete a network element from a ring 8-70

Configure a network element for an X.25 network 8-71

Section XI: Virtual disconnect tool 8-73

Virtual disconnect tool task 8-74
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Section I: Auto-Discovery Tool

Overview
....................................................................................................................................................................................................................................

Purpose The Auto-Discovery Tool is a UNIX script that is used off-line from
WaveStar NMS in two instances:

• When new customers with an existing live network (not yet or
already managed by an element management system), wish to
migrate their network management to WaveStar NMS.

• When existing WaveStar NMS customers who already have part
of their network managed by WaveStar NMS, wish to move
another part of their network under WaveStar NMS management.

Auto-Discovery tool performs two different tasks, which users can
combine or run singly:

• Discover the network’s connection layout based on input files.
Auto-Discovery tool uses input files provided by the EMS to
discover a connection’s layout and will only discover connections
defined by the data provided by the EMS. If the file defines only
one part of a connection, a manual merging may be later needed
to connect the connection’s different sections.
Auto-Discovery tool performs connection discovery in two
phases. In the first phase, it discovers VC-4 layer connections; in
the second phase, it discovers low-order connections. The tool
can discover VC4-4c and AU3 connections during the first or
second phases.

• Provision the discovered connections into WaveStar NMS.
For each discovered assignable path, the tool can automatically
provision a circuit to ride exactly on the path.

Initially, Auto-Discovery tool is run to discover and provision paths. It
is then run to provision the circuits riding atop the discovered paths.
The tool discovers the VC-4 and structured connections in the same
run. When the combo option is set, the tool achieves discovery of the
lower order connections and their circuits in the same run.

Off-line tool concepts
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Prerequisites Before using this tool:

1. All of the digital links belonging to the “migrated or discovered”
network must be (manually) provisioned in the WaveStar NMS
first before the Auto-Discovery tool can be run.

2. Two input files, a port file and a cross connect file must be
“extracted” from each of the EMSs. These extractions are
provided by running a script file in the EMS. See the topic “Data
import interface” (8-9) in this chapter for details.

Using the tool The tasks which use this tool are provided after this description.

Restrictions The following restrictions apply to the Auto-Discovery tool:

• Users must run the tool while the WaveStar NMS host is
running.

• While the tool is running, do not continue operational and
provisioning procedures through WaveStar NMS as it will slow
down the tool’s performance. Auto-Discovery tool could fail if
the user tries to access the same resources as the tool.

• No commands are sent to the network element level.

• Several instances of the tool cannot run simultaneously.

• It is possible to run the tool to discover several levels of
connections. It is not, however, possible to discover high-order
(VC-4) and low-order connections within the same run.

• The connections discovered by the tool may already have some
alarms raised or may be affected by a server failure.

• Input files describe the subnetwork involved in the
auto-discovery. The tool supports filtering of these input files.

• Users attempting to merge connections after path discovery may
have to first delete the circuit before being able to merge the
path.

Supported network
elements

Auto-Discovery tool supports the following network elements:

• Intelligent Synchronous Multiplexers (ISMs) [all Ring Drop
Insert (RDI) models]

• Synchronous Line Multiplexers (SLMs) all models

Section I: Auto-Discovery Tool
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• WaveStar ADM 155 E

• WaveStar ADM 4/1 STM-1 and WaveStar ADM 4/1 STM-4

• LXC 4/1

• LXC 16/1

• WaveStar ADM 16/1 and WaveStar ADM16/1 Compact

• WaveStar AM 1

• WaveStar TM 1

• WaveStar DACS

• WaveStar BandWidth Manager

• TDM 10G

Supported connections
types

Auto-Discovery tool supports the following connection types:

• Circuits

- 1920N circuits

- 480N circuits

- 672N circuits

- 30N circuits

- 24N circuits

• Combos

- VC4-1920N combo

- AU3-480N combo

- AU3-672N combo

- VC3-480N combo

- VC3-672N combo

- VC12-30N combo

- TU12-VC11-24N combo

• Paths

- VC4-4c paths

- VC-4 paths

- AU3 paths

- VC-3 paths

- VC-2 paths

Section I: Auto-Discovery Tool
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- VC-12 paths

- TU12-VC11 paths

Bidirectional: The tool supports bidirectional connection
discovery.

CTP and TTP: The tool supports connections that terminate on a
CTP (non-assignable port for both extremities) or TTP
(assignable port on one or both extremities).

MS-SPRING and SNC Protected: The tool supports both
MS-SPRING and SNC protected paths. The connections can be
either 1+1 or ring-protected.

Y-Protected: The tool supports Y-protected connections.

VC-4 paths: The tool supports both the structured and
unstructured VC-4 (carrying 140-Mb PDH). For the VC-4
structured connection, the tool will only discover those VC-4
paths which carry at least one low order connection.

Unsupported connection
types

The following connections are not supported by the Auto-Discovery
tool:

• Loopback on WaveStar DACS

• One-way or broadcast connections

• Single node connection. That is, a connection where
A_NE=Z_NE

• The discovery of connections running through or ending on a
black box

Parameters Auto-Discovery tool supports command line parameters and prompt
options. If a user specifies a command line parameter, the tool
prompts the user to confirm the parameters. If the user does not
specify any parameter, the auto discovery tool prompts the user to
confirm each of the following parameters:

• Input file names (default or new).

• WAIT_TIME (default or new). WAIT_TIME is the waiting
period (in seconds) between two connection provisioning
commands sent to WaveStar NMS from the Auto-Discovery tool.
It prevents WaveStar NMS from being congested by a burst of
provisioning commands. The default is 20 seconds.

Section I: Auto-Discovery Tool
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• Network element models (when a model file is used). The user
input file specifying models is located at /tmp/modelslist.

• Network elements file (if a network element file is used). By
default, the user input file specifying the list of network elements
is located at /tmp/nes_list. Note: ITM-SC does not support the
Network elements file option.

• Element management system files (if used). The default location
for the EMS files used by the tool are located at /tmp/ems.port
(for the port file) and /tmp/ems.xc (for the cross-connect file).

Log files Auto-Discovery tool generates three log files to track discovered and
provisioned connections. The three log files are:

• /tmp/auto_disc/auto_disc.log

• /tmp/auto_disc/end2end.log

• /tmp/auto_disc/send_g2.log.

Discovered connections logs

When a connection is discovered by Auto-Discovery tool, it is logged
to /tmp/auto_disc/newckts. Each record consists of one line, and
each line consists of A_NE:Z_NE:type:id:ckt_id. Paths and combos
are written to a flat file located at /tmp/auto_disc/path_G2.line and
circuits are written to /tmp/auto_disc/ckt_G2.line.

The creation of a log file does not indicate that a connection has been
successfully provisioned. The connection may be left in a pending
state in NMS if there was an error during provisioning. It is possible
to reapply the pending connections through WaveStar NMS.

Provisioned connections logs

When a discovered connection is provisioned in NMS, it is logged to
the file /tmp/auto_disc/provckts. Each record consists of one line.
Each line consists of A_NE:Z_NE:type:id:ckt_id.

When a discovered connection is provision in WaveStar NMS, it is
also logged in a specific format to be used as an input for the
connection renaming tool. Only one port is logged for each
provisioned connection. The file is located at
/tmp/auto_disc/renameckts.

Error Log Files

The Auto Discovery tool stores any errors in a log file located at
/tmp/auto_disc/circuit.err. In addition to data validation errors, the
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tool will also log any layout inconsistencies and unsupported
connection configurations.

Tool files The following files affect the auto-discovery and connection renaming
tools’ use:

• Network element model file

• Network element file

• Rate file

The Network element model file

The model file restricts the Auto-Discovery tool’s domain.
Auto-Discovery tool will only discover the connections that run
through network elements whose models are specified within this file.
The following models are allowed in the file:

• ISMs

• SLMs

• ADM 155E

• WaveStar ADM 4/1 STM-1 and WaveStar ADM 4/1 STM-4

• LXC 4/1

• LXC 16/1

• WaveStar ADM 16/1 and WaveStar ADM16/1 Compact

• WaveStar AM 1

• WaveStar TM 1

• WaveStar DACS

• WaveStar BandWidth Manager

• TDM 10G

The Network Element file

The network element file restricts the domain of Auto-Discovery tool.
The Auto-Discovery tool will only discover the connections that run
through the network elements specified by this file. Please refer to
“Supported network elements” (8-4) earlier in this chapter, for a list of
supported network elements.
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The Rate file

The rate file restricts the connection types discoverable by the
Auto-Discovery tool. The following rates are allowed in the file:

• VC4-4c

• VC-4

• C3

• DS3

• C1

• DS1

Data import interface The Auto Discovery tool’s data import interface allows for the
importation of data from an element management system to a network
management system.

The data import interface consists of two files: a cross-connect file
and a port file. The EMS extraction tool extracts from the EMS
database all the ports and cross-connects supported by the
Auto-Discovery tool and save them into these two files.

ITM-SC

For ITM-SC, the interface is applicable to the following network
elements:

• ADM 155E

• ISMs

• LXC 4/1

• LXC 16/1

• SLMs

• WaveStar ADM 4/1 STM-1

• WaveStar ADM 4/1 STM-4

• WaveStar ADM 16/1

• WaveStar AM 1

• WaveStar TM 1

• WaveStar DACS Release 2.1

Section I: Auto-Discovery Tool
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WaveStar SNMS

For WaveStar SNMS, the interface is applicable for the following
network elements:

• WaveStar BandWidth Manager

• TDM 10G

Note

• For each EMS, the interface is applicable to any network element
type that supports at least one signal rate supported by the auto
discovery tool.

The Cross-connect file

The cross connect file contains the supported rates for the
cross-connects. The file is applicable to the following rates:

• VC4-4c

• VC-4

• AU3 (high-order VC-3)

• VC3 (low-order VC-3)

• VC-2

• VC-12

Depending on the network elements, the fixed cross-connect may or
may not be part of the interface. For the WaveStar ADM 4/1 STM-4,
the fixed line to line AU4 cross-connects are part of the interface. For
the ADM 16/1, the fixed low-order cross-connect is not part of the
interface when a VC-4 trail terminates on a tributary card.
VC-3/VC-12 fixed cross-connects in the VC-4 are not returned.

In the case of a protected cross-connect (SNCP), the protected port is
mapped in the toport parameter and the protecting port is mapped into
the newto port.

Table 8-1 Cross-Connect File Field Descriptions

Field Description

Field 1 EMS ID

Field 2 network element ID

Field 3 fromport address

Field 4 fromport physical type, for example, S16, S4,
S1, S0, C1, C3, DS3, DS1
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Table 8-1 Cross-Connect File Field Descriptions (continued)

Field Description

Field 5 toport address

Field 6 toport physical type

Field 7 newto address

Field 8 newto physical type

Field 9 cross-connect type (P for Protected, T for
Unprotected)

Field 10 rate (VC-12/VC-2/VC-3/AU3/VC-4/VC4-4c)

The Port file

The port file contains the rates supported by the interface for ports.
The interface is applicable to the following rates:

• VC-4 (140 Mb or VC-4 substructured)

• C3 (34 Mb)

• DS3 (45 Mb)

• C1 (2 Mb)

• DS1 (1.5 Mb)

For the low-order rates (all rates except VC-4), each port record
corresponds to a SDH TTP port on a PDH interface card. The port
information also includes information about the related PDH CTP
port, when applicable.

Table 8-2 Port File Field Descriptions

Field Description

Field 1 Network element identifier (TID) of EMS

Field 2 TID of network element

Field 3 Port address

Field 4 Physical Type

Field 5 Param1

Field 6 Param 2

Field 7 pti_t

Field 8 pti_e

Section I: Auto-Discovery Tool
Overview

Off-line tool concepts

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 8 - 1 1



Table 8-2 Port File Field Descriptions (continued)

Field Description

Field 9 pti_mode

Field 10 rate (C1, C3, DS3, DS1, VC4)
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Add or migrate networks to WaveStar NMS management using
the auto-discovery tool
....................................................................................................................................................................................................................................

Purpose Use this task to add or migrate networks to WaveStar NMS
management.

The auto-discovery tool is an off-line UNIX script that is used in two
instances:

• When new customers who already have an existing live network
(not yet or already EMS managed) wish to migrate their network
management to WaveStar NMS.

• When existing WaveStar NMS customers, who already have a
part of their network managed by WaveStar NMS, wish to
include another part of a live network under WaveStar NMS
management.

Before you begin Before using the auto-discovery tool, note the following items:

• One or more element managed systems already manage the
network elements the auto-discovery tool will discover.

• At anytime, use [-h] to access screen help.

Task Use the following procedure to either migrate an existing live
network to WaveStar NMS management or to add another part of
a live network already under WaveStar NMS management to a
WaveStar NMS managed network.
............................................................................................................................................................

1 Run the EMS extraction tool, to extract the VC-4 data from each of
the EMS databases, and export the data to the EMS disk. Refer to the
ITM-SC documentation for instructions on this step.

............................................................................................................................................................

2 Copy the EMS files onto the WaveStar NMS disk.

............................................................................................................................................................

3 Merge the EMS files into two files (the port and cross-connect files).

............................................................................................................................................................

4 Log in as dacscan.
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............................................................................................................................................................

5 Enter /usr/dacscan/toolbin/auto_disc to discover the VC-4
connections and provision them into the NMS database using the
EMS data.

Result:

The system sends IE commands to the element management
system to verify the cross-connect and end ports used by the
discovered connections.

............................................................................................................................................................

6 Specify the tool parameters, the WAIT_TIME variable and filenames.
See “Specify auto-discovery tool parameters” (8-15) for details.

............................................................................................................................................................

7 Run the EMS extraction tool to extract the low-order data from the
EMS database and export it to the EMS disk.

............................................................................................................................................................

8 Copy the EMS files on to the WaveStar NMS disk.

............................................................................................................................................................

9 Enter /usr/dacscan/toolbin/auto_disc to discover the low-order
connections and provision them in the NMS database using the EMS
data.

Important! When the combo option is installed, this can be achieved
in one run of the tool. When the combo option is not set, this has to
be achieved in at least two steps. The tool is first run to discover and
provision the paths. The tool is then run to provision the circuits
riding on top of the discovered paths.

Result:

IE commands are sent to the EMS to verify the cross-connect
and endports used by the discovered connections. The network
is then added or migrated to WaveStar management.
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Specify auto-discovery tool parameters
....................................................................................................................................................................................................................................

Purpose Use this task to specify auto-discovery tool parameters.

The auto-discovery tool uses user-provided input files to discover a
connection’s layout. The tool will only discover connections defined
by the data provided by the element management system. If the file
only defines one part of a connection, a manual merging may be
necessary to connect the connection’s different sections.

Task Use the following procedure to specify and confirm the
parameters used by the auto-discovery tool during operation.
............................................................................................................................................................

1 Log in as dacscan.

............................................................................................................................................................

2 Enter /usr/dacscan/toolbin/auto_disc. The auto-discovery tool
will then prompt you to confirm the following parameters:

• Function [-f y/d/p] - if set to y (WaveStar NMS), the tool will
discover connections and provision them in WaveStar NMS.

- If set to d, the tool will discover connections but will not
provision them.

- If set to p, the tool will just provision the already discovered
connections.

• Trail Type [-t path/ckt] - specifies the connection type to
discover. Must be set to path (default) if combo was set as an
installation.

• Send EMS [-s y/n] - if set to y(default), will check provisioned
connections against the element management system databases. If
set to n, the connections will not be checked.

• Rate [-r VC-2/VC-3/VC-12/VC-4/VC4-4c] - causes the tool to
only discover and provision the connections for the list of rates
given in the parameter. VC-4 cannot be selected if a low-order
rate (C3, C1, DS1, etc.) is elected. The default is VC-12.
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• Domain [-m no/model/nes] - restricts the domain of the
connection discovery process by filtering the EMS data with a
list of network element types (model) or a list of network
elements (nes).

- If set to no (default), the tool discovers all the connections
described in the input files without restriction, ignoring the
existing model and network element files.

............................................................................................................................................................

3 Confirm the WAIT_TIME variable.

Result:

The complete command line will discover the VC-4 connections
and provision them into the WaveStar NMS database using the
element management system data.

Section I: Auto-Discovery Tool
Specify auto-discovery tool parameters

Off-line tool concepts

....................................................................................................................................................................................................................................

8 - 1 6 Lucent Technologies 365-309-245
Issue 1, October 2001

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section II: Rename network element tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to change the identification of an existing
network element using the rename network element tool.

Renaming Tool This tool is used to change the identification of an existing network
element.

Contents
Change the name of an existing network element 8-18
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Change the name of an existing network element
....................................................................................................................................................................................................................................

Purpose This task describes how to change the identification of an existing
network element using the rename network element tool. This tool is
first run on an ITM-SC server using the ems_db_gnrt command
(which resides on the ITM-SC server in the /opt/itm/sc/diag/bin
directory) and then run on the WaveStar NMS server.

Before you begin Before you change the name of an existing network element, consider
the following items:

• Changing a network element’s name should be first done in the
ITM-SC that controls the network element. It is recommended
that users perform an ITM-SC on-line archive before changing
the network element’s name.

• The user must ensure the uniqueness of the new network element
name.

• Shut down the ITM-SC before running the off-line script. The
WaveStar NMS user will not be able to communicate with the
ITM-SC at this time.

• The user should remove the geographic redundancy in the
ITM-SC for the network elements being changed.

• WaveStar NMS will only update the new name in the Circuit IDs
that are in M.1400 format. For Circuit IDs with FREE FORMAT,
it is the user’s responsibility to update the Circuit IDs (using the
Graphical Layout Parameters form).

• The WaveStar NMS will not dynamically update any current
screen with the new network element ID name. The user must
restart the WaveStar NMS user interface to display the new
name.

• When renaming a network element, users must abide by a strict
naming convention. Refer to “Section VII: Connection renaming
tool” (8-56) for details.
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• Users should mind the following limitations when renaming an
existing network element.

- The system does not perform any alphabetic ordering after
the network element name change.

- Subnet ID, Aggregate ID, and Controller Name changes are
not supported.

- The system will not update any Kanji-related tables. This
limitation is only relevant for Japanese customers.

- For the changed name to be displayed, the user must restart
the WaveStar NMS user interface.

- If a network element is deleted, has its name changed, or its
Office identification does not have an associated TID name,
it will remain on the Location Reference Table.

- The performance monitoring start time is lost after a
management information base (MIB) download. Thus, any
required information from a network element’s performance
monitoring report must be obtained before its name is
changed.

Task Important! Because the ITM-SC portion of this script may change,
please refer to the ITM-SC user documentation for updated
information on how to run this script on the ITM-SC system.

Perform the following steps to change the identification of an
existing network element. Note that the steps used in the first
part of this task apply to the ITM-SC server while the remaining
steps apply to the WaveStar NMS server.
............................................................................................................................................................

1 Log into the ITM-SC host as i2kadmin.

Result:

The ITM-SC host will request a password.

............................................................................................................................................................

2 Enter the ITM-SC password for the i2kadmin login.

Result:

The user is logged into the ITM-SC host.

............................................................................................................................................................

3 At the prompt, type . itmsc_setup
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Result:

The ITM-SC set up begins.

............................................................................................................................................................

4 At the prompt, enter cd /opt/itm/sc/diag/bin.

Result:

The prompt resides at the specified directory.

............................................................................................................................................................

5 Use a text editor to create a node_mapping file.

Be sure that the node_mapping file contains one line each, in
old_name|new_name format separated by a | character. A carriage
return must separate each line.

............................................................................................................................................................

6 At the prompt, enter ems_stop.

Result:

The ITM-SC is stopped.

............................................................................................................................................................

7 At the prompt, enter ./ems_db_gnrt —n

This command checks existing network elements in the ITM-SC
database.

............................................................................................................................................................

8 Continue with one of the following steps:

• If you know the value assigned to the network element to be
renamed, proceed to the next step to continue.

• If you do not know the value assigned to the network element to
be renamed, and would like to display a list of values, enter
./ems_db_gnrt then proceed to the next step.

............................................................................................................................................................

9 At the prompt, enter ./ems_db_gnrt -D <network_element_value>
-N node_mapping

Result:

The tool is initiated.
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............................................................................................................................................................

10 At the prompt, enter y to confirm the actions.

Result:

The renaming tool is executed and runs until successful
completion.

............................................................................................................................................................

11 While the ITM-SC is still down, log into the WaveStar NMS host as
root.

............................................................................................................................................................

12 At the prompt, enter cd /usr/dacscan/toolbin

Result:

The prompt resides at the directory where the change_neid tool
is located.

............................................................................................................................................................

13 Use a text editor to create an nm.node file.

This file has the same format as the node_mapping file. Note that
the last line of the nm.node file must not contain a carriage return.
(See Step 5.)

............................................................................................................................................................

14 At the prompt, enter su -dacscan.

Result:

This logs the user into the WaveStar NMS host as the dacscan
user.

............................................................................................................................................................

15 At the prompt, enter

cd ../toolbin

./change_neid nm.node

Result:

The renaming tool is executed and runs until the process is
complete.

............................................................................................................................................................

16 Upon completion, log into the ITM-SC server as i2kadmin.
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Result:

The ITM-SC server will request a password.

............................................................................................................................................................

17 Enter the ITM-SC password for the i2kadmin login.

Result:

The user is logged into the ITM-SC host.

............................................................................................................................................................

18 At the prompt, type:

. itmsc_setup

ems_start

Result:

The ITM-SC application is restarted.

..........................................................................................................................................................

19 IF THEN

The renamed network
element is a WaveStar
DACS 4/4/1,

Use the following steps.

1. Login to the WaveStar DACS 4/4/1
network element via CIT.

2. Select Provision > SystemID.

3. At theSystemID field, enter the
new network element name.

4. In theFrameID field, enter a value,
for example, 0.

5. Select the Change button. The
network element name has been
changed.

6. Perform a MIB-Upload to ITM-SC
for the renamed WaveStar DACS
network elements.

The renamed network
element is not a WaveStar
DACS 4/4/1,

Perform a MIB download for all
renamed network elements.
It is normal for this download to take
a long period of time to complete.

............................................................................................................................................................

20 Restart the WaveStar NMS GUI and synchronize its database with the
ITM-SC server.
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Section III: INSERTNODE and REMOVENODE tools

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on the INSERTNODE and
REMOVENODE tools which are UNIX scripts that allow users to
insert and remove network elements from WaveStar NMS. These tools
automatically update the WaveStar NMS database.

This tool uses cross-connect and port files when inserting a node;
there is no file needed when removing a node.

Features The INSERTNODE and REMOVENODE tools provide the following
features:

• Updates WaveStar NMS configuration locally. It will not send
any commands to the element management system.

• Digital links can be part of a path-switched ring or a
line-switched ring.

• Supports MSP digital link and Optical Multiplex Section (OMS)
with OMS Protection (OMSP).

• Handles the updates of one-way, two-way, and broadcast
paths/circuits.

• Handles fault management reconciliation in case trails or ports
involved in the procedure are alarmed.

• Supports combo circuits that are handled the same as VC-N
paths.

• Handles path trace parameters, PTI and PT mismatch detection
mode.

• Supports the removal of a black box from a physical link

• Supports inserting a node into a digital link. Supports all types of
digital links (from STM-0 to STM-64).

• Supports inserting a node into an OMS and optical link.

• Supports removing a node from two digital links. All types of
digital links (from STM-0 to STM-64) are supported.

• Supports removing a node from 2 OMS and 2 Optical Layer
(OL).

• Supports black box removal.
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Using the tool The tasks which utilize these tools are located after this description.

Supported network
elements

The INSERTNODE and REMOVENODE tools support the following
network elements:

• Intelligent Synchronous Multiplexers (ISMs) [all Ring Drop
Insert (RDI) models]

• Synchronous Line Multiplexers (SLMs) all models

• WaveStar ADM 155 E

• WaveStar ADM 4/1 STM-1 and WaveStar ADM 4/1

• ADM 4/1 STM 1

• PHASE ADM 4/4

• PHASE ADM 16/4

• LXC 4/1

• LXC 16/1

• WaveStar ADM 16/1 and WaveStar ADM 16/1 Compact

• WaveStar DACS

• WaveStar AM 1

• WaveStar AM 1 Plus

Supported WaveStar SNMS
network elements

The INSERTNODE and REMOVENODE tools support the following
WaveStar SNMS managed network elements:

• WaveStar BandWidth Manager

• WaveStar LambdaRouter

• WaveStar OLS 400G

Supported physical link
types

The tool supports the following physical type links:

For inserting a node:

• Optical Multiplex Section

• Optical Link

For removing a node:

• Optical Multiplex section

• Optical Layer
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Insert an ITM-SC controlled node into a digital link using
INSERTNODE
....................................................................................................................................................................................................................................

Purpose Use this procedure to insert an ITM-SC controlled network element
into a digital link using the INSERTNODE tool. Upon completion, the
task generates a cross connect and port file to update the WaveStar
NMS database.

Before you begin Before you insert an ITM-SC controlled network element into a
digital link, consider the following items.

• Be sure that the network element to be inserted on the database
of the WaveStar NMS is correctly installed on the network and is
already known by WaveStar NMS, that is, it displays on the
WaveStar NMS Network Map. This occurs when all ports are
provisioned and all cross connections are made on the EMS
being managed by WaveStar NMS.

• When inserting a node, the network element has to be
pre-provisioned; all ports are provisioned and cross connected as
needed to provide services.

• This task can be used before or after the fibers are physically
reconnected to insert or remove a node.

• The advantage of using the tool before reconnecting the fibers is
that if the process succeeds, this will ensure that the reconnection
of the fiber will minimize the risk of interrupting any logical
paths carried by the physical layer.

• The EMS will provide a file with port provisioning and cross
connect status. This file should be created just before the tool is
executed. A user will transfer this file to the WaveStar NMS host
and will specify the full path at the beginning of the task.

• If more cross connections than needed is reported by the EMS,
this is not an error. These cross connections will be displayed in
the Uncorrelated cross connect forms after a DBSynch is done by
the user.

• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.
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• The physical link where the node is inserted or removed should
be in the in-effect state. There should not be any scheduled paths
riding on the digital link to be updated.

• There should not be preplan paths associated with any of the
paths carried by the physical link to be updated.

• Performance Monitoring (PM) data collection on the physical
links should be stopped prior to execution of this task. When
inserting a node, PM data collection should be stopped on the
VC-4 substructured paths, terminating on the inserted node. Note
that PM on the path going through the inserted node does not
have to be stopped.

• The regenerators or amplifiers with OMS must be removed from
the digital links before running this tool. After the task is
completed, a user will put back the regenerators/amplifiers on the
new physical links.

• The WaveStar NMS user interface may not reflect the correct
configuration at the run time of the tool. While the tool is in
progress, a user should refrain from modifying/deleting existing
paths that ride on the digital link where the tool is being
executed. It is recommended that the user interface should be
down when the tool is run. If not, a user has to Refresh the
Network Map and any forms that are open.

• There is no time slot or frequency interchange in the cross
connects on the inserted/removed node. Cross connections with
timeslot or frequency interchange will not be reported by the
EMS. SNCP cross connects in the inserted/removed node will
also not be reported by the EMS.

Task Perform the following steps to insert an ITM-SC controlled node
into a digital link using the INSERTNODE tool.
............................................................................................................................................................

1 Log into the ITM-SC host as i2kadmin.

Result:

The ITM-SC host will request a password.

............................................................................................................................................................

2 Enter the ITM-SC password for the i2kadmin login.
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Result:

The user is logged into the ITM-SC host.

............................................................................................................................................................

3 At the prompt, enter

. itmsc_setup

db_ian_wrapper <node_name> <A EID> <Z EID>

Result:

db_ian_wrapper is executed and two files are generated
containing cross connect and tributary information in the
following format:
/home/i2kadmin/db_sc_xc_ddmmyyyy_hhmm
/home/i2kadmin/db_sc_pp_ddmmyyyy_hhmm

............................................................................................................................................................

4 Use ftp or rcp to get these two files to the WaveStar NMS host
/usr/dacscan/data then record the path name on the WaveStar NMS
host.

............................................................................................................................................................

5 Log into the WaveStar NMS host as root.

Result:

A password is requested.

............................................................................................................................................................

6 Enter the password for the root login.

Result:

The user is logged into the into the WaveStar NMS host as
root.

............................................................................................................................................................

7 At the prompt, enter cd /usr/dacscan/data

............................................................................................................................................................

8 At the prompt, enter

chmod 777 db_sc_xc_ddmmyyyy hhmm

chmod 777 db_sc_pp_ddmmyyyy hhmm
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............................................................................................................................................................

9 At the prompt, enter

su - dacscan

cd /usr/dacscan/bin

Result:

The user changes to dacscan and the prompt displays in the
requested directory.

............................................................................................................................................................

10 At the prompt, enter

INSERTNODE

Result:

The INSERTNODE tool is initiated.

............................................................................................................................................................

11 At the CLO/Order Number prompt, enter the value of the digital link
where the new node will be inserted.

............................................................................................................................................................

12 At the Network Element Name prompt, enter the name of the network
element that will be inserted.

............................................................................................................................................................

13 At the PORT ADDRESS to original A prompt, enter the service port
address (in NMS-Port Address-format) that will connect to the original
digital link’s A location.

............................................................................................................................................................

14 At the PORT ADDRESS to original Z prompt, enter the service port
address (in NMS-Port Address-format) that will connect to the original
digital link’s Z location.

............................................................................................................................................................

15 At the Digital Link 1 CKT ID prompt, enter the circuit ID for the
first new digital link.

Result:

This link’s terminations will be the original digital link’s A
location on the <new_node_name>.
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............................................................................................................................................................

16 At the Digital Link 2 CKT ID prompt, enter the circuit ID for the
second new digital link.

Result:

This link’s terminations will be the original digital link’s Z
location on the <new_node_name>.

............................................................................................................................................................

17 At the EMS Port Provision File prompt, enter the full path name
of the EMS port provisioning file.

............................................................................................................................................................

18 At the EMS Cross Connect File prompt, enter the full path name of
the EMS cross connect file.

............................................................................................................................................................

19 At the Is this all correct prompt, enter Y or N then continue with
one of the following options to determine if a CAC/CLO (CCL) data
file should be generated.

..........................................................................................................................................................

20 IF THEN

Do you want to Purge
the CCL Data? displays
when the INSERTNODE
tool is running:

select N(o)
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IF THEN

an older version of Fault
Management (FM) is being
used in WaveStar NMS:

generate a CCL file with the following
steps.

• Log into the WaveStar NMS server
as dacscan, then run the
$/usr/dacscan/toolbin/gen_ins_
ccl.sh tool.

• At the Do you want to Purge
the CCL data? prompt, select
Y(es) to create the
/dacscan/words/sc/db_nm_ccl_
<datemonthyear_hourminute> file.

• ftp the file to the ITM-SC server
as i2kadmin where the network
element is managed and enter the
password.

• Enter the following:
. itmsc_setup
chmod 775 db_nm_ccl_datemonthyear_
hourminute
db_nm_ccl_datemonthyear_
hourminute
During the import of the CCL file,
the ITM-SC application will be
stopped/started, so management
will be temporarily lost of all
network elements managed by this
ITM-SC server.
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Insert a WaveStar SNMS controlled node into a digital link
using INSERTNODE
....................................................................................................................................................................................................................................

Purpose Use this task to insert a WaveStar SNMS controlled network element
into a digital link using the INSERTNODE tool. Upon completion, the
task generates a cross connect and port file to update the WaveStar
NMS database.

Before you begin Before you insert an WaveStar SNMS controlled network element into
a digital link, consider the following items.

• Be sure that the network element to be inserted on the database
of the WaveStar NMS is correctly installed on the network and is
already known by WaveStar NMS, that is, it displays on the
WaveStar NMS Network Map. This occurs when all ports are
provisioned and all cross connections are made on the EMS
being managed by WaveStar NMS.

• When inserting a node, the network element has to be
pre-provisioned; all ports are provisioned and cross connected as
needed to provide services.

• This task can be used before or after the fibers are physically
reconnected to insert or remove a node.

• The advantage of using the tool before reconnecting the fibers is
that if the process succeeds, this will ensure that the reconnection
of the fiber will minimize the risk of interrupting any logical
paths carried by the physical layer.

• The EMS will provide a file with port provisioning and cross
connect status. This file should be created just before the tool is
executed. A user will transfer this file to the WaveStar NMS host
and will specify the full path at the beginning of the task.

• If more cross connections than needed is reported by the EMS,
this is not an error. These cross connections will be displayed in
the Uncorrelated cross connect forms after a DBSynch is done by
the user.

• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.

• The physical link where the node is inserted or removed should
be in the in-effect state. There should not be any scheduled paths
riding on the digital link to be updated.
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• There should not be preplan paths associated with any of the
paths carried by the physical link to be updated.

• Performance Monitoring (PM) data collection on the physical
links should be stopped prior to execution of this task. When
inserting a node, PM data collection should be stopped on the
VC-4 substructured paths, terminating on the inserted node. Note
that PM on the path going through the inserted node does not
have to be stopped.

• The regenerators or amplifiers with OMS must be removed from
the digital links before running this tool. After the task is
completed, a user will put back the regenerators/amplifiers on the
new physical links.

• The WaveStar NMS user interface may not reflect the correct
configuration at the run time of the tool. While the tool is in
progress, a user should refrain from modifying/deleting existing
paths that ride on the digital link where the tool is being
executed. It is recommended that the user interface should be
down when the tool is run. If not, a user has to Refresh the
Network Map and any forms that are open.

• There is no time slot or frequency interchange in the cross
connects on the inserted/removed node. Cross connections with
timeslot or frequency interchange will not be reported by the
EMS. SNCP cross connects in the inserted/removed node will
also not be reported by the EMS.

Task Perform the following steps to insert a WaveStar SNMS
controlled node into a digital link using the INSERTNODE tool.
............................................................................................................................................................

1 Log into WaveStar SNMS as ems.

............................................................................................................................................................

2 At the prompt, enter

cd /ems/bin

<node_path>

Result:

<node_path> is executed and the following two files are
generated:
/tmp/db_snms_xc_ddmmyyyy_hhmm
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/tmp/db_snms_pp_ddmmyyyy_hhmm

............................................................................................................................................................

3 Use ftp or rcp to get these two files to the WaveStar NMS host
/usr/dacscan/data then record the path name on the WaveStar NMS
host.

............................................................................................................................................................

4 Log into the WaveStar NMS host machine as root.

Result:

A password is requested.

............................................................................................................................................................

5 Enter the password for the root login.

Result:

The user is logged into the into the WaveStar NMS host as
root.

............................................................................................................................................................

6 At the prompt, enter cd /usr/dacscan/data

............................................................................................................................................................

7 At the prompt, enter

chmod 777 db_snms_xc_ddmmyyyy hhmm

chmod 777 db_snms_pp_ddmmyyyy hhmm

............................................................................................................................................................

8 Log into the WaveStar NMS host machine as dacscan.

Result:

A password is requested.

............................................................................................................................................................

9 Enter the password for the dacscan login.

Result:

The user is logged into the into the WaveStar NMS host as
dacscan.

............................................................................................................................................................

10 At the prompt, enter
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cd /usr/dacscan/bin

Result:

The prompt displays in the requested directory.

............................................................................................................................................................

11 At the prompt, enter

INSERTNODE

Result:

The INSERTNODE tool is initiated.

............................................................................................................................................................

12 At the CLO/Order Number prompt, enter the value of the digital link
where the new node will be inserted.

............................................................................................................................................................

13 At the Network Element Name prompt, enter the name of the network
element that will be inserted.

............................................................................................................................................................

14 At the PORT ADDRESS to original A prompt, enter the service port
address (in NMS-Port Address-format) that will connect to the original
digital link’s A location.

............................................................................................................................................................

15 At the PORT ADDRESS to original Z prompt, enter the service port
address (in NMS-Port Address-format) that will connect to the original
digital link’s Z location.

............................................................................................................................................................

16 At the Digital Link 1 CKT ID prompt, enter the circuit ID for the
first new digital link.

Result:

This link’s terminations will be the original digital link’s A
location on the <new_node_name>.

............................................................................................................................................................

17 At the Digital Link 2 CKT ID prompt, enter the circuit ID for the
second new digital link.
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Result:

This link’s terminations will be the original digital link’s Z
location on the <new_node_name>.

............................................................................................................................................................

18 At the EMS Port Provision File prompt, enter the full path name
of the EMS port provisioning file.

............................................................................................................................................................

19 At the EMS Cross Connect File prompt, enter the full path name of
the EMS cross connect file.

............................................................................................................................................................

20 At the Is this all correct prompt, enter Y or N.
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Delete an ITM-SC controlled node from a digital link using
REMOVENODE
....................................................................................................................................................................................................................................

Purpose Use this task to remove an ITM-SC controlled network element from
a digital link using the REMOVENODE tool.

Before you begin Before you remove an ITM-SC controlled network element from a
digital link, consider the following items.

• This task can be used before or after the fibers are physically
reconnected to insert or remove a node.

• The advantage of using the tool before reconnecting the fibers is
that if the process succeeds, this will ensure that the reconnection
of the fiber will minimize the risk of interrupting any logical
paths carried by the physical layer.

• The EMS will provide a file with port provisioning and cross
connect status. This file should be created just before the tool is
executed. A user will transfer this file to the WaveStar NMS host
and will specify the full path at the beginning of the task.

• If more cross connections than needed is reported by the EMS,
this is not an error. These cross connections will be displayed in
the Uncorrelated cross connect forms after a DBSynch is done by
the user.

• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.

• The physical link where the node is inserted or removed should
be in the in-effect state. There should not be any scheduled paths
riding on the digital link to be updated.

• There should not be preplan paths associated with any of the
paths carried by the physical link to be updated.

• The regenerators or amplifiers with OMS must be removed from
the digital links before running this tool. After the task is
completed, a user will put back the regenerators/amplifiers on the
new physical links.
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• The WaveStar NMS user interface may not reflect the correct
configuration at the run time of the tool. While the tool is in
progress, a user should refrain from modifying/deleting existing
paths that ride on the digital link where the tool is being
executed. It is recommended that the user interface should be
down when the tool is run. If not, a user has to Refresh the
Network Map and any forms that are open.

• There is no time slot or frequency interchange in the cross
connects on the inserted/removed node. Cross connections with
timeslot or frequency interchange will not be reported by the
EMS. SNCP cross connects in the inserted/removed node will
also not be reported by the EMS.

Task Perform the following steps to remove an ITM-SC controlled
node from a digital link.
............................................................................................................................................................

1 Log into the WaveStar NMS server as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd /usr/dacscan/bin then enter REMOVENODE.

Result:

The tool is initiated and a prompt displays.

............................................................................................................................................................

3 At the Network Element name prompt, enter the name of the
network that will be removed.

............................................................................................................................................................

4 At the first CLO/Order Number prompt, enter the value of the first
digital link from where the node will be removed.

............................................................................................................................................................

5 At the second CLO/Order Number prompt, enter the value of the
second digital link from where the node will be removed.

............................................................................................................................................................

6 Enter the CKT ID (All Fields of the Format) for the new digital link.
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............................................................................................................................................................

7 At the Is this all correct prompt, enter Y or N then continue with
one of the following options to determine if a CAC/CLO (CCL) data
file should be generated.

..........................................................................................................................................................

8 IF THEN

Do you want to Purge
the CCL Data? displays
when the REMOVENODE
tool is running:

select N(o)

an older version of Fault
Management (FM) is being
used in WaveStar NMS:

generate a CCL file with the following
steps.

• Log into the WaveStar NMS server
as dacscan, then run the
$/usr/dacscan/toolbin/gen_rem_
ccl.sh tool.

• At the Do you want to Purge
the CCL data? prompt, select
Y(es) to create the
/dacscan/words/sc/db_nm_ccl_
<datemonthyear_hourminute> file.

• ftp the file to the ITM-SC server
as i2kadmin where the network
element is managed and enter the
password.

• Enter the following:
. itmsc_setup
chmod 775 db_nm_ccl_datemonthyear_
hourminute
db_import_ccl
db_nm_ccl_datemonthyear_
hourminute
db_ian_wrapper
During the import of the CCL file,
the ITM-SC application will be
stopped/started, so management
will be temporarily lost of all
network elements managed by this
ITM-SC server.

Section III: INSERTNODE and
REMOVENODE tools
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digital link using REMOVENODE

Off-line tool concepts

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 8 - 3 9

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Delete a WaveStar SNMS controlled node from a digital link
using REMOVENODE
....................................................................................................................................................................................................................................

Purpose Use this task to remove a WaveStar SNMS controlled network
element from a digital link using the REMOVENODE tool.

Before you begin Before you remove a WaveStar SNMS network element from a digital
link, consider the following items.

• This task can be used before or after the fibers are physically
reconnected to insert or remove a node.

• The advantage of using the tool before reconnecting the fibers is
that if the process succeeds, this will ensure that the reconnection
of the fiber will minimize the risk of interrupting any logical
paths carried by the physical layer.

• The EMS will provide a file with port provisioning and cross
connect status. This file should be created just before the tool is
executed. A user will transfer this file to the WaveStar NMS host
and will specify the full path at the beginning of the task.

• If more cross connections than needed is reported by the EMS,
this is not an error. These cross connections will be displayed in
the Uncorrelated cross connect forms after a DBSynch is done by
the user.

• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.

• The physical link where the node is inserted or removed should
be in the in-effect state. There should not be any scheduled paths
riding on the digital link to be updated.

• There should not be preplan paths associated with any of the
paths carried by the physical link to be updated.

• The regenerators or amplifiers with OMS must be removed from
the digital links before running this tool. After the task is
completed, a user will put back the regenerators/amplifiers on the
new physical links.

Section III: INSERTNODE and
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• The WaveStar NMS user interface may not reflect the correct
configuration at the run time of the tool. While the tool is in
progress, a user should refrain from modifying/deleting existing
paths that ride on the digital link where the tool is being
executed. It is recommended that the user interface should be
down when the tool is run. If not, a user has to Refresh the
Network Map and any forms that are open.

• There is no time slot or frequency interchange in the cross
connects on the inserted/removed node. Cross connections with
timeslot or frequency interchange will not be reported by the
EMS. SNCP cross connects in the inserted/removed node will
also not be reported by the EMS.

Task Perform the following steps to remove an WaveStar SNMS
controlled node from a digital link.
............................................................................................................................................................

1 Log into the WaveStar NMS server as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd /usr/dacscan/bin then enter REMOVENODE.

Result:

The tool is initiated and a prompt displays.

............................................................................................................................................................

3 At the Network Element name prompt, enter the name of the
network element that will be removed.

............................................................................................................................................................

4 At the first CLO/Order Number prompt, enter the value of the first
digital link from where the node will be removed.

............................................................................................................................................................

5 At the second CLO/Order Number prompt, enter the value of the
second digital link from where the node will be removed.

............................................................................................................................................................

6 Enter the CKT ID (All Fields of the Format) for the new digital link.

............................................................................................................................................................

7 At the Is this all correct prompt, enter Y or N.
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REMOVENODE tools
Delete a WaveStar SNMS controlled node
from a digital link using REMOVENODE

Off-line tool concepts

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 8 - 4 1

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section IV: Network element reparenting tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the reparenting process, which involves moving
network elements from one EMS to another EMS or transferring EMS
resources from one WaveStar NMS to another WaveStar NMS.

Reparenting Tool This tool supports Network Element Reparenting, which is
reparenting network elements between two ITM-SCs or two WaveStar
SNMSs and WaveStar NMS Reparenting, or transferring EMS
resources from one WaveStar NMS to another WaveStar NMS. Both
processes are covered in the following tasks.

Contents
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Reparenting WaveStar SNMS controlled network
elements

8-45
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another WaveStar NMS

8-48
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Reparenting ITM-SC controlled Network Elements
....................................................................................................................................................................................................................................

Purpose This section describes how to reparent ITM-SC controlled network
elements.

Before you begin Before you use this tool, be sure that:

• No provisioning or software download or upload activities are
occurring to the network elements involved in the reparenting
process.

• There are no pending circuits connected to target network
element(s).

• Network element alarms are cleared from the ITM-SC.

Task Complete the following steps to run the reparenting tool.
............................................................................................................................................................

1 To verify that there are no pending circuits, at the Network Map,
select the target network element.

Result:

A menu displays.

............................................................................................................................................................

2 From the displayed menu, select NE Port Assignments.

Result:

The NE Assignments Query box form displays.

............................................................................................................................................................

3 Click the More button, then under Order Status, select Pending.

Result:

If pending circuits exist, a list displays.

..........................................................................................................................................................

4 IF THEN

pending circuits display, end this task.

pending circuits do not
display,

continue with the next step.

Section IV: Network element reparenting
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............................................................................................................................................................

5 After receiving a notification from ITM-SC that network elements
have been deleted from an old ITM-SC as a result of an ITM-SC
export tool run, login to the server as dacscan then enter cd
/usr/dacscan/toolbin.

............................................................................................................................................................

6 At the command line, type and include the location of the input file
containing information on each target network element and old and
new ITM-SC information.

Result:

The old ITM-SC data related to the target network elements is
changed to the new ITM-SC data in WaveStar NMS.

............................................................................................................................................................

7 Before performing this step, be sure that:

• the online ITM-SC import tool is run to add target network
elements to the new ITM-SC.

• a message is sent from ITM-SC to notify WaveStar NMS that the
network elements have been created.

• alarms are sent to WaveStar NMS.

In WaveStar NMS, clear alarms associated with this process. Refer to
the WaveStar NMS Maintenance Guide for details.

Section IV: Network element reparenting
tool
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Reparenting WaveStar SNMS controlled network elements
....................................................................................................................................................................................................................................

Purpose This section describes how to reparent WaveStar SNMS controlled
network elements.

Before you begin Before you use this tool, be sure that:

• no provisioning or software download or upload activities are
occurring to the network elements involved in the reparenting
process.

• there are no pending circuits connected to target network
element(s).

Task Complete the following steps to run the reparenting tool:
............................................................................................................................................................

1 Log into the old WaveStar SNMS as ems.

............................................................................................................................................................

2 At the prompt, enter NEReparentSource <network_element_TID>.

Important! <network_element_TID> represents the TID of the
network element being reparented.

Result:

A tmp_<network_element_TID>.data file is created in
$TMFA_DATA_DIR.

............................................................................................................................................................

3 Repeat Step 2 for each network element to be reparented.

............................................................................................................................................................

4 Using the old WaveStar SNMS GUI, delete the network element(s).
See the Delete a Network Element task in the WaveStar SubNetwork
Management System (SNMS) Provisioning Guide for details.

Result:

Each network element(s) is deleted.

............................................................................................................................................................

5 Using ftp, send each tmp_<network_element_TID>.data file from
the old WaveStar SNMS to the new WaveStar SNMS.

Important! Be sure to retain the files in $TMFA_DATA_DIR.

Section IV: Network element reparenting
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............................................................................................................................................................

6 Physically move the network element connections from the old
WaveStar SNMS to the new WaveStar SNMS.

............................................................................................................................................................

7 Log into the new WaveStar SNMS as ems.

............................................................................................................................................................

8 On the new WaveStar SNMS, use the WaveStar SNMS GUI to add
the network element(s) and then wait for the Dynamic Network
Operation (DNO) to complete before proceeding to the next step. See
the Add a Network Element tasks in the WaveStar SubNetwork
Management System (SNMS) Provisioning Guide for details.

Result:

The network elements are added.

............................................................................................................................................................

9 At the prompt, enter NEReparentTarget <network_element_TID>
for each network element that needs to be reparented.

Result:

A ne_snc_ids.dat file is created in $TMFA_DATA_DIR.

Note that only one ne_snc_ids.dat file is created, no matter how may
network elements are involved.

............................................................................................................................................................

10 Using ftp, send the ne_snc_ids.dat file from the new WaveStar
SNMS to the WaveStar NMS host under the /tmp/reparent directory.

Result:

The ne_snc_ids.dat file is sent to the WaveStar NMS host.

............................................................................................................................................................

11 On the WaveStar NMS host in the /tmp/reparent directory, create a
one-line, ems_map.dat file in
<OLD_SNMS_NAME>|<NEW_SNMS_NAME> format.

Important! Note that the WaveStar SNMS names must be all caps as
they appear on the Nework Controller Map and separated by the |
character, for example: TUNA|SHARK.

Section IV: Network element reparenting
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............................................................................................................................................................

12 Login to the WaveStar NMS server as dacscan, then enter cd
/usr/dacscan/toolbin/reparent.

Result:

The user logs into the WaveStar NMS server and the prompt
displays in the requested directory.

............................................................................................................................................................

13 At the prompt, enter

./reparent.ksh SNMS

Result:

The reparenting tool is initiated.

............................................................................................................................................................

14 From the WaveStar NMS Controller Map, synchronize both of the
WaveStar SNMSs. See “Synchronize the WaveStar NMS database
with a WaveStar SNMS database” (9-13).
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Reparenting WaveStar NMS EMS resources to another WaveStar
NMS
....................................................................................................................................................................................................................................

Purpose This section describes how to reparent WaveStar NMS EMS resources
to another WaveStar NMS (that is, one EMS at a time) using the
reparenting tool.

Before you begin Before you use this tool, be sure that:

• the WaveStar NMSs involved in this process are not connected to
any other northbound system.

• the ID of the EMS to be moved is unique.

• the target network elements are not involved in an ITM-SC
geographic redundancy switch.

• the EMS is not involved in an ITM-SC geographic redundancy.

Task Complete the following steps to run the tool:
............................................................................................................................................................

1 IF THEN

there are circuits/digital
links that are connected
beyond the EMS domain,

disconnect them then proceed to the
next step.

there are not
circuits/digital links that
are connected beyond the
EMS domain,

proceed to the next step.

............................................................................................................................................................

2 Login to the server as dacscan then enter cd /usr/dacscan/toolbin.

............................................................................................................................................................

3 Run the export data tool to extract data from the current WaveStar
NMS to datafiles.

Result:

Data is stored to datafiles.

............................................................................................................................................................

4 Disconnect the old EMS (for example, ITM-SC) and its managed
network elements from the old WaveStar NMS, then re-add the EMS
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and its managed network elements to the target WaveStar NMS (see
“Add a new ITM-SC” (9-4)).

............................................................................................................................................................

5 Run the import data tool.

Result:

Data is imported to the target WaveStar NMS.

............................................................................................................................................................

6 “Virtual disconnect tool task” (8-74).

Result:

This cleans up circuit provisioning information that was stored
in the old WaveStar NMS and is now successfully transferred to
the target WaveStar NMS.

............................................................................................................................................................

7 Run the clean up tool.

Result:

This cleans up all remaining data that was stored in the old
WaveStar NMS and is now successfully transferred to the target
WaveStar NMS.

............................................................................................................................................................

8 Perform a database synchronization with the new WaveStar NMS and
ITM-SC.

Result:

This is performed to ensure that data is consistent between the
new WaveStar NMS and ITM-SC.

Section IV: Network element reparenting
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Section V: Upgrade WaveStar OLS 400G to WaveStar OLS
800G

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to upgrade WaveStar OLS 400G network
elements to WaveStar OLS 800G network elements to add more
circuit packs and increase their capacity. The script changes most
network elements having a release level lower than R5.0 to R5.0 with
the exception of WaveStar OLS 400G R4.0 network elements, which
cannot be upgraded.

Note that WaveStar OLS 400G R6.0 network elements will also not
change to R5.0 as a result of this script.

Contents
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Upgrade WaveStar OLS 400G to WaveStar OLS 800G
....................................................................................................................................................................................................................................

Purpose This task describes how to increase the capacity of an WaveStar OLS
400G network element by upgrading it to WaveStar OLS 800G.

Before you begin Before you begin this upgrade, be sure that:

• the database has been backed up

• no provisioning activities involving the target WaveStar OLS
400G network element(s) occur during the upgrade process.

• the upgrade is complete in WaveStar SNMS which may be
detected by WaveStar NMS after receiving a second State
Change alarm from WaveStar SNMS.

Task Complete the following steps to run the upgrade tool.
............................................................................................................................................................

1 After receiving an alarm notification from WaveStar SNMS that the
upgrade is complete, back up the WaveStar NMS database. See
“Section I: Perform backups” (7-3).

............................................................................................................................................................

2 Log into the server as dacscan then enter cd /usr/dacscan/toolbin.

............................................................................................................................................................

3 Open the log files then enter <network_element_identifier(s)> to run
the script.

Result:

The script either reads the entered TID(s) or a file containing a
list of WaveStar OLS 400G TIDs to be upgraded to WaveStar
OLS 800G. The script accepts entries for multiple network
elements residing under the same WaveStar SNMS however the
script must be run separately when network elements reside
under different WaveStar SNMSs.

............................................................................................................................................................

4 Once the run is complete, select View > Network View Reset to
refresh the GUI and display the upgraded network elements.

Section V: Upgrade WaveStar OLS 400G to
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............................................................................................................................................................

5 Synchronize WaveStar NMS with WaveStar SNMS. See “Synchronize
the WaveStar NMS database with a WaveStar SNMS database” (9-13)
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Section VI: Upgrade WaveStar OLS 400G’s network element’s
from CMISE mode to TL1 mode

Overview
....................................................................................................................................................................................................................................

Purpose WaveStar OLS 400G R6.0 network elements use a TL1 mode
protocol. Earlier WaveStar OLS 400G network elements used the
Common Management Information Service Element (CMISE) mode
protocol.

When WaveStar OLS 400G network elements need to be upgraded
from an earlier release to R6.0, a script is run in WaveStar NMS.

Before running the script, the WaveStar OLS 400G network
element(s) must first be upgraded to R6.0 in WaveStar SNMS. Note
that WaveStar OLS 400G R4.0 network elements cannot be upgraded
to R6.0.
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Use the CMISE to TL1 upgrade tool for WaveStar OLS 400G
....................................................................................................................................................................................................................................

Purpose This task describes how to upgrade WaveStar OLS 400G network
elements (R6.0 and beyond) in WaveStar NMS.

Before you begin Before you use this tool, be sure that:

• the WaveStar NMS database has been backed up.

• no provisioning activities involving the target WaveStar OLS
400G network element(s) occur during the upgrade process.

• the Network Event Summary form has displayed a network
element software upgrade event to indicate that WaveStar OLS
400G network element(s) have been upgraded from CMISE mode
to TL1 mode in WaveStar SNMS. See the “In Service Upgrade
of WaveStar OLS 400G Software from Release 5.0 to Release
6.0 TL1 Mode” task in the WaveStar SubNetwork Management
System (SNMS) Provisioning Guide.

Task Complete the following steps to run the upgrade tool:
............................................................................................................................................................

1 After the Network Event Summary form displays a network element
software upgrade event , backup the WaveStar NMS database. See
“Section I: Perform backups” (7-3).

............................................................................................................................................................

2 Log into the server as dacscan then enter cd /usr/dacscan/toolbin.

............................................................................................................................................................

3 Open the log files then enter <network_element_identifier(s)> to run
the script.

Result:

The script either reads the entered TID(s) or a file containing a
list of WaveStar OLS 400G TIDs then upgrades the node type
from CMISE to TL1.

Note that the script accepts entries for multiple network
elements residing under the same WaveStar SNMS however the
script must be run separately when network elements reside
under different WaveStar SNMSs.
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............................................................................................................................................................

4 Once the run is complete, synchronize WaveStar NMS with WaveStar
SNMS. See “Synchronize the WaveStar NMS database with a
WaveStar SNMS database” (9-13)
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Section VII: Connection renaming tool

Overview
....................................................................................................................................................................................................................................

Purpose The Connection renaming tool is a UNIX script used to:

• Rename a large number of network connections using a list of
trail/circuit identifications (connection identifications) as input.

• Rename discovered network connections with a given naming
rule after a path discovery procedure

Usable independently of the Auto-Discovery tool, the Connection
Renaming tool takes a user-provided input file, containing every trail
identification as a parameter, and retrieves the connections to which
the end ports belong and renames them with the trail identification.
The tool only renames the connections defined in the input file. If the
file provides at least one end port of a connection, the tool will
rename the related connection.

The tool is applicable to any in-effect SDH and PDH connection
provisioned in WaveStar NMS.

Using the tool The tasks which utilize this tool are contained after this description.

Restrictions The following restrictions apply to the Connection Renaming tool:

• Not applicable to new network objects introduced with the
optical layer.

• Only applicable if the free format option for the trail/circuit ID is
set.

• Local to WaveStar NMS. No commands will be sent to the
network elements level.

• Users must provide a file containing the end ports of the
connections they wish to rename.

• The trail identifications provided in the input file must be unique
in WaveStar NMS.

• There is no consistency check when a file provides a
connection’s two end ports. If a user provides two different trail
ids for the two end ports, then the tool will rename the
connection with one of the two trail IDs without error.
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• Several instances of the tool cannot be run simultaneously.

• Users must refresh screens to reflect new connection
identifications.

• Recommended that users only operate the tool while the
WaveStar NMS host is running.

Log files When the Connection Renaming tool successfully renames a
connection, it logs the renamed connection to
/tmp/auto_disc/rename_ckts. The file format is structured so each
record is a line. Each line consists of:

old_trail_id:new_trail_id

Error Log

The tool logs errors to /tmp/err_rename.log. Errors are logged to a
file for the following reasons:

• The data validation fails.

• The trail ID is not unique in WaveStar NMS.

• The input file’s port does not have any related connection

There is no error if the trail identification in the user input file is the
same as the current trail identification in the database.

Supported interfaces The Connection renaming tool supports the following interfaces:
ITM-SC, ITM-XM, and WaveStar SNMS.

Contents
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Rename network connections with the connection renaming tool
....................................................................................................................................................................................................................................

Purpose Use this task to rename network connections using the connection
renaming tool.

The connection renaming tool is a UNIX script that is used to rename
large numbers of network connections using a list of connection or
trail identifications as input.

Before you begin Before using the connection renaming tool, consider the following
items:

• You must run the connection renaming tool while WaveStar is
running.

• Although not recommended, it is possible to continue operation
procedures through the WaveStar NMS interface while the tool is
running.

Task Use the following procedure to rename network connections
using the Connection Renaming tool.
............................................................................................................................................................

1 Log in as dacscan.

............................................................................................................................................................

2 Specify and confirm the port input file location. By default, the file is
located at /tmp/userinput.port.

Important! The port input file is a text file consisting of a record set,
with each record consisting of one line. Each line consists of a set of
fields separated by | and populated as follows:

• Field 1: Trail ID of the network element.

• Field 2: Port address, using the EMS format.

• Field 3: rate.

• Field 4: Trail ID.

Result:

The connection renaming tool uses the port input file to specify
the trail ID of the connections to be renamed. The tool will, for
each record of the input file, identify the IE connection and
rename the Trail ID with the specified ID. It will then update
the tail ID within the WaveStar NMS database.
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............................................................................................................................................................

3 Verify the renamed connection at /tmp/auto_disc/rename_ckts.

Result:

The renamed connections should appear. Note that each record
consists of old_trail_id:new_trail:id.

Section VII: Connection renaming tool
Rename network connections with the
connection renaming tool

Off-line tool concepts

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 8 - 5 9

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section VIII: Bulk circuit provisioning tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the bulk circuit provisioning tool.
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Bulk circuit provisioning tool task
....................................................................................................................................................................................................................................

Purpose This task describes how to use the bulk circuit provisioning tool.

Before you begin Before you run the bulk circuit provisioning tool, be sure to create a
VC-12 from the Network Map.

Task Complete the following steps to run the bulk circuit provisioning
tool.
............................................................................................................................................................

1 Using the Network Map, create a VC-12 and optionally create a
CEPT-1 on the VC-12. See the Add a Circuit tasks in the WaveStar
NMS Provisioning Guide.

............................................................................................................................................................

2 Log into the server as dacscan then enter cd /usr/dacscan/toolbin.

............................................................................................................................................................

3 In the /usr/dacscan/toolbin directory, create a data_file file.

............................................................................................................................................................

4 Add the following information to data_file, then save and close the
file.

• Circuit ID <CKT_ID> of the created VC-12 circuit, e.g., HTN1
HTN2 VC12S.2000.

• Total number of VC-12 circuits to be created during the bulk
provisioning, e.g., 2

• External port address of the VC-12 at the A_location

• External port address of the VC-12 at the Z_location

• A to Z Path Trace ID (transmitting).

• Z to A Path Trace ID (receiving).

• Y(es) or N(o) value to specify if a CEPT-1 should be created over
the VC-12.

• Y(es) or N(o) value to specify if alarms should be ignored during
the bulk provisioning.

For example, data_file’s contents may appear as follows:

HTN1 HTN2 VC12S.2000|2
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S1/1/2/1/1-3|S1/1/2/1/1-3|0|0|N|Y

S1/1/4/1/1-3|S1/1/4/1/1-3|0|0|N|Y

The first line represents the circuit ID followed by the total number of
circuits to be created. The second and third lines contain the a frame,
z frame, A to Z and Z to A path trace IDs, and the assign CEPT-1 and
ignore alarm values.

............................................................................................................................................................

5 In the /usr/dacscan/toolbin directory, create and save an index file
that contains the directory path of the data_file, e.g.,
/usr/dacscan/toolbin/data_file.

............................................................................................................................................................

6 At the prompt, enter /usr/dacscan/toolbin/group_prov
<indexfilename> -p

Result:

A prompt displays requesting a proxy host.

If you are not prompted to enter the proxy host, none of the
VC-12s will be added and an error message displays indicating
that there are other proxyproc processes on the system.

............................................................................................................................................................

7 At the prompt, enter the proxy host.

Result:

The script continues to run.
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Section IX: Bulk link provisioning tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the bulk link provisioning tool, which is used
to perform a bulk transfer of topological links from provisioning
systems, such as the Physical Resource Manager, to WaveStar NMS.
This off-line tool abstracts the topological links into a bulk process
then performs a bulk add of the links to WaveStar NMS as if they
were added individually through the WaveStar NMS GUI.

About this tool Before running this tool, an input file is created which contains one
line per WaveStar NMS link to be provisioned. The created file is
entered in the bulk link provisioning tool command and run with one
of the following options:

• -v, which performs a pre-provisioning run to validate the input
file without provisioning links. Depending on the results of the
validation, users may edit the input file and rerun this command
until the results predict that a clean run will occur.

• -p, which runs the bulk link provisioning command.

• -a, which takes the latest provisioning run and audits the
WaveStar NMS database against the input file.
When a link is detected in this run that is not In-Effect, this is
noted in the error file, link_audit.log which lists each suspect
input line along with one audit error message per error.
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Bulk link provisioning tool task
....................................................................................................................................................................................................................................

Purpose This section describes how to perform bulk link provisioning in
WaveStar NMS.

Before you begin Consider the following before running the bulk link provisioning tool.

Important! This tool is expected to be run during off-hours to avoid
the impact that the process may have on system response.

Task Complete the following steps to run the bulk link provisioning
tool:
............................................................................................................................................................

1 Log into the server as dacscan then enter cd /usr/dacscan/toolbin.

............................................................................................................................................................

2 In the /usr/dacscan/toolbin directory, create an input file.

............................................................................................................................................................

3 In the input file, add one row of the following data, separated by the |
character for each WaveStar NMS link to be provisioned.

• The full ’A’ network element identifier <aloc>.

• The full ’Z’ network element identifier <zloc>.

• The network element-level port address of the service link at the
A location.

• The network element-level port address of the service link at the
Z location.

• The coded rate of the link <link_type>.

• The free-format label for the circuit ID field <link_ID>.

• The coded Multiplex Section Protection (MSP) configuration.
Values are 1X1MSP, 1+MSP or none.

• The free-format label denoting the protecting link or none.

• The network element-level port address of the protecting link at
A_location or none.

• The network element-level port address of the protecting link at
Z_location or none.
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• The MSP protection group name for 1X1MSP or none.

• The type of MSP configuration: UNI, BI, NTT or none.

Note that if the row is being created for MSP links, the protecting
link and service link fields must be consistent for the sequential array
of fields. The row must also have the same A network element ID and
Z network element ID while conforming to the correct MSP port
groupings at either end. The protecting link and service link must also
have the same link ID.

............................................................................................................................................................

4 Save and close the file, then select one of the following options from
the next step.

..........................................................................................................................................................

5 IF THEN

You want to validate data
in the input file without
provisioning links,

enter linkgroup_prov NM_links -v

Result:

All records in the data file are
validated and error messages are
logged to a file.

You want to provision a
group of In-Effect links,

enter linkgroup_prov NM_links -p

Result:

A group of links are provisioned.

You want to take the latest
provisioning run and audit
the WaveStar NMS
database against the input
file,

enter linkgroup_prov NM_links -a

Result:

The run is audited and any
non-In-Effect links are noted in the
link_audit.log error file.
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Section X: Network element tools

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tools for adding a network element to or
deleting a network element from an established ring or for configuring
a network element for a network using an X.25 protocol.

Contents
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Delete a network element from a ring 8-70
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Add a new network element to an established ring
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a new network element to an established
ring. You will use the WaveStar NMS ADDNODE utility to complete
this task.

Before you begin Before you add a new network element to an established ring, ensure
the following items are completed:

1. Perform a database backup.

2. Determine whether the SCMNODE server is running by
performing the following task:

............................................................................................................................................................

1 Login to dacscan.

............................................................................................................................................................

2 Enter: ps -eaf | grep ’SCMNODE’ <CR>

..........................................................................................................................................................

3 IF THEN

The output is one line. The server is not running. Perform a
tmboot (see below).

The output is more than
one line.

The server is running.
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• If the SCMNODE server is not running, perform the following
task:

............................................................................................................................................................

1 Login to dacscan.

............................................................................................................................................................

2 Change the present working directory to: /usr/dacscan/bin <CR>

............................................................................................................................................................

3 Enter: tmboot -s SCMNODE <CR>

Result:

The SCMNODE server should begin running.

1. Delete the following files from the /dacscan/trace directory:

• addnode_ntfy.txt

• addnode_lkup.txt

• addnode_ctrl.txt

Task Complete the following task to add a new network element to an
established ring.
............................................................................................................................................................

1 At a UNIX prompt, change to the following directory:
/usr/dacscan/bin

............................................................................................................................................................

2 Enter the following command:. /ADDNODE <CR>

Result:

The ADDNODE executable is invoked.

............................................................................................................................................................

3 Enter the Order No (CLO) of the digital link that connects the two
end network elements between which the new network element will
be added.

............................................................................................................................................................

4 Enter the new network element’s name.
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............................................................................................................................................................

5 Enter the left side of the Port/Frame address of the new network
element that is being connected to the A end of the digital link.

Result:

All the unprotected VC-4 and VC-12 links are displayed.

............................................................................................................................................................

6 Enter Y.

............................................................................................................................................................

7 Specify the PPC options of all the VC-4 paths on the digital link that
is being connected between the two existing network elements.

Important! You have a choice of selecting the DROP_PPC option for
only two VC-4s. The remaining VC-4s have to be BYPASS_PPC.

............................................................................................................................................................

8 Enter 1 for BYPASS_PPC OR enter 2 for DROP_PPC.

............................................................................................................................................................

9 At the final confirmation, enter Y.

Result:

The SCMNODE server is invoked to add the new network
element to the ring.
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Delete a network element from a ring
....................................................................................................................................................................................................................................

Purpose Use this procedure to use the system’s DELETENODE utility to
delete a network element from a ring.

Before you begin Refer to the “Add a new network element to an established ring”
procedure for important information to consider before attempting to
delete a network element from a ring.

Task Complete the following task to delete a node from an established
ring.
............................................................................................................................................................

1 At a UNIX prompt, change to the following directory:/usr/dacscan/
bin

............................................................................................................................................................

2 Enter the following command: ./DELETENODE <CR>.

Result:

The DELETENODE executable is invoked.

............................................................................................................................................................

3 Enter the name of the node which is being deleted.

Result:

The system displays all unprotected VC-4s and VC-12s.The
system waits for your confirmation to proceed.

............................................................................................................................................................

4 Enter Y.

Result:

When you enter Y, the SMNODE server is invoked and the node
is deleted from the ring.The Network Map displays the ring
without the deleted node.
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Configure a network element for an X.25 network
....................................................................................................................................................................................................................................

Purpose Use this procedure to configure network elements that use the X.25
protocol.

Important! This procedure is only for networks containing a DACS
VI network element.

Task Perform the following steps to configure a network element for
an X.25 network.
............................................................................................................................................................

1 Set up the X.25 configuration by executing the following command at
the root command prompt (#): /etc/osiadmin <CR>.

Result:

The OSI Administration main menu appears.

............................................................................................................................................................

2 Set up the parameters for CONS over X.25 by performing the
following steps:

1. From the OSI Administration main menu, select OTS.

2. From the OTS menu, select Configure OTS.

3. Select Set Configuration Mode.

4. From the Subnetwork Configuration menu, select Subnetworks:
Configure.

5. Select CONS over X.25: Add.

6. Enter the specified parameters for:

• Subnetwork name

• Local network address (NSAP)

• Subaddress

• X.25 Programmatic access name

7. Return to the OSI Administration main menu.

............................................................................................................................................................

3 Set up the parameters for Destination System by performing the
following steps:

1. From the OSI Administration main menu, select OTS.

2. From the OTS main menu, select Configure OTS.
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3. Select Set Configuration Mode.

4. Select Destination System > Add.

5. Enter the specified parameters for:

• Network address

• Physical address (IEEE MAC or X.121) for the WaveStar
NMS host

• Outgoing subnetwork name

• End system, intermediate system, or both

• Request reverse charge

6. Repeat the previous two steps to add connections for other
network elements.

7. Return to the OSI Administration main menu.

............................................................................................................................................................

4 Set up the parameters for Transport Parameters over CONS with the
following steps:

1. From the OSI Administration main menu, select OTS.

2. From the OTS main menu, select Configure OTS.

3. Select Set Configuration Mode.

4. From Layers, selectTransport Layer Parameter over CONS.

5. Enter the specified parameters for:

• Maximum TPDU size (octets): 128

• Window size (TPDUs): 7

• Force Transport class: 0

• Preferred multiplexing class (2 or 4): 2

• Class 2 flow control? (y/n): y

• Multiplex network connections? (y/n): y

• Maximum inbound multiplexed connections: 10

• Maximum outbound multiplexed connections: 5Essential

6. Return to the OSI Administration main menu.

Result:

The network element is configured for an X.25 network.
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Section XI: Virtual disconnect tool

Overview
....................................................................................................................................................................................................................................

Purpose This section contains the Virtual disconnect tool task.

Contents
Virtual disconnect tool task 8-74

Off-line tool concepts

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 8 - 7 3



Virtual disconnect tool task
....................................................................................................................................................................................................................................

Purpose Run this tool (also referred to as the “paper disconnect”) when there
is a need to virtually disconnect circuits. This function may also be
performed through the Graphical Layouts form available from the
Configuration menu on the Network Map. (Refer to theWaveStar
NMS Provisioning Guide for details.)

Prerequisites Be sure to have a list of each circuit name to be virtually
disconnected. You must also have access to the following files:

• /usr/dacscan/data/discord.fmt

• /usr/dacscan/data/disc_order

• /usr/dacscan/toolbin/deleteorder

• /usr/dacscan/toolbin/get_disc.sh

• /usr/dacscan/toolbin/ug

Files can be transmitted electronically or are also available in a tape
and can be loaded via the patch.install program. The patch.install
program automatically sets the correct permissions and ownership and
installs the files into the corresponding directories. If the files are
transmitted electronically, the permissions need to be modified to 755
(-rwxr-xr-x), the ownership needs to be modified to dacscan dba and
the files need to be installed in directories.

Important! Circuits will not be disconnected if it has a pending order
on the stack or if it has lower order facilities riding on it.

Task Perform the steps below to run the disconnect circuit script.
............................................................................................................................................................

1 Log into the machine as dacscan.

............................................................................................................................................................

2 At the prompt, type cd /usr/dacscan/data.

Result:

You are changed to the /data directory.

............................................................................................................................................................

3 Create a file named disc_ckt, and add the name of each circuit to be
disconnected.
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............................................................................................................................................................

4 At the prompt, type ksh /usr/dacscan/data/disc_order.sh.

Result:

Circuits that can be disconnected are saved in the
/usr/dacscan/data/disc_input file. Circuits that could not be
disconnected are listed in the tmp/disc_order.err file.
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9 EMS management

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes tasks performed to interact with subsystems in
the network.

Contents
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Section I: Interact with ITM-SCs

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the administration of ITM-SCs.

Definition: ITM-SC An ITM-SC is an application that provides services to the network
management system to enable it to set up end-to-end paths and to
monitor overall network behavior.
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Add a new ITM-SC
....................................................................................................................................................................................................................................

Purpose Use this task to create a new ITM-SC on the WaveStar NMS.

Important! This task must be run for each ITM-SC to be added. The
number of ITM-SCs that may be added varies with the WaveStar
NMS configuration installed. The limit for ITM-SC is 20 subnetwork
controllers. When the limit is reached, an error message is displayed
after the last step of the procedure to inform the user that the EMS
could not be added because it exceeded the number allowed.

Before you begin Before you begin this task, collect the following information:

• system name for the ITM-SC to be added

• IP address for the ITM-SC to be added

Task Perform the steps below to add a new ITM-SC.
............................................................................................................................................................

1 Log in as root to the WaveStar NMS host.

............................................................................................................................................................

2 At the prompt, enter ksh /usr/dacscan/bin/add.controller and
press Enter.

Result:

The following prompt is displayed:

Which Controller do you want to add?

............................................................................................................................................................

3 At the prompt, enter 8 and press Enter.

Result:

The following prompt is displayed:

What is the name of the ITM-SC?

............................................................................................................................................................

4 Enter the name of the ITM-SC then press Enter.

Result:

You are prompted to confirm your entry.
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............................................................................................................................................................

5 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the ITM-SC.

............................................................................................................................................................

6 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the Acronym.

............................................................................................................................................................

8 Enter the acronym using all CAPS. Note that this entry is a unique
identifier, which should not be more than four characters long.
Generally, the first four characters of the ITM-SC hostname are used.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

9 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

The user, i2kadmin is created and you are prompted to enter a
new password for the new user ID.

............................................................................................................................................................

10 At the prompt, enter a password and then re-enter the same password
to continue.

Result:

The original activity screen displays.
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............................................................................................................................................................

11 Continue with one of the following steps.

• If you have have additional ITM-SCs to add, for example, if a
geographic redundancy configuration is in place, repeat Step 3
through Step 10 to continue.

• If you do not have additional ITM-SCs to add, proceed to the
next step.

............................................................................................................................................................

12 Enter quit to exit the script then continue with one of the following
steps.

• If you are using an HP machine, open an hpterm window and
type vi /etc/hosts.

• If you are using a Windows machine, use an editor to access the
..\etc\Hosts file.

............................................................................................................................................................

13 Add the host name and the IP address of the new EMS to the hosts
or Hostsfile (if the hostname and IP address are not already present)
then save the file.

............................................................................................................................................................

14 If a second ITM-SC host is applicable, for example if geographic
redundancy configuration is in place, repeat Step 13, otherwise
proceed to the next step.

............................................................................................................................................................

15 Using the system console, log in to the new EMS as root.

............................................................................................................................................................

16 Enter /opt/itm/sc/toolbox/bin/itmsc_set_itmnm_name to
configure the EMS to communicate with WaveStar NMS.

Result:

The new ITM-SC is added.
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Synchronize the WaveStar NMS database with an ITM-SC
database
....................................................................................................................................................................................................................................

Purpose Use this procedure to synchronize the WaveStar NMS database with
an ITM-SC database.

Task Complete the following task to synchronize the WaveStar NMS
database with an ITM-SC database.
............................................................................................................................................................

1 Access the Network Controller map.

............................................................................................................................................................

2 On the Network Controller map, right-click the desired ITM-SC node.

............................................................................................................................................................

3 Select Session > Start EMS Synchronization.

Result:

The Database Synchronization form is displayed. The EMS ID
field is pre-populated with the name of the EMS.

............................................................................................................................................................

4 From the Type menu, select one of the following node types:

• Alarm

• NE

• All

............................................................................................................................................................

5 Select OK.

Result:

A confirmation form appears.

............................................................................................................................................................

6 Select Yes.

Result:

The Database Synchronization Status form appears.

............................................................................................................................................................

7 Wait for the synchronization to complete.
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............................................................................................................................................................

8 Select Close.

Result:

The WaveStar NMS database is synchronized with the ITM-SC
database.
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Section II: Interact with WaveStar SNMSs

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the administration of WaveStar SNMSs.

Definition: WaveStar SNMS WaveStar SNMS is a management system for the WaveStar product
family, providing Element Management Layer (EML) management
functions for WaveStar products. This system has configuration
management, fault management, performance management, and
security management functions.

Contents
Add a new WaveStar SNMS 9-10

Synchronize the WaveStar NMS database with a
WaveStar SNMS database

9-13

Refederate a WaveStar SNMS server 9-15
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Add a new WaveStar SNMS
....................................................................................................................................................................................................................................

Purpose Use this task to add a new WaveStar SNMS on the WaveStar NMS.

Important! The task below must be run for each WaveStar SNMS to
be added.

Before you begin Before you begin this task, collect the following information:

• EMS system name

• EMS Internet address

Task Perform the steps below to add a new WaveStar SNMS.
............................................................................................................................................................

1 Log in as root to the WaveStar NMS host.

............................................................................................................................................................

2 At the prompt, enter ksh /usr/dacscan/bin/add.controller and
press Enter.

Result:

The following prompt is displayed:

Which Controller do you want to add?

............................................................................................................................................................

3 At the prompt, enter 17 and press Enter.

Result:

The following prompt is displayed:

What is the name of the WaveStar SNMS?

............................................................................................................................................................

4 Enter the name of the WaveStar SNMS then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

5 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.
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Result:

You are prompted to enter the IP address for the WaveStar
SNMS.

............................................................................................................................................................

6 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the Acronym.

............................................................................................................................................................

8 Enter the acronym using all CAPS. Note that this entry is a unique
identifier, which should not be more than four characters long.
Generally, the first four characters of the WaveStar SNMS hostname
are used.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

9 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

The original activity screen displays.

............................................................................................................................................................

10 Continue with one of the following steps.

• If you have have additional WaveStar SNMSs to add, for
example, if a geographic redundancy configuration is in place,
repeat Step 3 through Step 9 to continue.

• If you do not have additional WaveStar SNMSs to add, proceed
to the next step.

............................................................................................................................................................

11 Enter quit to exit the script.
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Result:

The script is exited.

............................................................................................................................................................

12 At the prompt, enter chown dacscan /dacscan/log/orbixd.log*

Result:

The owner of the orbixd.log file is changed.

............................................................................................................................................................

13 Continue with one of the following steps.

• If you are using an HP machine, open an hpterm window and
type vi /etc/hosts.

• If you are using a Windows machine, use an editor to access the
..\etc\Hosts file.

............................................................................................................................................................

14 Add the full qualified machine name of the host and the IP address of
the new EMS to the hosts or Hostsfile (if the hostname and IP
address are not already present) then save the file.

Important! If the machine to be added is in a local redundancy
configuration, the floating/virtual IP address should be entered.

............................................................................................................................................................

15 If a second WaveStar SNMS host is applicable, for example if
geographic redundancy configuration is in place, repeat Step 14,
otherwise proceed to the next step.

............................................................................................................................................................

16 Using the system console, log in to the new EMS as root.

............................................................................................................................................................

17 Enter /opt/itm/sc/toolbox/bin/wavestarsnms_set_itmnm_name

Result:

The new WaveStar SNMS is configured to communicate with
WaveStar NMS.
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Synchronize the WaveStar NMS database with a WaveStar
SNMS database
....................................................................................................................................................................................................................................

Purpose Use this procedure to synchronize the WaveStar NMS database with a
WaveStar SNMS database.

Task Complete the following task to synchronize the WaveStar NMS
database with a SNMS database.
............................................................................................................................................................

1 Access the Network Controller map.

............................................................................................................................................................

2 On the Network Controller map, right-click the desired ITM-SNMS
Node.

............................................................................................................................................................

3 Select Session > Start EMS Synchronization.

Result:

The Database Synchronization form is displayed. The EMS ID
field is pre-populated with the name of the EMS.

............................................................................................................................................................

4 From the Type menu, select one of the following node types:

• Alarm

• NE

• All

............................................................................................................................................................

5 Select OK.

Result:

A confirmation form appears.

............................................................................................................................................................

6 Select Yes.

Result:

The Database Synchronization Status form appears.

............................................................................................................................................................

7 Wait for the synchronization to complete.
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............................................................................................................................................................

8 Select Close.

Result:

The WaveStar NMS database is synchronized with the WaveStar
SNMS database.
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Refederate a WaveStar SNMS server
....................................................................................................................................................................................................................................

Purpose When the WaveStar SNMS application is upgraded to a new release,
there is a need to refederate WaveStar SNMS server(s), which
involves re-establishing the association between the WaveStar NMS
and WaveStar SNMS Orbix instances. Use this task to refederate a
WaveStar SNMS server from a WaveStar NMS server.

Important! This task applies to WaveStar SNMS R4.2 (or greater). If
the task is not run, communication would be severed between the
WaveStar SNMS server(s) and the WaveStar NMS server because the
associated Inter-operable Object Reference (IOR) string would be
lost. The task also relies on the naming service repository being intact.
If corruption is suspected, then refer to WaveStar NMS release notes.

Before you begin Before you begin this task, be sure that the WaveStar NMSserver is at
run level 4. See “Run level 4” (1-6) for details.

Task Perform the steps below to refederate WaveStar SNMS server(s)
from a WaveStar NMS server.
............................................................................................................................................................

1 Using a terminal window on the WaveStar NMS server, log in as
dacscan.

............................................................................................................................................................

2 At the prompt, enter /bin/ksh/install/refederate_snms
<wavestarsnms_hostname>

............................................................................................................................................................

3 Using a terminal window on the WaveStar NMS server, log in as
root.

............................................................................................................................................................

4 Determine whether or not the version of the WaveStar SNMS has
changed.

• If the version of the WaveStar SNMS has not changed, proceed
to Step 15 to continue.

• If the version of the WaveStar SNMS has changed, continue
with the next step.
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............................................................................................................................................................

5 At the prompt, enter init 3 to bring WaveStar NMS to run level 3.

............................................................................................................................................................

6 At the prompt, enter /usr/dacscan/bin/AddEMS.sh

............................................................................................................................................................

7 Select option 2 (for WaveStar SNMS server).

............................................................................................................................................................

8 At the Enter the SNMS Server Name, then press [return]:?

prompt, enter the hostname of the WaveStar SNMS.

............................................................................................................................................................

9 At the Enter the Version of the SNMS <SNMS Name>, then

press [return]: prompt, enter the WaveStar SNMS version.

............................................................................................................................................................

10 At the Are the WS-NMS GUI and SNMS GUI installed on the

same desktop(y/n)? prompt, enter y if a joint workstation is
deployed or n if the WaveStar NMS and WaveStar SNMS GUIs are
running on separate machines.

............................................................................................................................................................

11 If y was selected in the last step, enter the IP address of the WaveStar
NMS and WaveStar SNMS GUIs (when prompted). If n was selected
in the last step, enter the IP address of the WaveStar NMS GUI, and
then enter the IP address of the ITM-SC GUI.

............................................................................................................................................................

12 Review the displayed prompt, then enter y if the information is
correct.

............................................................................................................................................................

13 Select quit from the displayed list.

............................................................................................................................................................

14 At the prompt, enter init 4 to bring WaveStar NMS to run level 4.

............................................................................................................................................................

15 At the WaveStar NMS client GUI, click the desired WaveStar SNMS
server icon, then select Session > Start Communication.
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Result:

A dialog box containing the following text displays: START
SESSION COMMAND SENT FOR FRAME:<ems_ name>

............................................................................................................................................................

16 On the dialog box, click OK.

Result:

Communication is re-established between the WaveStar SNMS
and WaveStar NMS servers. The emsmap.cfg file is also
automatically updated where necessary, therefore, no editing of
this file is required.

If communication cannot be immediately established with the
refederated WaveStar SNMS server, restart the WaveStar
NMSapplication using the init 3/init 4 commands. See Start the host
application in Chapter 3, “System administration” for details.

............................................................................................................................................................

17 For each WaveStar SNMS server to be refederated, repeat Step 1
through Step 15 of this task.
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Section III: Interact with EMSs

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the administration of EMSs.

Definition: EMS An EMS is a graphical user interface-based element manager used for
network management.
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Add a new element management system (EMS)
....................................................................................................................................................................................................................................

Purpose This task is used to initiate adding a new EMS on the WaveStar NMS
Controller. The remaining add process is supported by subsequent
tasks referenced in the last step of this task.

The following EMSs are supported:

• External ITM-XM (DACS machines)

• External ITM-NSU (Bosch Radio Relay)

• External WaveStar NMS to ITM-XM

• External ITM-PRM

• External ITM-IDM

Important! The number of EMSs that may be added varies with the
WaveStar NMS configuration installed. The limit for ITM-SC is 20
subnetwork controllers. When the limit is reached, an error message is
displayed after the last step of the procedure to inform the user that
the EMS could not be added because it exceeded the number
allowed. The task below must be run for each EMS to be added.

Before you begin Before you begin this task, collect the following information:

• EMS system name

• EMS Internet address

Task Perform the steps below to add a new EMS.
............................................................................................................................................................

1 Log in as root to the WaveStar NMS host.

............................................................................................................................................................

2 At the prompt, enter ksh /usr/dacscan/bin/add.controller and
press Enter.

Result:

The following prompt is displayed, along with a numbered list
of EMSs:

Which Controller do you want to add?
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............................................................................................................................................................

Important! The following lists only those entries supported by
WaveStar NMS.

3 IF THEN

you select 6, and press
Enter.

See “Add a new ITM-XM” (9-21) to
continue.

you select 8 and press
Enter,

See “Add a new ITM-SC” (9-4) to
continue.

you select 11 and press
Enter,

See “Add a new NSU” (9-23) to
continue.

you select 13 and press
Enter,

See “Add External WaveStar NMS to
ITM-XM” (9-25) to continue.

you select 14 and press
Enter,

Enter the ITM-PRM hostname at the
prompt. (No other steps are necessary).

you select 15 and press
Enter,

See “Add a new ITM-IDM” (9-27) to
continue.

you select 17 and press
Enter,

See “Add a new WaveStar SNMS”
(9-10) to continue.
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Add a new ITM-XM
....................................................................................................................................................................................................................................

Purpose Use this task to continue adding a new ITM-XM on the WaveStar
NMS.

Before you begin Complete “Add a new element management system (EMS)” (9-19).

Task Perform the steps below to continue adding a new ITM-XM.
............................................................................................................................................................

1 Complete “Add a new element management system (EMS)” (9-19) to
select the controller to be added.

Result:

A message, beginning to set up external ITM-XM for

DACSV displays followed by the following prompt:

What is the name of the ITM-XMV?

............................................................................................................................................................

2 Enter the name of the ITM-XM, then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

3 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the ITM-XM.

............................................................................................................................................................

4 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

5 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.
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Result:

The text, correcting XTNC/XTND entries in

/usr/dacscan/oam/config_data/cm/ccpm/ccpconfig

displays.
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Add a new NSU
....................................................................................................................................................................................................................................

Purpose Use this task to continue adding a new NSU on the WaveStar NMS.

Before you begin Complete “Add a new element management system (EMS)” (9-19).

Task Perform the steps below to add a new NSU.
............................................................................................................................................................

1 Complete “Add a new element management system (EMS)” (9-19) to
select the controller to be added.

Result:

A message, beginning to set up external ITM-XM displays
followed by the following prompt:

What is the name of the PRIMARY NSU?

............................................................................................................................................................

2 Enter the name of the primary NSU, then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

3 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the primary NSU.

............................................................................................................................................................

4 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

5 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the name of the standby NSU.
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............................................................................................................................................................

6 Enter the name of the standby NSU, then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the standby NSU.

............................................................................................................................................................

8 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

9 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

The following text displays adding BOSCH PRIMARY and

STANDBY NSU entry to /usr/dacscan/oam/config_data/cm/

ccpm/ccpconfig adding BOSCH NSU entries to DSCANenv

file ... notifying workstations of new PRIMARY NSU...

notifying workstations of new STANDBY NSU...
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Add External WaveStar NMS to ITM-XM
....................................................................................................................................................................................................................................

Purpose Use this task to continue adding an external WaveStar NMS to
ITM-XM.

Before you begin Complete “Add a new element management system (EMS)” (9-19).

Task Perform the steps below to add an external WaveStar NMS to
ITM-XM.
............................................................................................................................................................

1 Complete “Add a new element management system (EMS)” (9-19) to
select the controller to be added.

Result:

A message, beginning to set up external ITM-NM displays
followed by the following prompt:

What is the name of the ITM-NM/DACS-VI XM

............................................................................................................................................................

2 Enter the name of the WaveStar NMS host name, then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

3 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the
ITM-NM/DACS-VI XM ITM-NM/DACS-VI XM.

............................................................................................................................................................

4 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

5 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.
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Result:

The text, correcting TNC/TND entries in

/usr/dacscan/oam/config_data/cm/ccpm/ccpconfig

displays.
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Add a new ITM-IDM
....................................................................................................................................................................................................................................

Purpose Use this task to continue adding a new ITM-IDM on the WaveStar
NMS.

Before you begin Complete “Add a new element management system (EMS)” (9-19).

Task Perform the steps below to add a new ITM-IDM.
............................................................................................................................................................

1 Complete “Add a new element management system (EMS)” (9-19) to
select the controller to be added.

Result:

The following prompt displays:

Please enter IDM Hostname:

............................................................................................................................................................

2 Enter the name of the IDM host name, then press Enter.

Result:

You are prompted to enter the IP address.

............................................................................................................................................................

3 Enter the IP address then press Enter.

Result:

The message, Adding host to /etc/hosts displays.
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Synchronize the WaveStar NMS database with an EMS
....................................................................................................................................................................................................................................

Purpose Use this procedure to synchronize the WaveStar NMS database with
an EMS database.

Task Complete the following task to synchronize the WaveStar NMS
database with an EMS database.
............................................................................................................................................................

1 Select Network Map -> File -> Network Controller Map -> select
Node -> Session -> DB SYNC.

Result:

The Database Synchronization form is displayed.

............................................................................................................................................................

2 Select the name of the EMS node listed in the EMS field.

..........................................................................................................................................................

3 IF THEN

You select Alarm, An alarm synchronization occurs with
all the network elements under control
of this EMS.

You select NE, A network element synchronization
occurs with all the network elements
under control of this EMS.

This only determines which network
elements are under the control of the
EMS. To perform a database
synchronization with a network
element, it must be done directly from
the Network Map.

You select All, An alarm and equipment
synchronization occurs with all the
network elements under control of this
EMS.

You select Clear, The EMS field is cleared.
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Section IV: Miscellaneous management communication tasks

Overview
....................................................................................................................................................................................................................................

Purpose This section describes miscellaneous management communication
tasks.
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View LAN status information
....................................................................................................................................................................................................................................

Purpose Use this procedure to view the status of any of the LANs that are
connected to the machine, including the LAN that connects the
WaveStar NMS to the EMS.

Task Perform the steps below to view LAN status information.
............................................................................................................................................................

1 Using the system console, log into either the primary or the standby
host as root.

............................................................................................................................................................

2 Enter lanscan

Result:

The LAN status information is displayed.
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Section V: ITM-XM EMSs

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes the processor’s resource management functional
area’s equippage and configuration records for digital cross connect
system frames. It also includes a description on the alarm database
audit and the database synchronization processes and their impact to
stored data.

This chapter includes infomation on WaveStar DACS and DACS
VI-2000 frames, which can be graphically displayed through one of
the following methods.

If the DACS equipment has not been upgraded/migrated to WaveStar
DACS R2.1, then the equipment is managed by the ITM-XM EMS
and can be displayed directly through ITM-XM. If however, the
equipment has been upgraded/migrated to WaveStar DACS R2.1, then
the equipment is managed by the ITM-SC EMS and displayed through
a cut-through to ITM-SC EMS.

Please refer to the ITM-SC User Documentation for resource diagrams
of network elements managed by the ITM-SC.
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Resource management functions
....................................................................................................................................................................................................................................

Overview Resource Management is a functional area of the Processor that
maintains equipage and configuration records for the digital
cross-connect system frames associated with the processor, such as
WaveStar DACS.

For additional information, see the product documentation for the
specific digital cross-connect.

These database records are created automatically by database
synchronizations with the digital cross-connect system frames; they
cannot be created or manipulated manually. Therefore, they are in
agreement with the digital cross-connect system frames and not based
on a manually created record of what we think is there.

The hierarchal levels of digital cross-connect system information are
similar for all digital cross-connect systems. However, the terms vary
depending upon the vendor or the digital cross-connect system. For
WaveStar DACS the terminology is:
System/Rack/Subrack/Unit/Physical Port/Logical Port.

To support multiple vendors with different terminologies, in this
manual the terms are used generically as: System (Frame)/Rack
(Bay)/Subrack (Shelf)/Unit (Slot)/Port /Time Slot (Logical Port).
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WaveStar DACS
....................................................................................................................................................................................................................................

Overview WaveStar DACS terminates STM-0 and STM-1 (SDH) signals and
AU4/AU3/TU3/TU12 cross-connects.

WaveStar NMS supports WaveStar DACS Releases 2.0, R1.0 and
R1.1 with Port Subrack A (PSA) and Port Subrack B (PSB) port units.
Subracks are configured as either dual fiber or single fiber. Single
fiber subracks support only odd numbered units; even numbered units
must then be used for MSP protection of the odd numbered units.

The WaveStar NMS display of the WaveStar DACS resources is
presented graphically in a cascading hierarchical sequence as follows:

• Frame (System) - The entire WaveStar DACS consisting of a
number of racks identified by a digital cross connect ID, which
identifies a particular digital cross-connect system.

• Rack (Bay) - Racks are physical hardware that exist only to hold
subracks.

• Subrack (Shelf) - Subracks sometimes called shelves contain slots
for plug-in units and interface hardware panels.

• Unit (Slots) - A component of the subrack, that accepts units
(plug-ins) that combine to make a subrack (shelf).

• Ports (Physical Ports) - Ports are located on and are a component
of the plug-ins in the slots, to physically terminate a signal from
and to the external transmission systems. They serve as an
interface between the digital cross connect and the external
facilities.

• Time Slot (Logical Port) - These are the multiplexed or
demultiplexed signal channels of a higher order transmission
system terminated at a physical port. For a digital cross connect,
these logical ports are associated with AU4, AU3, TU3, and
TU12 time slots that are the virtual cross-connections on the
frame.

WaveStar DACS display Resource display of the WaveStar DACS involves the Equipment
display and the Resource Database Management Equipment display.

The user interface forms for the WaveStar DACS are:

• Frame Display

• STM0 PSB
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• STM1 PSA

• Main Controller Subrack (MC)

• Matrix and Synchronization Subrack (MS)

• Physical Port Display

• Logical Port Display

• Cross Connection Management
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WaveStar DACS frame display
....................................................................................................................................................................................................................................

Overview The graphical display of the WaveStar DACS frame includes a
representation of all racks and subracks provisioned in the monitored
system. The following figure shows an example of the WaveStar
DACS frame with port racks (containing PSA and PSB subracks), and
two core racks containing the MC subrack and the Matrix and
Synchronization (MS) subrack. Note that the MS subrack is composed
of three elements and spans two racks. However, it is possible to
indicate that the Matrix elements are alarmed independent of the
synchronization elements and it is possible to select the
synchronization subrack independent of the matrix subracks.

Access If the DACS equipment has been upgraded/migrated to WaveStar
DACS R2.1:

• refer to ITM-SC User Documentation.

Color conventions On the Frame Display, all the Subracks (shelves) are displayed. The
color coding of each subrack indicates equipment provisioning and
alarm information as follows.

Service affecting or non-service affecting port or equipment alarm
information is indicated by color coded circle or square respectively,
at the bottom of the displayed subrack. Placement does not indicate
the location of the unit. Where as, provisioned subracks are indicated
by color coding the entire displayed subrack in Clear display.

• No Circle or Square: - Provisioned and without service affecting
or non service effecting equipment or signal alarms on any
component of the subrack down at the port level.

• Yellow Circle: - Provisioned and non service affecting signal
alarm on at least one component of the subrack down at the port
or logical port level. No service affecting signal alarm exists on
any component of the shelf.

• Red Circle: - Provisioned and service affecting signal alarm on at
least one component of the subrack down at the port or logical
port level. There may be some non-service affecting signal
alarms also on some of the components of the shelf.
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• Yellow Square: - Provisioned and non service affecting
equipment alarm on at least one component of the subrack down
at the slot level. No service affecting equipment alarm exists on
any component of the shelf.

• Red Square: - Provisioned and service affecting equipment alarm
on at least one component of the subrack down at the slot level.
There may be some non-service affecting equipment alarms also
on some of the components of the shelf.

Fields

Bay Information

NE ID: Network element identifier.

Model: Frame model.

Software Version: Version of the software application.

EMS Version: Version of EMS application.

Buttons Close: Closes this form.

Help: Provides help for this form.
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WaveStar DACS shelf display
....................................................................................................................................................................................................................................

Purpose The subrack display provides a display of the subrack fronts and
backs. Because serviceable units are located in both the front and
back of the port and synchronization subracks, both the front and the
back of such subracks are graphically displayed when the user selects
the subrack from the Frame Display.

WaveStar DACS has the following port subrack configurations:

• There can be up to two PSA subracks within a rack.

• There can be only one PSB subrack within a rack.

• Subracks can be “one-fiber” or “two-fiber” and “electrical” or
“optical” in nature.

• A two-fiber subrack supports a capacity of 64 STM1s from the
subrack to the cross-connect core. A one-fiber subrack supports
32 STM1 worth of capacity. Two-fiber subracks are ideally suited
for unprotected ports and one-fiber subracks are ideally suited to
MSP protected ports. Note that a two-fiber subrack can support
MSP protected ports and a one-fiber subrack can support
unprotected ports. The two-fiber and one-fiber nature of a
subrack only reflects the amount of connectivity between the
subrack and the cross-connect matrix.

• Each subrack supports two shelves.

• Units are placed both in the front and in the back of the subrack.

• Port units are placed in the front of the subrack and Interface
Units (IUs) are placed along with the Bits Slice Interface Units
(BSIUs) in the back of the subrack.

• The IUs determine the optical or electrical nature of the interface.

• STM1 IUs are available as either optical or electrical units.

• STM0s IUs are only available as optical units.

• Up to 8 STM0 port units per shelf.

• Up to 8 STM1 ports units per shelf plus one optional protection
unit to support 1:8 equipment protection for electrical units.

• An interface unit must accompany each STM1 or STM0 port unit
directly on the other side of the subrack.

• Note that protection units do not have a directly supporting
interface unit but instead are wired to all interface units for that
shelf.

Section V: ITM-XM EMSs EMS management
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• STM1 port/interface units support up to 4 STM1 ports.

• STM0 port/interface units support up to 12 STM0 ports.

• The STM1 and STM0 optical ports can be configured as
Multiplex Section Protection (MSP) protected or as unprotected.
Protected ports must be located on adjacent units and in the same
relative position in each unit.

Section V: ITM-XM EMSs
WaveStar DACS shelf display

EMS management
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WaveStar DACS cross-connect management
....................................................................................................................................................................................................................................

Purpose WaveStar DACS supports two interface port units types, STM0 and
STM1. These units are housed in the subrack type PSB and PSA,
respectively. An STM1 unit can interface to an STM1 signal that is
structured to carry one clear channel AU4 (VC4) signal or three clear
channel AU3 (higher order VC3) signals or a structured VC4
(TU3s/TU12s). An STM0 unit interfaces to an STM0 signal
provisioned as a clear channel AU3 signal.

The Cross Connections Management form displays a graphical
representation of port cross-connections within a digital cross connect
frame. The internal address of the From Port is displayed. The internal
address of the To Port is displayed only when there is a
cross-connection to the corresponding From Port. The alarm condition
on the displayed ports may be viewed. The Cross Connection
Management option may be selected from the graphical display of the
selected digital cross connect frame by navigating to the physical or
logical port display, or from the cross-connect cascaded menu off the
Node Menu associated with the selected digital cross connect frame.

Section V: ITM-XM EMSs EMS management
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Alarm Database Audit
....................................................................................................................................................................................................................................

Overview To optimize certain searches, the WaveStar NMS Fault Management
module has redundancy in its data storage, which leads to occasional
deviation in data. The Alarm Database Audit feature corrects this
deviation.

An alarm Database Audit for alarms is triggered by one of the
following:

• A nightly cron job (according to the schedule defined during
installation) that automatically triggers the audit at the scheduled
time.

The cron job is not triggered if an alarm sync with an EMS is
currently in progress.

• Automatic audit after a manually triggered alarm sync with an
EMS (such as ITM-SC).

At the end of an Alarm Database Audit, a broadcast message is sent
that indicates that the audit is completed. A broadcast message is not
sent if the Alarm Database Audit does not find any discrepancies.

Section V: ITM-XM EMSs EMS management
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WaveStar DACS database synchronization
....................................................................................................................................................................................................................................

Overview The Database Synchronization form (described in an earlier chapter) is
used to perform a synchronization between the Controller database
and the database of an individual digital cross-connect system.

With the Synchronization function, the Controller database is
synchronized with the database of an individual digital cross-connect
system. The synchronization can be a partial or full synchronization
based on your selection.

The Controller supports following types of Database Synchronization
processes:

• Alarm Database Synchronization

• Cross Connection Map Database Synchronization

• Equipment Database Synchronization

• Complete Database Synchronization

Facility-based port parameter data synchronization can only be
performed manually (on-demand). The other three types of data
synchronization can be performed either automatically or manually.
The Controller displays associated commands, data and status
messages on the Data-base Synchronization form.

Section V: ITM-XM EMSs EMS management

....................................................................................................................................................................................................................................

365-309-245
Issue 1, October 2001

Lucent Technologies 9 - 4 1





10 Trouble clearing

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes how to turn on trace and view trace files.

For information on fault management and performance monitoring
tasks, refer to theWaveStar NMS Maintenance Guide.

WaveStar NMS home
directory

The home directory of WaveStar NMS is /usr/dacscan. The
application servers reside in the bin directory of the home directory.
Each server has trace information linked to it and it can be turned on
and off via the tinfo file in /usr/dacscan/bin.

Important! The trace files should never be removed while the
application is up under any circumstances.

Definition: trace file A trace file contains information that identifies equipment status at a
given point in time. The typical use of a trace file is to send it to
Lucent technical support to be used as part of their remote
troubleshooting activities.

Contents
Troubleshoot X.25 links 10-3

Create a trace file on a server 10-4

Create a trace file on an HP-UX workstation or on
a PC

10-6
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View the core file 10-7

View the log files 10-8

View the log file on an HP workstation 10-10

View the console.log file on a Windows PC 10-11

Start WaveStar NMS on a specific
MC/ServiceGuard node

10-12

Overview Trouble clearing

....................................................................................................................................................................................................................................

1 0 - 2 Lucent Technologies 365-309-245
Issue 1, October 2001



Troubleshoot X.25 links
....................................................................................................................................................................................................................................

Background Normally, if an X.25 link goes down, it restores itself automatically
after the trouble on the link clears.

Task If an X.25 link goes down, do not attempt to restart it. For trouble
resolution, the link should be called into the organization responsible
for the packet network.

Trouble clearing
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Create a trace file on a server
....................................................................................................................................................................................................................................

Purpose Use this procedure to turn on trace at a particular server and to create
a trace file for capturing information.

Important! Trace files should never be removed.

Before you begin Before you begin this task, ensure that the application is at run level
3.

Task Perform the steps below to create a trace file.
............................................................................................................................................................

1 Enter the command who -r to check the current run level.

Result:

The run level number displays, such as run-level 3.

............................................................................................................................................................

2 If the displayed run level is higher than 3, enter the command init 3
to bring the application up to run level 3.

............................................................................................................................................................

3 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

4 At the prompt, enter cd /usr/dacscan/bin to change to the directory
containing the tinfo file.

............................................................................................................................................................

5 To edit the tinfo file, enter vi tinfo.

............................................................................................................................................................

6 In the tinfo file, locate a line containing the following format:
<servername> -1 0 <servername>. 0 Y

Important! In your tinfo file, <servername> will be replaced with
the actual server name.

............................................................................................................................................................

7 To increase the trace level from 0 (the lowest level) to 5, press the
Esc button, then type :1,$s/-1 0/-1 5/ then press Enter.

Trouble clearing
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Result:

The lines containing those entries will be substituted with the
higher trace level value, such as <servername> -1 5

<servername>.0 y

............................................................................................................................................................

8 Save and exit the file.

Result:

The file is saved with the new trace level.

............................................................................................................................................................

9 At the prompt, enter init 4 to bring the application up to run level 4.

Result:

Trace is turned on. A trace file is generated and is called
<servername>.<pid><host_name>.

............................................................................................................................................................

10 Verify that the trace file /dacscan/trace/<servername>.<pid> exists.

Result:

The file displays in the appropriate directory.

Create a trace file on a server Trouble clearing
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Create a trace file on an HP-UX workstation or on a PC
....................................................................................................................................................................................................................................

Purpose Use this procedure to create a trace file for capturing information on
an HP-UX workstation or a PC console.

Important! Trace files should never be removed.

Task Perform the steps below to turn create a trace file on an HP
workstation or on an NT PC.
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

..........................................................................................................................................................

2 IF THEN

you want to increase global
tracing and turn on
F-interface tracing at an
HP-UX console,

edit the /usr/add-on/ui/jui/bin/run_jnm
file by gt=1 to gt=4 fint.tr=4

you want to increase global
tracing and turn on
F-interface tracing at a PC
console,

edit the <drive>:\jui\bin\run_jnm.bat
file and enter set trace=5

............................................................................................................................................................

3 Save the edited run_jnm or run_jnm.bat file.

............................................................................................................................................................

4 Shut down and restart the WaveStar NMS application.

For instructions, see the “Stop WaveStar NMS” (3-16), “Start
WaveStar NMS on an HP-UX workstation” (3-13), and “Start
WaveStar NMS on a Windows workstation (PC)” (3-14) tasks in this
document.

Result:

Tracing is turned on and a trace file is generated.

............................................................................................................................................................

5 Verify that the trace file exists.

Result:

The file displays in the appropriate directory.

Trouble clearing
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View the core file
....................................................................................................................................................................................................................................

Purpose Use this procedure to view the core file created when a server dies.

Definition: core file The core file contains information that identifies which process died
and caused the core dump. It is used during troubleshooting to help
identify what caused the server to die.

About the core file When a server shuts down, a core file may be created in
/usr/dacscan/bin. The core file reveals the identity of the server.
Because the server is automatically restarted, service on that particular
function of the system is only impacted for a brief period. Until it has
restarted, information will not be lost because the system’s bulletin
board will buffer services requested upon that server.

Task Perform the steps below to view the core file.
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 At the prompt, type: ls -l core

Result:

The core name displays in the following file format:
core.<PROCESS_NAME>.<process>

............................................................................................................................................................

3 Enter the following command: file core

Result:

A file is created which may be used for verification purposes. It
is stored under the /usr/dacscan/bin directory and is named
in the following format: core.<PROCESS_NAME>.<process>

Trouble clearing
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View the log files
....................................................................................................................................................................................................................................

Overview Operator transaction logs are stored in compressed format in the
/dacscan/log/data directory with the following naming convention:

<log-prefix>.<julian-date>.<hour>.<minute>

The following is a list of log files:

• sys (System Event) - records all system error messages. File
name is nms.log.<hostname>.

• dcs (Digital cross connect log) - records communication
information with the DACS in the network. File name is
ne.log.<hostname>.

• Notification log file - notif.log.<hostname>

• Orbix log file - orbix.log.<hostname>.

• HP client log file - File name is console.log and is stored at
/home/<user_name>/NM/<workstationname>.<pid>/jui/logs/console.log

• PC client log file - The file is stored at
<drive>:\jui\logs\<user>.log

All log files are maintained up to seven days; the oldest file is
overwritten first. One log file is retained for each day of the week.

Log Files All significant events associated with the database backup and transfer
scheme are logged.

The events are also retained in log files in /dacscan/tmp.

Log file management for
joint workstations

Joint workstation logs record all ICA client sessions from a joint
workstation. The log files for the joint workstation are not
automatically deleted by the system. For space consideration, it is
recommended that the system administrator or user manually delete
the log files that are no longer necessary.

Location of log files

Joint workstation log files are located in c:\jui\logs and use the format
<username><win station name>#<a random number> where:

• <username> is any valid user

• <win station number> is the console on which the GUI is run

Trouble clearing
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• # is the actual character #, and

• <a random number> is any random number assigned (<999). The
random number is attached to the log file to prevent a user with
the same user ID from overwriting a log file that is already in
use.

View the log files Trouble clearing
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View the log file on an HP workstation
....................................................................................................................................................................................................................................

Purpose Use this procedure to view the log file residing on an HP workstation.

Task Perform the steps below to view the log file.
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 Change to the directory containing the log file to be viewed. Type cd
/<full_directory_pathname> cd /<full_directory_path>

For example, type cd /home/<user>/NM/<workstation>.<pid>/
jui/logs/console.log

............................................................................................................................................................

3 Enter pg <logfilename>.log

Result:

The contents of the log file is displayed.

Trouble clearing
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View the console.log file on a Windows PC
....................................................................................................................................................................................................................................

Purpose Use this procedure to view the console.log file residing on a PC.

Task Perform the steps below to view the log file.
............................................................................................................................................................

1 Log in to the PC as sa.

............................................................................................................................................................

2 Using Notepad or Wordpad, display the console.log file which
resides in <drive_letter>:\jui\logs\<user>.log

Result:

The file displays.

Trouble clearing
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Start WaveStar NMS on a specific MC/ServiceGuard node
....................................................................................................................................................................................................................................

Purpose Use this task to start the WaveStar NMS application on a specific
node using the sam application. This task may be used, for example,
to isolate a problem on the node.

Start WaveStar NMS on a
specific node

Complete the following steps to start the WaveStar NMS
application on a specific node.
............................................................................................................................................................

1 Log into either the primary or the standby machine as root.

............................................................................................................................................................

2 Enter sam at the prompt.

Result:

The sam application displays.

............................................................................................................................................................

3 Select Clusters > High Availability Clusters > Package Admin.

............................................................................................................................................................

4 Highlight the ITMHost entry.

............................................................................................................................................................

5 On the pull down menu, select Actions > Start a package > Start a
package on a specific node.

............................................................................................................................................................

6 Check enable package switching.

............................................................................................................................................................

7 Highlight Node entry.

............................................................................................................................................................

8 Select OK.

Result:

The WaveStar NMS application starts on the specific node.

Trouble clearing
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11 Patch and Software Upgrade
Tasks

Overview
....................................................................................................................................................................................................................................

Purpose This chapter will provide WaveStar NMS patch and upgrade
information.

Information Information not available.

Contents
Patch information 11-2
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Patch information
....................................................................................................................................................................................................................................

Description Information not available.

Patch and Software Upgrade Tasks

....................................................................................................................................................................................................................................

1 1 - 2 Lucent Technologies 365-309-245
Issue 1, October 2001



Appendix A: WaveStar NMS
Filesystems

WaveStar NMS file systems
....................................................................................................................................................................................................................................

Introduction This appendix contains a list of the WaveStar NMS file systems.

List of file systems The following lists the directory structure supported within WaveStar
NMS.

1. Root directory (/)

2. OS kernel (/stand)

3. Spool directories (/var)

4. Core OS components (/usr)

5. Optional software (/opt)

6. Provisioning documents directory (/dacscan/prov)

7. Alarms directory (/dacscan/alarms)

8. Three Oracle tablespace directories (/oradb, /oradb2, /oradb3)

9. Application logs directory (/dacscan/log)

10. Database redo logs and archives directory (/dacscan/dbarch and
/dacscan/journal)

11. Application users directory (/dacscan/users)

12. Application trace information directory (/dacscan/trace)

13. Temporary directory (/tmp)

14. Application temporary space (/dacscan/tmp)

....................................................................................................................................................................................................................................
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15. Application software (/usr/dacscan)

16. Application software patch history (/patch)

17. ITM_QA (/ITM_QA)

WaveStar NMS file systems WaveStar NMS Filesystems
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Appendix B: WaveStar NMS
Parameters

Overview
....................................................................................................................................................................................................................................

Introduction This Appendix contains non-obsolete, WaveStar NMS configuration
parameters to be set during the installation process. Most of these
parameters are STRING type, however in many cases, these
parameters are effectively of another type, for example, boolean or
integer.

This section has a table that lists the parameters, their descriptions,
and values. The table includes ranges, default values, and the time at
which the parameter can be set or reset, for example, at install time,
or anytime, where applicable.

Header Files There are three header files, two of which are auto-generated. The
only maintained header file is nms_param.h which itself includes the
relevant public auto-generated header file.

Parameter numbers ParamNo are defined as the name of the
parameter, capitalized and prefixed by SA_. The parameter BER
would have a ParamNo of SA_BER.

To obtain the value of a parameter, you need to know its ParamNo
and type (i.e., Scalar or String). The ParamNo is unique across both
types, to help detect calls to ‘get’ functions with the wrong type of
ParamNo. Any process wishing to obtain the value of a parameter
must include nms_param.h.
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Values Certain ‘well known’ pre-defined values are defined in the maintained
header file nms_param.h. If you need to use any other values, they
must be added to this file. Currently defined values are TRUE /
FALSE, ON / OFF and YES / NO which are all defined as 1 / 0
respectively. These values may be used as numeric entries in the
tables below.

Overview WaveStar NMS Parameters
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WaveStar NMS Parameter Table
....................................................................................................................................................................................................................................

Parameters

Parameter Description and Values Default Value

ALARMED_PATH_
SUPPRESSION

Whether alarmed path suppression is on or off.
Mininum value is False; Maximum value is
True.

False

ALM_DEL_OPTION Configurable options for the deletion of
persistent alarms. Values are UNACK_ACK,
ACK, UNACK, ENF_CLR_ACK

UNACK_ACK

ALM_THRESHOLD Keeps track of alarm aging period in seconds -
for preplan only.

45

BILLING_INTERFACE For billing interface feature. (1 = TRUE; 0 =
FALSE)

0

BILL_COMPUTER Name of the bill computer.

BILL_DIRECTORY Name of the bill directory.

BROADCAST Broadcast family function enabled. Values are
off; on

off

CHANNEL_SELECTION Determines the method to use for channel
selection. Values are LOWEST_TIMESLOT_FIRST,
BEST_USAGE

BEST_USAGE

CKTFMT Describes the circuit and format. Values are:
AZTYPEID, IDTYPEAZ,FREEFORMAT,AZTYPEID:FREE,
IDTYPEAZ:FREE

AZTYPEID

CKTFMTSTR Stores the format of the circuit ID. Values are:
%s - %s %s %s,%s %s %s.%s,%s %s %s %s

%s %s %s %s

COMBO_PROVISIONING Configures combo provisioning. Values are off
and on.

off

COUNTRY Country codes used during installation. Values
are: FRANCE, GCL, GER, HOL, INDONESIA,
JAPAN, KSA, MEX, PHILIPINES, PRC, SPAIN,
TAIWAN, UK, USA

USA

CURR_ALM_STORAGE_LIMIT Configurable record limit for current alarms.
Minimum value is 10000; maximum is 200000.

10000

CYCLIC Cyclic scheduler function enabled. Values are
off, on.

off

WaveStar NMS Parameters
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DATE_FORMAT The format for the date. Values are AMERICAN,
EUROPEAN, YYYYMMDD

EUROPEAN

DBPVAR Geographical Domain Partitioning view. Values
are “READALL” for see all nodes or ”” for
See-Own-Nodes.

DNA_INCR_UPD Controls the database trigger supporting the
DNA incremental update feature. Values are
OFF,ON

OFF

ENTERPRISE The default service partitioning name. Values
are ENTPRISE, user-supplied for Other or ″″ for
none.

FIX_TUG_STRUCT Fixed TUG structure functionally enabled.
Values are off, on.

off

FM_APPROACH Two distinct modes identified for the operation
of Fault Management (FM) which are Service
approach (top down mode) and the Alarm
approach (bottom up mode). They affect
whether the NES or NEV form of the network
event list is displayed and certain other
behavior of the FM screens. Values are alarm,
service

alarm

FM_EVENT_LIST_SIZE The number of events (lines) to be displayed on
the NEV/NES window. Min. value is 100; Max
value is 500.

100

FM_NASS_INTERVAL Alarm summary update interval. (Range value;
1,300)

60

FM_POLLING_INTERVAL The interval time (in seconds) for polling to
update the counters on the NES or NEV.
Minimum value is 30; maximum value is 60.

60

FM_SYSTEM Fault Management System Flag. Values are
CORBA, NON-CORBA

CORBA

FRENCH French language supported? Values are on, off off

GERMAN German language supported? Values are on, off off

HIST_ALM_STORAGE_LIMIT Configurable record limit for historical alarms.
Minimum val ue is 10000; maximum value is
300000.

100000

HIST_RM Keep track of disconnect history orders. Values
are 1 to 180

180

WaveStar NMS Parameter Table WaveStar NMS Parameters
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IMP_DISC_UN_XC Improper disconnect/uncorrelated cross-connect
function enabled. Values are off, on

off

INC_PPRSV_CHANS_IN_RTE Defines whether to include pre-planned
reserved channels in restoration order or not.
Values are YES, NO

NO

INTEGER_PORT_ID To determine if client uses TP IDs generated by
ITM-NM to access the frame address and
location. Values are TRUE for QNN interface;
FALSE for PRM interface.

FALSE

INTEGER_SNC_ID To determine if SNC_ID is integer or not.
Values are TRUE for QNN interface; FALSE for
PRM interface.

FALSE

KANJI Kanji language supported? Values are off, on. off

LB Loop back functionality enabled. Values are off,
on.

off

LOWER_LVL_CKT_PREEMPT Lower level circuit pre-emption flag. Values are
Y,YES,N,NO

N

MERGE_CIRCUIT Merge circuit function enabled. Values are off,
on

off

NB_ALARMS Northbound alarms function enabled. Values are
off, on

off

NB_CMISE Northbound CMISE function enabled. Values
are off, on

off

NB_CONFIG Northbound configuration function enabled.
Values are off, on

off

NB_EVTRCVR Northbound event receiver. Values are CIPC for
QNN interface; nbgw for PRM interface.

nbgw

NB_NOTIF Northbound notification server. Values are CIPC
for QNN interface; er for PRM interface.

er

NB_RSPMGR Northbound response manager. Values are CIPC
for QNN interface; nbgw for PRM interface.

nbgw

NMS_NB_NAME A free-form field. Installation procedures
should ensure that this is set to the UNIX host
name of the primary machine in GR and
ServiceGuard machine sets.

NMS_PORT_TABLE NMS Port Selection screen enabled? Values are
y,n

n

WaveStar NMS Parameter Table WaveStar NMS Parameters
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NB_THR_SIZE Value of thread stack size in kilobytes. 128

OFFICEDELIM The location code delimiter (separates the
physical office component from the NE
equipment address in a location code.

/

PAMS Is the PAMS interface enabled? Values are off,
on

off

PAMS_ACCOUNT_NAME The name of the PAMS account.

PAMS_FILE_DIR The directory in which PAMs auto-generated
files are placed.

/ITM_QA/PAMS_NM

PAMS_PASSWORD The password for the PAMS account (in clear).

PAMS_SCHEDULE_AM The time (HH:MM) scheduled for PAMS in the
morning, i.e., 00:00 - 11:59.

07:00

PAMS_SCHEDULE_PM The time (HH:MM) scheduled for PAMS in the
evening, i.e., 12:00 - 23:59.

13:00

PCC Path continuity check function enabled. Values
are off, on

off

PM Basic Performance Monitoring (PM) function
enabled. Values are off, on

off

PM_LOG_DIR PM remote directory

PM_LOG_WKSTN PM remote workstation

PPALM To check if user wants alarm triggered preplan.
Values are YES, NO

NO

PP_COMBO_REST Preplan combo flag. Values are Y, N N

PREEMPT Preemption function enabled. Values are off, on. off

PRODSPLIT Product ID for this installation (Values are NLS
for R3T NLS only, ELS for R3T ELS only,
JOINT for joint R3T NLS and ELS,
JOINT_MULTI_ELS for one NLS to many ELS,
or OTHER).

JOINT_MULTI_ELS

PRODUCT Name of the product. Values are T30,T30/VM,
T30/JT

T30

READ_ONLY_VIEWING_FOR_
GD_USERS

Geographic Domain users may have a view
only for records not in their domain. Minimum
value FALSE; Maximum value TRUE.

FALSE

REUSE_CLO_FOR_RS Reuse circuit order data for restoration circuits?
Values are YES, NO

NO

WaveStar NMS Parameter Table WaveStar NMS Parameters
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RS Basic restoration function enabled. Values are
off, on

off

RS_SKIP_CHASS_VALID RS customer can choose to skip class
validation. Values are Y, N

N

RS_STOP_AT_LAY To determine if the auto alarm triggered RS
order needs to be stopped at LAY. Values are Y,
N

Y

RS_STOP_AT_TEST To determine if the user wants auto RS stop at
TEST step. Values are Y, N.

N

SAVE_DISC_WKLOG Is archive of Disconnect Orders enabled?
Values are Y, N

N

SB_CORBA Southbound CORBA function enabled. Values
are off, on

on

SCHED_DISCONN Scheduled disconnect function enabled. Values
are off, on

off

SPANISH Spanish language supported? Values are on, off off

SWITCH_MSP Switch MSP function enabled. Values are off,
on

off

TANDEM_CONN Tandem connection monitoring enabled. Values
are off, on

off

TELCO Name of the customer; user to set other
parameters. Values are BT-GTN, CHT, DTAG,
GCL, SDH

SDH

TIMESLOT_FORMAT Timeslot format. Values are G707, SEQUENTIAL G707

TIM_PORT Keep track of TIM interface datakit port
address (0 if TIM_TCP is “Y”, otherwise, user
supplied).

TIM_TCP Keep track of TIM interface network type?
Values are Y, ““

TRENCH_ID_OPTION Trench ID usage is on (TRUE) or (FALSE) FALSE

TWOBYTECHAR To identify if it is a double byte character
language. Values are YES, NO

NO

UNALMUPP User notification of alarms against unused
preplan functionality enabled. Values are off, on

off

UNASGN_SRVDOM_ON_DISC To unassign channels from service domain
when service is disconnected. Values are Y,N

N

WaveStar NMS Parameter Table WaveStar NMS Parameters
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WORD_IP_ADDRESS IP address of DNA serving Work Order Record
Documents (WORDs)

WaveStar NMS Parameter Table WaveStar NMS Parameters
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Glossary

A Action
Order Action - Represents the work activities against a facility/circuit order.

Add Channel
One direction of a bidirectional signal; a wavelength being added into the single flow.

Add Side
Hardware that handles a signal coming in from the network to an end terminal.

ADM
Add-drop multiplexer

Aggregate
A collection of one or more network elements and/or aggregates. An aggregate is represented by
a single icon on the Network Map.

AIS
Alarm Indication Signal

AL
Alarm List

Alarm
An event, or a pair of events, that indicates there is a problem that must be resolved by the
operator. Alarms appear in the Alarm List. There are different types of alarms, including current
alarms, repeat alarms, and historic alarms.

Alarmed Object
A network resource on which a problem exists or has existed, and on which a user needs to take
action. The network resource can be a piece of equipment, a port, or a trail.

Archive
The act of copying information to an external device. The file may then be referred to as an
archive file.

....................................................................................................................................................................................................................................
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Area
Networks managed by WaveStar NMS can be subdivided into smaller, manageable networks
called areas. An area is a collection of nodes and/or aggregates, and their associated links. An
area is represented by a single icon on the Network Map. Subdividing a network into areas
reduces overcrowding on the display and improves system performance because smaller amounts
of information are exchanged by the subsystems.

Assignable
A characteristic of a trail set at the time of provisioning. In WaveStar NMS, a trail should be
set as assignable if it is expected that at least one client trail will be provisioned for it.

....................................................................................................................................................................................................................................

B BBE
Background Block Errors - An errored block not occurring as part of an SES.

Black box
A functional network unit, displayed on the Network Map, that is not monitored or controlled
by WaveStar NMS. An example of a black box is a non-Lucent network element.

BLSR
Bidirectional Line Switched Ring

....................................................................................................................................................................................................................................

C CAC
Circuit access code - A code unique to a particular circuit that equates to a particular Circuit
Identification name for the same facility/circuit. The code is randomly generated in the circuit
provisioning system. The CAC does not change during a facility’s lifetime.

Catalogued Connection
A connection that physically or logically exists in the network, and that is recorded in WaveStar
NMS.

Channel
When either a digital link, path, or facility is channelized, it is subdivided into channels. For
Time Division Multiplexing (TDM) equipment, channels represent the time slots with which
information is carried within a digital link or in a server trail. Channels are created by WaveStar
NMS for use during circuit/trail provisioning. When creating channels for digital links,
depending on the network element capability, alternate channels are created. The channel is
given an identity when it becomes either a provisioned path or facility, or a subdivision of a
digital link, path, or facility.

Channel Type
Indicates the type of channel riding on a facility/circuit.

....................................................................................................................................................................................................................................
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Circuit
A transmission path through the network, terminating at equipment at both the A and Z ends.
The transmission path combines equipments and channels of facilities. The circuit has a defined
purpose such as data, video, or voice.

Circulate
The act of moving the window at the bottom of a stack (of windows) to the top of the stack.

CKT
Circuit

CLO
Circuit Layout Order - Code (number) identifying a specific circuit layout order (configuration),
and used as the work item tracking key for a circuit order.

COI
Complete Order/Item state - The last state in most circuit order life cycles.

Cold backup
A backup that is performed while WaveStar NMS is not running.

Combo circuit
The SDH version of one step combo provisioning is an optional feature in which 24N, 30N,
480N, 672N, 672N, and 1920N circuits/paths can be provisioned without an explicit
provisioning of TU12-VC11S, VC-12, VC-3, AU3S, and VC-4 respectively. These circuits/paths
provisioned via one step provisioning are identified using VC12S-24N, VC12S-30N,
VC3S–480N, VC3S-672N, AU3S-672N and VC4S-1920N respectively. The selection of either
TU12-VC11S-24N, VC12S-30N, VC3S-480N, VC3S-672N, AU3S-672N or VC4S-1920N for
provisioning is the selection of 24N, 30N, 480N, 672N, 672N, and 1920N provisioning
respectively.

Connection
Generic name for all transmission objects managed by WaveStar NMS. A connection can be a
trail or a subnetwork connection or a link connection.

Console
A local terminal which is dedicated to administering a single host machine, and connected
directly via a console port.

Controlled network element
A network element controlled by WaveStar NMS that displays on the network maps as nodes
interconnected by digital links. These network elements are in constant communication with
their EMS and are controlled by commands sent from the EMS. They also report and show
alarms. See Network element.

....................................................................................................................................................................................................................................
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CORBA
Common Object Resource Broker Architecture

CTM
Channel Terminations state - The state in a circuit order’s life cycle where the user enters
channel termination information.

Current Alarm
A new alarm received by, or generated by, WaveStar NMS.

Customer equipment
See Equipment.

....................................................................................................................................................................................................................................

D DA
Digital Cross Connect Alarm - Displays the type of digital cross-connect alarms that are active
on the port. Possible values are: E (equipment alarm), S (signal or loss of signal alarm), P
(performance), M (multiple alarms).

Days Past Due
The number of calendar days (0-30) past the due date of a pending order.

DB
Database

DB Sync
Database Synchronization - Refers to the synchronization of digital cross-connect system
databases with the WaveStar NMS database.

DCS
Display Construction Set

DD
Due date - Date when the work requested by the order is to be completed.

Default Weight
WaveStar NMS calculated link weight.

Dense Wavelength Division Multiplexing (DWDM)
A connection that combines multiple optical signals to increase capacity. These signals are
amplified as a group and then transported over a single fiber.

Digital link
Fiber or electrical connections between two points. These transport facilities are assignable to
high-order and low-order circuits to carry customer services.

....................................................................................................................................................................................................................................
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Digital links can be of two types: Synchronous Digital Hierarchy
(SDH) or Plesiochronous Digital Hierarchy (PDH).

• SDH digital links are synonymous with multiplexer sections. They connect two SDH network
elements, black boxes or equipment.

• PDH digital links are asynchronous connections between two PDH ports of the network elements
assignable to the PDH circuits.

DISC
Disconnect (improper disconnect) - Indicates whether a facility/facility channel has been
improperly disconnected. If it has, a “D” appears in this field and WaveStar NMS lists it as
In-Effect.

Domain
A collection of network elements that can be assigned to specific users in “database
partitioning.”

Drop Channel
One direction of a bidirectional signal; a wavelength being dropped from the single flow.

Drop Side
Hardware that handles a signal leaving an end terminal and heading out to the network.

DTE
Data Terminating Equipment

DTS
Digital Transmission System

DWDM
Dense Wavelength Division Multiplexing

DXC
Digital Cross-Connect System - A generic term for electronic cross-connect systems.

DXC Model
The model of the digital cross-connect system frame.

DXCAM
Digital Cross Connect Administration and Maintenance

....................................................................................................................................................................................................................................

E E
Specifies an alarm condition for the equipment assigned to an area.
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E1
International facility on which DS0 channels are multiplexed up. The E1 carries 32 channels;
channel 0 is used for signaling between DACS frames. Channel 16 may be used for carrying
DS0 signaling. Otherwise, channel 16 may be used for customer service and signaling is carried
inband.

EBC
Errored Block Count

EML
Element Management Layer

EMS
Element Management System

Equipment
Equipment is a network element that will never be controllable. Customer equipment does not
report alarms and the WaveStar NMS does not send provisioning commands to customer
equipment. Customer equipment does not appear on the Network Map but does appear at the
Graphical Layout of the provisioned digital link, path, and/or circuit. Although customer
equipment is not displayed on the Network Map, it can be a place holder for end lines. Also
called customer equipment.

ES
Errored Seconds - A one-second period with one or more errored blocks or at least one defect.

Event
Something that has happened — either in the transmission network, or in an EMS that WaveStar
NMS is managing, or within WaveStar NMS itself. Examples of events include an operation that
has succeeded, an operation that has failed, or failure of a network resource. Failure events give
rise to alarms. Some events occur as a pair (a raise followed by a clear).

External Address
Address used by WaveStar NMS in configuration management.

....................................................................................................................................................................................................................................

F Facility
A carrier of low-order trails. A facility is a channel-assignable trail.

....................................................................................................................................................................................................................................
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Fault State
The state of an alarmed object with respect to its ability to carry traffic.

There are three fault state values:

• “Working” indicates that the object can carry traffic as intended.

• “Degraded” indicates that the object is still carrying traffic but has lost some protection or the
quality of traffic is impaired.

• “Failed” indicates that the object is not carrying traffic.

Faulted Connection
A connection that has an event correlated against it.

FM
Fault Management

Form
A task window where the user can enter data, perform commands, and view data from the
system.

Full Geographic Redundancy
See Geographic Redundancy

....................................................................................................................................................................................................................................

G Geographic domain
A geographic domain is a partition of the network that is defined to include a group of network
elements.

Geographic domain partitioning
Geographic Domain Partitioning is an optional feature that allows a network to be partitioned
into geographic domains. A geographic domain is a partition of the network that is defined to
include a group of network elements. Access to the geographic domains can be controlled on a
per-user basis.

Geographic redundancy
Geographic redundancy provides site protection by maintaining a primary server and a standby
server in separate locations and ensuring that the two servers are far enough apart so that
natural disasters or adverse weather conditions cannot affect the primary and standby servers at
the same time. The database of the standby server is maintained as a copy of the primary server.
If the primary server fails, the standby server can be manually brought on-line.

There are two types of geographic redundancy:

• simplified, an optional WaveStar NMS feature which uses nightly backups to update the database
of the standby server.

• full, an optional WaveStar NMS feature which uses a mirroring facility to update the database of
the standby server every 30 minutes.

....................................................................................................................................................................................................................................
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The two types of geographic redundancy differ in the frequency of database updates from the
primary server to the standby server.

GR
Geographic Redundancy

GUI
Graphical User Interface

....................................................................................................................................................................................................................................

H Historic alarm
An alarm that has been deleted.

Hot backup
A backup that is performed while WaveStar NMS is running.

....................................................................................................................................................................................................................................

I IMP
Implementation state - The state in the life cycle of a circuit order where the digital
cross-connect system commands are implemented.

IMR
Implementation Roll state - The state in the life cycle of a circuit order that permits testing
between the bridge and roll commands.

Int ChType
Internal Channel Type

Integrated Transport Management - Cross-Connect Module (ITM-XM)
An EMS to which WaveStar NMS has direct access; no interface is required.

Integrated Transport Management - Subnetwork Controller (ITM-SC)
Previously known as Transport Management Application Group (TMAG).

Internal Address
Address sent to the network element via the ITM-SC (Element Management System), sometimes
referred to as the software address of the port. This address is specified by the vendor.

IOR
Inter-operable Object Reference

ITM-PRM
Integrated Transport Management - Physical Resource Manager

....................................................................................................................................................................................................................................
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ITM-SC
See Integrated Transport Management - Subnetwork Controller.

ITM-XM
See Integrated Transport Management - Cross-Connect Module.

....................................................................................................................................................................................................................................

L LAY
Layout state

Local Terminal
The terminal that resides next to the digital cross-connect in the central office and can be used
to interface directly with the ITM-SC. Also known as “console terminal”.

Location
The location code of the equipment or digital cross-connect frame.

LOF
Loss of frame

Log
Record of past and/or current activities.

Logical Port Address (External or Internal)
Address of a channel (logical channel) riding on a higher-order system; the higher-order system
is terminated on a physical port. There are two address formats: network-level (external)
and EMS-level or Network Element level (internal).

LOM
Loss of multiframe

LOP
Loss of pointer

LOS
Loss of signal

LSR
Line-Switched Ring

....................................................................................................................................................................................................................................

M MDI
Miscellaneous Discrete Input
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MDO
Miscellaneous Discrete Output

MIB
Management Information Base. A conceptually organized database that contains the management
information accessed through SNMP.

MODE
Execution (Restoration) mode of a preplan circuit.

MS
Multiplex Section

MS-SPRING
Multiplex Section-Shared Protection Ring

MSP
Multiplex Section Protection

MT
Moyens de Transmission (Transmission Means)- A digital transmission medium (facility) of
specific bandwidth between A Location and Z Location. Contract circuits are routed on MTs.

....................................................................................................................................................................................................................................

N NE
Network Element

NEID
Network Element Identifier of digital cross-connect systems under ITM-SC. (Same as TID.)

Network
A network carries a payload from one point to another. This payload can consist of data, voice,
video, or images. Only circuits carry data. Digital links, facilities, and paths carry the circuits
that carry the data.

Network Connection
A transport connection that is connected at each end to a trail termination point.

Network element
A network element is a functional unit in a customer’s network that the WaveStar NMS displays
on the Network Map and is monitored by the WaveStar NMS user through the graphical user
interface. Network elements supply switching, transmission, or multiplexing functionality in a
network. A network element is either controlled or noncontrolled.

....................................................................................................................................................................................................................................
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Node
Physical location representing any managed equipment, including regenerators.

Non-assignable
A characteristic of a trail set at the time of provisioning. In WaveStar NMS, a trail should be
set as non-assignable if it is expected that no client trail will be provisioned for it.

Non-service-affecting alarm
Alarms categorized as non-service-affecting indicate that at least one channelized facility,
without provisioned circuits, is alarmed.

Noncontrolled network element
A noncontrolled network element is a Black box or Customer equipment that cannot be
controlled by WaveStar NMS. These network elements do not report alarms. Noncontrolled
network elements support only manual provisioning and are listed in the database as a part of
provisioning records. See Network element.

NSA
Non-service-affecting

NTN
Network Telephone Number - Used on a network to represent a physical address.

NTN1
Network Telephone Number - Primary telephone number of the digital cross-connect frame on
the packet network.

NTN2
Network Telephone Number - Backup telephone number of the digital cross-connect frame on
the packet network.

....................................................................................................................................................................................................................................

O OA
Optical Amplifier

OCH
Optical Channel

OFS
Out-of-Frame Seconds

OLS
Optical Line System

....................................................................................................................................................................................................................................
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OMS
Optical Multiplex Section

Order
Circuit Order number

OTU
Optical Translator Unit

....................................................................................................................................................................................................................................

P Path
An SDH transmission object between two SDH/virtual ports. There are high-order paths (VC-4)
and low-order paths (VC-3 and VC-12).

PDH
Plesiochronous Digital Hierarchy

Performance Monitoring (PM) Export
An optional feature that allows performance-monitoring information to be exported to a
predefined data file, which can be used for a variety of purposes.

Physical Port
The object responsible for the processing of the signal on the communication infrastructure.

• For an SDH port, the physical port is the processing from the fiber to the MS level.

• For a PDH port, the physical port is the PDH processing before insertion/extraction to the SDH.

• For an optical port, the physical port is the processing from fiber to the optical MS level.

Physical Port Address (external or internal)
Address of the port that physically terminates a facility.

Plesiochronous Digital Hierarchy
A transmission hierarchy wherein all the elements have the same nominal digital rate but are
synchronized on different clocks (near synchronization).

Port
The port address of the facility.

Post
Command to initiate the continuity check of a facility/circuit layout across the network and to
determine the route of a facility or circuit.

Preplan Circuit
The preplan circuit is the protecting circuit used to restore the service circuit. Also known as
service circuit.

....................................................................................................................................................................................................................................
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Preplan Restoration
An optional feature that allows a dedicated backup route to be specified for paths and circuits.
When Preplan Restoration is used, a disrupted circuit is temporarily rerouted on an alternate
route to restore service. The restoration process is triggered manually or automatically by an
alarm. Once the alarm situation is resolved, the restored circuit can be manually reinstated to its
original route.

Primary Alarm
An alarm that is a direct result of a failure in the network, such as Loss of Service (LOS).

Protection Path
The protection path is a backup route that protects the service path. The service path is the path
that is standards operational.

PSR
Path-Switched Ring

PTI
Path Trace Identifier

....................................................................................................................................................................................................................................

R Receive Date
The date an order is received.

Redline
Indicates whether circuit requires special service protection marking and treatment.

Refederate
The process of re-establishing the association between the WaveStar NMS and WaveStar SNMS
Orbix instances.

Repeat Alarm
A type of current alarm; a current alarm that has the same source as probable cause as another
current alarm becomes a repeat alarm.

Response Display
You specify whether you want to see all responses from the frame, only your own responses, or
your own and alarm responses.

Ring
Rings are formed when the digital links connect all participating network elements to form a
closed loop.

....................................................................................................................................................................................................................................
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RNAME
The system name that identifies the specific DTE to use to communicate with the packet
network and the host name.

....................................................................................................................................................................................................................................

S SA
Service affecting

SDH
Synchronous Digital Hierarchy

Section
A trail in a section layer.

Service Circuit
See Preplan circuit.

Service Domain
A partition of the network that is defined to include a subset of a network’s link connections
(channels) and physical ports and their derived connectivity.

Service domain partitioning
Service Domain Partitioning is an optional feature that allows a network to be partitioned into
service domains. A service domain is a partition of the network that is defined to include a
subset of a network’s link connections (channels) and physical ports and their derived
connectivity. Access to the service domains can be controlled on a per-user basis.

Service Path
The path that is standards operational. The protection path is a backup route that protects the
service path.

Service-affecting alarm
Alarms categorized as service-affectingindicate that at least one non-channelized facility is
alarmed or that at least one channelized facility with provisioned circuits is alarmed.

SES
Severely Errored Seconds - A one-second period that contains 30% or more errored blocks or at
least one defect. SES is a subset of ES.

SI
Session indicator - Type of session between the WaveStar NMS and the DACS: DS (WaveStar
NMS Session) or VS (VCIT Session).

Simplified Geographic Redundancy
See Geographic Redundancy.

....................................................................................................................................................................................................................................
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SNCP
Subnetwork Connection Protection

SNMP
Simple Network Management Protocol

SNMS
See WaveStar Subnetwork Management System (SNMS).

Speed
Baud rate

Status
Current condition or state of progress of an instance or object.

Subnetwork
A collection of interconnected network elements that has a certain behavior. The subnet concept
allows WaveStar NMS to manage fixed cross-connect systems and rings through SDH
multiplexers. Also called a ″subnet.″

Synchronous Digital Hierarchy
A transmission hierarchy wherein all the elements are synchronized.

....................................................................................................................................................................................................................................

T Tandem connection
A sublayer between the management system connection and path layer that allows users to
monitor the quality of the signal transport within its managed domain. Tandem connections also
provide users with information about the total quality of a signal before the signal travels from
the user’s managed network to a network managed by a different user. Users can create tandem
connections on paths that do not terminate in its managed network but traverse its network from
other user managed networks.

TCA
Threshold Crossing Alert

TCAL
Traffic Correlated Alarm List

TCM
Tandem Connection Monitoring

Termination
Port address

....................................................................................................................................................................................................................................
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TID
Target Identifier - The target identification name of the digital cross-connect frame, that is used
in the network to identify a digital cross-connect frame. (Same as NEID.)

TP
Termination Point

Trail Termination Point
The transport, trail termination, and adaptation functions that terminate a trail.

Tributary Port
Generally forms the add/drop side of an ISM. This is where signals going from the tributary
side to the line side of an ISM get added, or where signals going from the line side to the
tributary side of an ISM get dropped. The tributary ports terminate 2-Mb/s (CEPT-1 or VC-12),
140 Mb/s (CEPT-4 clear channel), or 155 Mb/s (STM-1 clear channel or TUG structured)
signals.

TTP
Trail Termination Point

....................................................................................................................................................................................................................................

U UAP
Unavailable Period

UAS
Unavailable Seconds - A period containing 10 or more consecutive Severely Errored Seconds.

UID
User Identification - Host login of the user.

Uncatalogued Connection
A connection that physically or logically exists in the network, and that is not recorded in
WaveStar NMS.

Uncorrelated Alarm
Specifies an alarm condition that exists on ports or network elements assigned to an area that
does not terminate links, trails, or circuits in WaveStar NMS.

Uncorrelated Event
An event that does not affect any trail provisioned in WaveStar NMS.

User ID
A login. Each user ID represents a person who has been granted access to use WaveStar NMS.

....................................................................................................................................................................................................................................
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User Profile
A user profile is an association of a list of tasks with a User ID. The user profile controls which
tasks the user is allowed to perform.

....................................................................................................................................................................................................................................

V VCIT
Virtual Craft Interface Terminal

Virtual Port
Terminates the two line ports in a protection scheme. You enter the line port addresses in the
normal manner. The virtual port address is in addition.

Virtual Port Address (External or Internal)
Addressing scheme that allows you to enter a virtual port address that controls the two line
ports; the address allows one line port to be the service port and the other line port to be the
protection port. Virtual port addressing is a protection scheme.

VPN
Virtual Private Network

....................................................................................................................................................................................................................................

W WaveStar Subnetwork Management System (SNMS)
SNMS is a management system for the WaveStar product family, providing Element
Management Layer (EML) management functions for WaveStar products. This system has
configuration management, fault management, performance management, and security
management functions.

Work Log
The history of a work item; a log of significant operations performed on work items.

....................................................................................................................................................................................................................................

X X.25
A protocol for communication between packet-switched public data networks and user devices
in the packet-switched mode. Recommendations for this protocol were developed by a group
formerly known as the International Telegraph and Telephone Consultative Committee (CCITT),
now known as the International Telecommunication Union Telecommunication Standardization
Sector (ITU-TSS).
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an area, 6-13

EMS, 9-19

External WaveStar
NMS, 9-25
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6-7
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geographic domain,
4-14

node to established ring,
8-67

user profile, 4-9
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domain, 4-14

user to a service
domain, 4-23

WaveStar SNMS, 9-10

Add a user

geographic domain user,
4-4

on a server, 2-33

regular user, 4-4

service domain user, 4-4

to a SAGE workstation,
2-35

Aggregate

add, 6-7

modify acronym, 6-11

Alarm database audit, 9-40

Area

add, 6-13

delete, 6-17

modify, 6-15

Area Map, 6-25

add a user defined, 6-26

delete a user defined,
6-28

display/modify a user
defined, 6-27

Areas, 6-12

Assign

users to geographic
domain, 4-13

asynchronous port for
datakit, 2-19

asynchronous port for TIM
interface, 2-17

Audience, xix

Auto-Discovery Tool, 8-3

add or migrate
networks, 8-13

parameters, 8-15

automatic

package switching, 3-32

........................................................

B Background Map

install new for HP-UX
machines, 3-47

install new on machines
running Windows,
3-48

install new, all users,
3-45

Backups, 7-3

cold, 7-4, 7-6

hot, 7-3, 7-5

Bulk circuit provisioning
tool, 8-61

Bulk Link Provisioning
tool, 8-64

........................................................

C CDE printer icon

set up, 2-44

Change

network element name,
8-18

Channel

list assigned, 5-18

modify, 5-23

Check

X.25 links status, 3-62
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Clusters

re-add server to, 3-34

view status, 3-35

CMISE, 8-54

Cold backup, 7-4, 7-6

Cold backup recovery, 7-11

Commands

WaveStar NMS
geographic
redundancy, 7-20

Commenting on user
documents, xxiii

Comments, xxiii

Communication

restart, 7-26

Configure

X.25 network, 8-71

Connection Renaming tool,
8-58

Controller

select, 9-19

Conventions

typographical, xxii

Core file, 10-7

Cron file

edit, 3-29

view, 3-28

Cut-through

assign WaveStar SNMS
login ID, 4-28
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administer, 3-39
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4-20

network element from
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8-37

node, 3-52
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ring, 8-70

user, 4-8
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user profile, 4-12
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domain, 4-26

Delete a user

from SAGE
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setting, 3-55
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add a user, 4-14

administration, 4-13
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5-9
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7-32
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........................................................

H Host database, 7-9

Hot backup, 7-3, 7-5

Hot backup recovery, 7-10

.....................................................................................................................................................................................................................................

I N D E X
I N - 2

Lucent Technologies 365-309-245
Issue 1, October 2001



........................................................

I

icon behavior

EMS, 7-23

Information products

font usage, xxii

how to comment, xxiii,
xxiii

how to order, xxiii

init 3, 1-6

init 4, 1-6

Insert
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restart WaveStar NMS
communication with,
7-29
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........................................................

M MC/ServiceGuard, 3-30

Messages

recovery, 3-42

warning, 3-42

Mirroring status, 7-18
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user ID information, 4-6
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enable automatic, 3-32
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Windows terminal
server, 2-8, 2-8
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local, 7-19
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6-9

REMOVENODE tool, 8-23

Reparent

WaveStar SNMS
Network Elements,
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Resource management
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Search

network element’s
location type, 3-64

Servers

adding a user, 2-33
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switching roles of, 7-30

Service Domain

add, 5-20

Service domain

add a user, 4-23

administration, 4-22

delete, 5-27

delete user(s), 4-26
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Service domain mode
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Set
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Set up
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Space

monitoring, 3-42
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3-9
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Stop WaveStar NMS

on a geographic
redundancy server,
3-19

on a MC/ServiceGuard
cluster, 3-21
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on a simplified or full
geographic redundancy
server, 3-19

on a specific node using
sam, 3-23

on a Windows terminal
server, 3-22

on a Windows
workstation, 3-25
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6-32
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defined, 6-31
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to a standby server,
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WaveStar SNMS local
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privileges

assigning on a Windows
PC, 2-31
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2-14

TL1, 8-54

Tools
See: Off-line Tools
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create trace files on an
HP-UX, 10-6
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listing, 5-17
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xxii
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800G, 8-50, 8-51
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add on a server, 2-33
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6-26

User defined submap, 6-30

User ID
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user ID
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2-22

User privileges
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PC, 2-29

User profile

add, 4-9
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NMS, 7-32

Virtual disconnect, 6-34

Virtual disconnect tool,
8-74

Virtual Private Network,
5-14

VPN, 5-14
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W WaveStar DACS, 9-33

cross-connect
management, 9-39

database
synchronization, 9-41

frame display, 9-35
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WaveStar NMS database

synchronize with an
EMS, 9-28

WaveStar SNMS

add a new, 9-10

interact with, 9-9

WaveStar SNMS
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servers
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communication with,
7-28

WaveStar SNMS local
redundancy servers

restart WaveStar NMS
communication with,
7-27
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host, 2-13
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